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Preface

Keyboard: Computer Science with Application Software (Third Edition); a series of eight
books for Classes 1 to 8; is a concerted effort to impart knowledge about computers using
an interesting and interactive approach. Computer science is a fascinating and wide-
ranging subject with limitless opportunities for creativity and application. Today computers
influence every facet of our lives. In the highly competitive world we live in, a basic
working knowledge of computers is essential for success. There is, therefore, a great desire
to introduce computer education to children at an early age. There should also be enough
room for them to explore and create on their own.

This series introduces the subject in language that is simple and direct. Technical
vocabulary is introduced where necessary and all such terms are defined at the end of
each chapter. Comic strips, icons, engaging characters, and illustrations make the learning
process an enjoyable experience.

The content is based on extensive feedback from teachers, and on the latest trends in
computer education. Particular care has been taken to update facts and figures, and to
include information about the latest devices in the markel.

The focus of Books 1 ta 5 is on learning the basics of computer science; on understanding
MS Office 2013 and using KTurtle, as a programming language.

Books 6 to 8 move beyond elementary concepts and introduce Publisher 2013 (Flash
‘u’er?iun CS3), HTML 5, Dreamweaver (Version C53), Photoshop (C531, Microsait Small
H:151c. and Visual Basic (Version Microsoft Visual Basic 2013 Express). This edition also
gives them the potential opportunity for hands-on experience of sound and video editing
through the programmes, Audacity and Lightworks.

With a strong emphasis on developing 21* century computer skills: critical thinking,
communication, collaboration, and creativity—this edition of Keyboard: Computer Science
with Application Software will prove to be invaluable for students and teachers.
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Exercises « The downloadable teaching -
contain both objective and descriptive questions, resource is an exciting new

digital teaching aid that
offers reinforcement and
assessment malerials,

s The Test Generalor is an innovative,
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pool of questions for effective evaluation,
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Formulas in excel 2013

- H.; GCoggle! How was

e your day? Ond you learn | ... But. don't worry!
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In Excel, formulas are written differently from how you write
them in Math. ‘
An Excel formula always starts with an equals (=} sign and it
can contain values, cell references, functions, and operators.

* Celland Range References

» Values: 987 and 36.7 (numeric), "Computer” and *Hi - Using Formiuilas
(string) » ETorAesulty
s ALTOSLITE FEATUTE
» Cell references: C3, B2:B5, A2:D8, B:E, 4:10 = Funetions Library

* Funclions: sum, average, min, max, coun

* Operalors: +, -, *, /. N, >

Thus, a formula in Excel is a sequence of values, cell references, functions, and/or operators in
a cell that produces a new value from existing values.
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CELL AND NANGE REFERENCES

A reference identifies a cell or a range of cells in a worksheet, and tells Excel vhere to bl
the values or data you want 1o use in a formula, Let us consider a few examples. '

The cell in column A and row | Al
The range of cells in column B and rows 1 B1:620 * Top Tip I
through 20 - -
) The status bar at the oy,
The range {1I'. cells in row 4 and columns B [14:04 of the window displays the -
through D current action being taken, Whe.
All cells in row & a8 YOURIE ok Going Stythiceg, the
) status is Ready. When you enter
All cells in row 3 through 6 36 data in a cell, the status charge;
Al cells in column E EE IASERIRL Wi 10 Colblv iy
_ or press F2 1o edit a cefl the
All cells in columns B through D B:D status changes to Edit

The range of cells in columns C through Eand ~ C5:E10
rows 5 through 10

USING FORMULAS

To enter a formula, select a cell and enter the formula in the cell or in the Formula Bar, When

you finish entering the formula and elick L2 (or press Enter), the cell will show the formula
result and not the formula itself,

However, you see the formula in the Formula Bar when the cell is selected. To understand how

a formula can be entered in the formula bar, let us calculate the sum of the numbers in cells B2,
C2, and D2 as shown in the worksheet below iFigs. 1.1-1.41,

Step 1 Step 2
tame Bou Enter burran Formala Bar
g2 e £ SUM - S S S '
o Ao o o B 0 E_| . S| SR« LR e
1| RollNo. Testi  Testm  Testmi  Total 1 | RollNo. Testi  Testm  Testil  Total
2| som a5 a3 w [ ] 2| som a5 41 40 J

Fig. 1.1 Click the cell in which you want to
put the formula, which in this case is E2. The
cell reference E2 appears in the Name Box,

Fig. 1.2 Type the equals (=) sign. You can
type it either in the cell or in the Formula

Bar. What you type will appear in both
places automatically.

OXFORD a
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step Step 4

| o " :
¥ 1 2 & A TRIT _'|||,| £
& 1] i 4] 2 n c ) E
£ || mollae, T R —
el
L maliNe,_Testh Testi | Testn e ',l ; q:: "":':" '*::" Total
. 200 j28

_-l apol |_._n1 B 1 a0 ez | l‘ E

Fige 1.3 Continue typing W22 s shown
sotive the clitterent volowr Bostders appear
arerine] s vlls,

Fig. 1.4 f:l'r[.lu:] ¥ rm s Enter, Cell E2 will display
thee formula result. This will chanpe automatically if
dhata changes in cells B2, C2, o D2,

painting = i e
An easier method of adding a cell ) a
i i - ¢ D E
Al YT ;| 5 Ll &
relere rfu o ale nTmIﬂ is 1o click on the | L RoltNo. Testi | Testn Testi Total
coll instead of typing the cell address. This | 2| soo1 } = 1 a s
Emmm -

method is called pointing. After typing =,
do not type “B2". Click on cell B2 instead,
a moving dashed border called a marquee will appear around B2 (Fig. 1.5). The status bar will
display a status of Point.

Fig. 1.5 Entering a cell reference by pointing

Now type “+' and click on cell C2. Then type 4 and click on cell D2. Cell E2 will now have
the same formula as in Figure 1.3, Press Enter to see the value.

Relative, absolute, and mined References
When you use a cell {or a range) reference in a formula, you can use the following three types

of references:
« Relative The row and column references can change when you copy the formula to another

cell, By default, Excel creates refative cell references in a farmula. For example, A1, B5, D4, etc.
1. Consider the worksheet given below (Fig. 1.6) to find the Interest Amount using the formula
Principal Amount * Rate of Interest * Time in Years.
2. elect cell D3 and using the AutoFill handle, drag it to cell D6 iFig. 1.7).

3 Release the mouse button; the calculated values will appear (Fig. 1.8).

o3 * £ zRIFEINCE 01 - fi  =&)*E¥"C1
i . C o 4 | c 1]
I i =
Painclpal mateaf  Timedn  mberesl Privwipal Raten!  Timalm  Inkerest
F) Anaunl Int#rest Tean Amauii ¥ Amaunl InteEt Vit Ammtund
1] sos o t 3] weoc0 % ' B0
4 $0000 e b 4 bt % 1
4| ypooon 10% 1 5 o000 boti 1
& | soed 1% i ) & A0o0od 3.1 1 |
Fig. 1.6 Select cell D3, enter the formula =AIB3*(3, Fig. 1.7 Drag the AutoFill handle
and press Enter. The calculated value will apgiear.
3 OXFORD
i i Jf u] =] " T N T
EE @y O oEEE B 2 o
pgo_EEEE maE_ oo
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4. Select cell D4 and DS, ane note the formula in the

Formula Bar (Figs. 1.8 and 1.9,

—
04 . fi  saaTBATCA o5 - k| ATRD
X 8]
. ; ¢ D 8 i & e
1 1
Pringljpal Rateol  Thimeln  Wlerest mingipal mateof  Timein  Interes
2 Aimant Bt Yiars At 2 Amount interest Years Amount
i 10 B% 1 DO 3 10000 B% 1 800
4 | S0000 e ] a500 | d SO000 0% 1 4500
5 100000 10% 1 10000 5 l 10000 10% 1
0 S00000 12% 1 BO0CD J 0 500000 1% 1 E0000

Fig. 1.8 Formula in cell D4

Fig. 1.9 Farmula in cell D3

The formula in cells D3 to D6 is the sum of the three cell values to their left. The reference

changes if the formula is copied to another cell. This is
referencing. It is useful if you want o total row data for

because the formula uses relative
each row using the same formula.

+ Absolute The row and column references do not change when you copy a formula becaus

the reference is 1o a fixed cell address. It uses two dol

lar signs in the reference—one for the

column letter and the other for the row number. For example, $AS1, $D$5, and 5B57.

1. Consider the worksheet given in Figure 1.10,

The formula entered in cell C3 is =A3*B3*$DS%1.
Select cell C3 and using the AutoFill handle, drag it
to cell C6 iFig. 1.10).

When you capy the formula to cell C4, it becomes
=A4*B4°5D51.

A part of the formula is relative (A4*B4), while
another part is absolute (SD$1}. Wherever you

copy the formula, only the relative part will
change. The absalute part remains the same.

Now, can you guess the formula that would be
copied to cell C5¢ Yes, it would be =A5*B5*5D%1.

I

4 - I =4 3"BI"5DEL
& [ c 4]
e —
Thme i
Yrears 1

Principal Rateof  IndErest
amount interest  Amaunt

« Mixed The row or column reference is relative ||,
while the other is absolute. For example, SAT or

AST.
1. Consider the worksheet in Figure 1111
calculates the area of a rectangle for various
lengths and breadihs. The formula in cell €3 is

=$B3°C$2. Copy the formula to the cell range
CLFh.
ORI 4

] L H
u B EEEE = =

2
1| aooco % [ 00 I
F 50000 w5 1500
5 106600 10% 10000
6| so00t0 12% 50000
Fig. 1.10 Absolute referencing
- i =583°CSD
& B € D g r
1 Baeadif
| 1 F 3 ]
3 1 1 2 3 1
1 & 2 2 a 3 g
s| & 1 3 6 s 12
L] 4 4 ] i ¥ ] 1 _J|
Fig. 1,11 Mixed referencing
i
Iy
| J-lh
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foth thee cell references are mised, The meference to cell B3 usies an absolute reference lor the
column ($18) and the referenee o oell €2 uses an alsalule refogen e for the o (52).

Phere is away tooviews the fomulas copied o the cell ranpe
1

I

TR 7

¢l Click the FORMULAS tib, 1n the Formula Auditing proup, — v

click the Show Formulas button, The formula used in each ol

the cells of the range will Be shovwn in the eells di, 1,120,

i
|

#F =

[

i

g
=

1
P
1
a

1

sSAN*CSD
=552
=SAS*CA2
=5BE*C5)

n

[}

Neesillh
i 1
EELE b v R
SERATOE]  =SRATEGD
SRS D42 RIS EST
ERGD5T oSNETEST

L
=SB FST
=SO85
s L

=

Fig. 1.12 Formwlas in the selected colls

Yo can wse the F4 key
repeatedly to have Excel cycle
through all the four reference
typos. For example, if you enter
=A1 to start a formula, pressing
F4 converts the cell reference to
=5A% 1, Pressing it again displays
=441 and then again displays
=A5 1, Pressing it one more time
returns you to the original =A1,

Note: The type of cell reference is important anly if you copy the formula to other cells.

circular neference

A circular reference occurs when a formula refers to its own value, For
example, il you enter the formula =AT+A2+A3 in cell A3 (Fig. 1.13),
every time it calculates the formula in cell A3, it must be calculated again 3 |=AL+A2+A3
because A3 has changed. The calculation would go on forever. You will

A

1| 12|

2 az|

el

Fig. 1.13 Circular

spe 8 warning in such a case (Fig. 1.14). Click OK and correct the formula. R
Microsaft Excel i

L 1

Careful, we Tound ane or mate ceoular relenenoss in your welk
sruuia Bl mefers bo its own ctll vale, of refers to & cell dependent on it own cell vakue,

FYl: & chrouwlar releremos can be a fo

meok fRHat might ceute your Tarmialad Lo caloudale ncarredtiy.

ok

Help

Fig. 1.14 Warning in the case of circular reference

PRACTICE TIME

Mohsin the owner of a furniture shop, wants to cabculate the final price (total amount + sales tax
amaunt) of the furniture ftems in his stare. He has created the worksheet given on the next page for
this purpose. The sales tax amount is B6% of the total amount. Can you heip him in this task?

o ‘l‘
[l
14
OXFORD
ano [ pmgrLELrE paEis
o0 oEoE B Li
sus_ssmw_ene_sm )
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A - n i_—_ h ; ! j
L e auantity | mhr Farkall Airsiniiiod | Silees Faw Ainiiil | beial Price
2 ablechock | 5 | ¥ L
1 Im_mt B T N ... DN - |
4 Shudy Tabde 1 | e | =
s ComputerTable | 3 | M9
[ g
7 Aabealin ] i e ———
SOLUTION

1 Create the worksheet a8 showenn in the ligure above,

1 Galect coll D2 and Lype ¥ H_?f.-.?" il||ﬂ.|. click Erter,
Salect cell 1972 and using the AutoFill handle, drag it through the cell range D325

Seloct coll £2 and type ™= D2*4Rs7 and chck Enter.

-,
5 Solecr coll E2 and using the AutoFill handle, drag ic through the cofl range E3E5,
& Select coll F2 and type "=D24EY° andl click Enter,
7 Select cell F2 and using the AutoFill handle, drag it through the cell range F3F5.
& The output will look as given below,
|
C B _C ] £ f :
| Hem hiantihy Mrice Total Amount | Sales Tax Amosint Final Price
2 Table Clock 5 249 1250 107.50 1357.50
3 |lamp 4 0 oo EE.E0 E58.80
4 [Study Table 3 3000 5000 774,00 9774.00
5 itnrrq:utlrhhlt 5 5000 2500 2150.00 ITLH0.00
&
7 SalesTan [ aeox |
Text Formulas I
A text string or a text value is a sequence
of characters on which you cannot perform '
. 3 : gogd-c C1 . £ =m1E"“EBL |’
operations like subtraction, multiplication,
or division, However, you can join strings A 1 E‘___-l .
together. This is called concatenation, 1 [Respect EMders  [Respect Eiders
We use the ampersand (&) character to Fig. 1.15 Concatenated text

concalenate strings. For example, il you type
="Respect”&" “&"Elders”
in a cell and press ENTER, you will see the result Respect Elders (Fig. 1.15).

Let us now consider another example to understand how to use the ampersand character. In this
example, we will enter a formula that will display a sentence with information from the talle.

OXFORD ] u
i - o a Bg i =
o a " EEEN B L= i
OEEp DEE EERER EEE © Em = B . :J.l
T Ly -t [ 1] M B B — s -
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Step 1 Step 2
- 2 Sy 1 B A B c D E
1 t———I—“““ No. , tame _Grade [Rolio, Wame  Grade .
- [ | Samesra Al i ™3 : =
3E d - 8l 2  Ramsha Bl
4 | 3 H:mﬂ-'l A2 3 Fiapam g
5| 4 Ghaw B2 4  Ghaur P

‘ [ |

7 |=B2k", whose roll number is "& A28", got the grade 'Iutd

Fig. 1.16 Click the cell A7 in which you want the
result of the formula to be displayed. Type =B2 & *,
whose roll number is * & A2 & *, got the grade * & C2
and press Enter, Motice the spaces inside the quotation

marks after the comma.

Step 3
A B C D E

i | Roll HNo. MName Grade

2 1 Sameeia Al

3 2 Ramsha Bl

4 i Mesaem A2

5 4 Gihaari B2

§

1 whose roll numbaer is 1, got the grade Al
‘ ’ roll number is 2, got the grade B1
9 e roll number is 3, got the grade A2

| ge roll number is 4, got the grade &2

Fig. 1.18 Release the left mouse button and
see the magic of Excel! The formula is copied
inte all the cells in the range. The row numbers
have been changed in each cell.

1
i
3
d
5
&
T | Samuora lwhose rall pumber i 1, got the grade A1
[}
9
10

Fig. 1.17 Click cell A7 again, and point the cursor
to the small black square on the lower-nght cormer

of the cell. This is the fill handle. The cursor
changes to a small black cross, Drag the fill handle
to cell A10, keeping the left mouse button pressed,

| Did you Know? ﬂ

With 1048576 rows and
16384 columns, an Excel
workshest has 1048576 x 16384 =
17179869184 cells. If you enter a
single digit in each cell at a speed
of 1 digic per second, it will take
you about 19884 days of nonstop
work ta fill the worksheer!

So, do you agree that using a formula is faster and more accurate than typing each sentence one
at a time, especially if you have to do it a number of times? Just imagine how useful this feature

would be if you had a really long list!

PRACTICE TIME

Aman, a COMpuUter OPerator, wants to
put together the first name, the middle
name, and the last name in the Full
Name column as shown in the following
figure. Can you help Aman in his task!?

"’*"_ p
i

A 1 L
PR T L T PerTRer— - ——
I  Haagd Walsed Jamil
1 Sabeer  |C Waha
4 | Amseh Watnad Faroog
5 | Wahah [ Arraar
b Mahwish |V Fahad
7 OXFORD
B [ -] [+ B LT PRI
a 2 pEEER @ " m
I oge oEEE III_I!
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mathematical Dperators Used o fonnolas
Fablie 1.1 showes the Pable 1.1 §xoed operators and their procedence
mathematical operators

usedd i Exeed aned their Operation  Operator  Orderof  Formula Result

order of evaluation in | Evaluation Al
formulas from first 1o last, | Expnent . A I 2h4 1 Th
) | 2 . ' 2 . B r I:L"
o Aty operation | Multiplication | 2 pes Ao -
. ’ e ; o fil
cantained in brackets - Division ! / , 2 10/ 333 it
will bee carried oul Aklition N 5 24+ 58 B2 '
| : _ .
first, followed by any Sulstraction - - } a6 - 14 27
i_":u:IH!IlII'III [Flnwl_'rjl. 8

o Then follow division and multiplication operations, which are given equal imporance,
[hey are carricd out in the orcder in which they occur in the formula, left to right. Whichever

appears first in a formula is carried out first, Table 1.2 Examples uf Evaluation
o After tha, .'uinii[im'l..}ml sulbtraction ul|u.1r.|ll't:-r‘ll.*~ are given BN Output
eepual importance, They are also carried outin the oreher | =TT : 13 =3
: t | = i £
in which they ocour in a formula, from leeft o rigght. |
|=H*2+1 | 19
H ]
Ko, if two operators lave the same order q_:J' l."l-'.l.|I.M|IHr1, legving ' =
Excel simply evaluates them from lefl 1o right. Some I oma
Fipisa i - =
examples of how Excel evaluates formulas are given in ; k3 2 12
Fablis 1., =0+ 1I0/2*3-6 | 15 L

EANOR RESULTS

1
Sometimes o cell with a formula displays an error result rather than a proper value, This
happens when the furmula has a prablem and Excel cannal process it Tabile 1,4 lists some
commaon errors in Excel along with their possible reasons,
UR1OIRD il I
PETrrr "  WE = 1
B H @ EEEE ® i s
_‘J_ EE SEN EEEN EED 5

Scanned with CamScanner



Tahble 1.3 Common formula errors in Excel

el ™ G e i
#9222 Th!;'_c-uTu;wn_|$ not -u.uanuunh m_d?pia_w. the value.
=DIvio! mElﬂrm;El-:::pl‘;l;L’-ﬁ-s.;ﬁ-lljl;il.d nper.:t.l:n:m i.e. division h'-
- Zero, -
ENA - ' The formula ;ses a miu; that |; r;:ll_a'-ﬂrl.:ﬂ:ﬂﬂ _
ENUM! A -pmhlem W |1|1 a \alue for example, a nr:g,a.tue number i
~ specified when a pasitive number is expected.
| #REF! . “ThE formula refers to a cell that dﬁﬁ not exist. This hﬂPPE“ if
~ the cell has been deleted from the worksheet.
SVALUE! The formula has an invalid argument; for eumple text in a

cell where a numeric value is requsled

AUTOSUM FEATURE
The AutoSum feature automatically adds numbers in the selected

; E AutoSum = A"F ﬁ
cells. You can also use it to find the average, maximum, efc., fora | s,
" S-nl't& Find &
range of cells. The AutoSum button is present at two places onthe | o o . 207 (00
ribbon: Eding

« In the Editing group on the HOME tab iFig. 1.19.. Fig. 1.19 Editing group
» In the Function Library group on the FORMULAS tab (Fig. 1.200. on the HOME tab

m E h' c 0
m MOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW

| A TEBEBITBER E B

Insert  AutoSum Recently Finzncial Ltu;rul Text Date & Lockup & Math & hlose
Function - Used - - = Time~ Reference~ Trg= Functions =
Fumgian Library

Fig. 1.20 Function Library group on the FORMULAS tab

Calculating Totals with AutoSum
Consider this example where we need to find the total marks of students in three tests.
1. Type the data in a worksheet as shown (Fig. 1.211. Select cell E4 and click AutoSum in the

Editing group on the HOME tab. For more options other than addition, click the drop-down
meny amow to the right of the AutoSum button (Fig. 1.221. With AutoSum or Sum, Excel

q OXFORD
u [} ED ] -1 e
. BB " SEEE ® & =
immE_ e , EER SEEE smD ao
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will create a formula with the X " ¢ o 3 T
Sum function along with a t motime. | testt | vestn | testm [“votal | Aveespe |
cell range. A moving marquee | 2 [Caoor 1 s -r- el 4
. T UM inemberl, [ .,
surrounds cells B2 through = 2 - : -
DI g e i ADD3 a5 46 42 |
= and a screen lip appears 5 | ADDS 42 40 a3 -—
below the cell, telling you .
the correct format of the Sum Fig. 1.21 AuloSum creates a formula with the SUM funciy,
tunction.
2. Press ENTER, or click the AutoSum button again, to view the - i
result (Fig. 1.23). 2 AutoSum *
E Lum '
e T TR i fvenge "
Roll
1 mT‘ T':;' “:;“ “:;m Tx‘ AUsTage Count Numbers
1| aoo2 8 a0 37 Max
2 _ao03 | a5 36 az - :
5 ADDa 42 40 43 |
— l Fore Functions,.
Fig. 1.23 Result of AutoSum in cell E2
3. As you have learnt earlier, you can use the AutoFill feature to fill G132 suteg

ls
a range of cells. Select cell E2. Point the cursor to the fill handle i

(the small black square at the lower-right corner) of cell E2. It will change to a small black
cross. Keeping the left mouse button pressed, drag the fill handle to cell ES (Fig. 1.24),

i ' : o E P TOE e - o =

1 BaollMo. | Testd Testii | Testin | Todsl AWETagE 1  Aoldlbo. | Testl Testl | Teviin Taotal Aweiage

1| aom [T 4 4 1 1| aom a5 43 40 138

k] ADO37 13 = L1 3 ADY jL] &0 37 115

o an 25 [ &l 4] anoy a3 s | u 113 |

5 Aooh | a3 a8 ) N o = | |

Fig. 1.24 Use AutoFill to enter the formula in the Fig. 1.25 The formula is copied 1o all the cells
desired range of cells selected

4. Release the left mouse button 1o view the result (Fig. 1.25),

other AutoSum Functions

You are already familiar with the Sum function. It is inserted automatically when you click the
AuloSum bution.

Let us consider an example 1o familiarise ourselves with the other functions (Fig, 1.22),

1. Type the data as shown Fig. 1.26} in a worksheet. Select cell F2, click the AutoSum drop-
down menu arrow, and choose Average from the AutoSum menu. The Average function wil

LY POy 1n

L]

T e ] @ EE © i
5 W o EEEE ® & s !

UE BES BEEE BEE . T

E E 5 ®m EEEEED " e ®m Om - E mE = = - e e W l
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1

i=

- . . ] [ ] E ( ] ¥
1] welwm | Vel Lot LTeum | teal 1| menpie. | westi | vestw | vewim | vwwni | Awerage |
g soeu L L] & SEVIRRGE]EL T4 20 aem i " 138 i
PR - . 1y B T e 1 ] = a0 T 1
4 oo ) ] a3 EFT] i 4301 o ib i 11
¥ ] = - . 1 5 A £ ] a1 in
® B
T shisbemm 7 mawbmiim
1 Misleeon i Snbmam
] _M— 3 Mm, i Fudenisl

Fig. 1.26 Average function

Fig. 1.27 Resultof the formula

be inserted automatically. The range in the formula is B2:E2, which is not what we want,
Correct the cell range by changing E2 10 D2.

2. Press ENTER and you will get the result

(Fig. 1.27},

3. Select cell F2. Point the cursor to the

lower-right corner of cell F2. Keeping
the left mouse button pressed, drag
the fill handle to cell F5. Release the
left mouse button to view the result
(Fig. 1.28).

4, Now, let us select cell BT and
choose Max from the AutoSum
menu. Correct the cell range in the
formula to B2:B5 and press ENTER
to view the result (Fig. 1.29),

5. To fill the remaining cells in the row,
first select cell B7. Point the cursor to
the fill handle of cell B7. Keeping the
left mouse button pressed, drag the
fill handle to cell F7. Release the left
mouse bution to view the resull
(Fig. 1.301,

A B C ] E F
1 Holl Ma, Testd | Testfl | Testm | Total | fwer
2 ADGE 45 43 & 128 &
E AD0L 13 an ar 115 5rs |
4 Aphi 45 a5 a2 133 (]
H AD 4] 40 41 125 1S
B '
T Manireim
i Minimam
5 | Mo, o et

Fig. 1.28 Using the fill handle for F2:F5

A ] c b £ F
1| motino. | tTemt | Yestuw | Testm | Total | Average |
F R ADD1 a5 il an 128 ]
3| ADO7 k1] 40 ” 1% 575
& | ADCA a5 ik ax 153 665
51 Apoa a3 40 iy 175 BL5
[

7 MEximaim [
& |Misimamm
§ [Mp, ol Shadenks|

Fig. 1.29 Max function applied in cell B7

— E c 1] E F
1| moimo, [ wests | Testn | Testn | Totsl | Average
2 D01 £ 41 ap 123 i
| ADOZ 1 a0 7 118 575
1 AD03 a5 2 A 1m 6.5
5| ADM a2 a0 &3 125 [T
4,
7 [meanbmum a5 a6 a 133 165
A 1
9 Neo. of Students|
Fig. 1.30 Using the fill handle for B7:F7
11 OXFORID
s EE = . asieteery et
4 W EEEE B = ®
4h EEE EEEE BEE &G
& B 58 @ EEEEER @ Em B B o
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b. Let us now try the Min function, Select

cell B8 and choose Min from the
AutoSum menu. Correct the cell range
in the formula to B2:B5 and press
ENTER to view the result (Fig. 1.31).

. As in the case of the Max function, to
fill the remaining cells in the row, first
select cell B8, Point the cursor to the
fill handle and drag the fill handle to
cell F8. Release the left mouse button
to view the result {Fig. 1.321,

- Finally, let us select cell B9 and choose
Count Numbers from the AutoSum
menu. Correct the cell range in the
formula to B2:B5 and press ENTER 1o
view the result (Fig. 1.33). This inserts a
formula with the Count function. The
Count function counts the number of
numeric values in a range.

A 1o = D E

1 Rall o, Tastl Testll | Testil Total Aver,

2 aooi a3 43 0 128 _h,‘t

b | ARG s a0 7 115 ¥y

4 AL} 45 ae a2 111 8 1

5 ADD4 47 o a3 w | s

& e

T Masbmum &5 A% 43 133 T

B | Mbnlmaim 38 _—_i

] lm.ul S

Fig. 1.31 Min function in cell BA

AN c D : F

1 Rodl N, Testd | Testm | Teston [ Total | Averape

2 ADDE 45 a3 &h 128 i

3 ACER 33 o 37 118 | s

i A a1 45 a3 3 B |

5| aoM __42 an 43 125 B1%

-]

T Manimaim a5 as 43 133 565

8 [Minbmam 18 a0 w_| 1 _m

2 Noal ﬂuﬂﬂ L

Fig. 1.32 Copying the formula in cells C8 to FB

(" Top Tip

The Quick Analysis tools also let you total your numbers
quickly. Whether it is 2 sum, average. or a count, Excel shows the
calculation resuslts right below or next to your numbers.

1. Select the cells that contain the numbers you want to add or

count
2.

Click the Quick Analysis button at the bottom-right corner of

A& _ = o [ i
t [ moti No. Testi | Tesihi | Testmn | Totad | Awerspe |
3 | Annl a5 L] A0 138 =]
| 3 | ADOI L] A a7 1% 57.4
a4 | AO00 i3 Ak 43 133 56,5
5 AT 43 an a3 135 6.5
L]
7 M-l'rlu'll 45 5 a3 133 B85
| e [T 4@ a7 115 578
J 5 Mo, ulﬂhﬂlﬂq &
Fig. 1.33 Count function in B9 Wl
- R lom
- D—
& [ ] [ [H] ] [}
1 13
I oW
U
L) a4
1 a
. 'E =
LT TG, [a E 1 LLLE LY

FapLrh ERLMT

iheselecrian. I 1 s e i
1, Click TOTALS, move your cursor across the buttons to see the ool oo Mt ol
calculation results for your data, and then click the required AT s et
button. —— —— —
LA a " EE ® e A

E = N WEEE B = .
EN EEE EEEE EEE W& . 8

w e e 8 _FOFRSS S Sy w I T m = n'_."J
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e
PRACTICE TIME [
i
"Apna Store’ maintains data on its employees in a b, K .
worksheet as given on the nghr. List che SLERS [0 : il - am a;,::_ ;'$
calculare the total, average, maximum, and minimum : %E ::;Ihr-lﬂn Arvwar ﬁ
salaries. Also find our the number of employees working | $ Eid £5000
X E E10% ivala Yiar 42000
in the store, 1
(] Total Salany
! vt age Salirg
n Bt | musm Salary
SOLUTION X i
1. Type the data as shown in the worksheet alongside. | —
. - [ootimplopern] |
2. Select cell C8, chick the arrow next ro AutoSum and

select Sum, The formuta will appear in C8 Correct the cell range to C2:C6 and click Enter. The
total salary will appear.

3. Select cell C9, click the arrow next to AutoSum and select Average. In the formula that appears
in €9, correct the cell range to C2:C6 and click Enter, The average safary will now be shown in
cell C5.

4 Select cell C10, click the arrow next to AutoSum and sefect Max. Correct the cell range to C2:C6
in the formula that appears in €10, and click Enter. The maximum satary will be displayed.

5. Mow, select cell C11, chck the arrow next o

A [ 3
AutoSum, and select Min. The formula wil s [ Employse e | Emplopes Mame | saiary
appear in C11. Correct the cell range to C2C6 and : = ::ﬁ mh;T_ ﬁ
click Enter, The minimum salary will be shown a [T W Khawar 53000

: 3 i Esza hles 5000

& Finally, select cell €13, click the drop-dawn menu |, ™55 e S

T
arrow of AutoSum and select Count Numbers. 4 e
The formula will appear in C13. Correct the cel 0| salory 52800
i 19 Maximum Salary | #5000
range 1o C2:C6 and chck Enter, The number of 1| L! :@r -
i i
employees will appear. | i — :
7 The final worksheet will look as shown alongside. :

FUNCTIONS UBRARY

Functions in Excel are predefined formulas that perform specific calculations. We will discuss
some basic funclions here.

Click the FORMULAS tab (Fig. 1.20). In the Funclion Library group, click the tunction button for
the category of function you want to use, such as Financial, Logical, Text, Date & Time, Lookup
& Reference, or Math & Trig. Then select the required function from the list that appears.

13 OXFORD

. - .. . = EETIRELTTY S
' | B W & u B oEER @ | B
§ BERA me — e A e -E-_--. sEEm .-....'
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Let us learn about two functions in the Math & Trig category: GCD and LCM.

GCO

This function calculates the GCD or the greatest common divisor of two or more integers, The
greatest common divisor is the largest integer that can divide the numbers without a remainder

It is also called the highest common S ST ——— g
factor. The steps 1o calculate the WOME  BEEIT  BAGELAYOUT  IDRMLAS  BATA  EDEN v
GCD are as follows: A S H BoR BE B -
Badinem l.,p..r = E bah B bl
1. Type two numbers in cells A1 and o o< m- SRS ronctons M)
L LT &1 U= i
A2, Select cell A3, which is the 2 i :L s L.
a1 - 3 [l TR
cell where you want the GCD of o i 2 E 3 : o i
the two numbers. Click the Math ' i = ] ' "
" (Y] |
& Trig button and then select H i | p
GCD from the drop-down menu - 'E
(Fig, 1.341. Fig. 1.34 GCD function in the Math & Trig menu
2. The Function Argumenls dialog box pu T L SR
appears (Fig. 1.35). Type Al and A2 — Bl ™ (R
in the Number1 and Number2 text o B - =
boxes, respectively. e L 1.
Observe that the result of the formula 3.
appears near the bottom of the dialog | s ne prsen sese s e
I:H:I-:I:._ Ehck DH\. L2 ST P T T e
3. The output will now be seen in cell
ﬂ} Tormas s = §
LG fig. 1.35 Funclion Arguments diﬂlﬂg bhasx 3
This function calculates the least common multiple of two or more integers. The least commaon |
multiple (LCM) is the smallest positive =
integer that is a multiple of all the ‘- N A R S e o 4
given numbers, The steps to calculate F T EOEBDD 1*|E|‘ B =
LCM are: e Aaituifurn Rarwcly Foupiad logusl Tas Omed Lok & [T N - Har
Vi T # L~ . = T s B lh- -
1. Type three numbers in cells A1, A2, | | z :mm-# s
and A3. Select cell A4 where you — " : : ' :':E ’
want the LCM of the three numbers, [t o A Lo
L H 2 i
Click Math & Trig and then select sl 2
LCM from the drop-down menu L w16
(Fig. 1.36 Fig. 1.36 LCM function in the Math & Trig menu
OXFORD
FEMTRREFT Mo : . : . =: B 14
B E [ a = N
- L .=..--..====-...I.=l [ - ] - E EE =m = - = _EH--'-
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2. The Funclion Arguments chialog box appears (Fig 1,870 Typee A1, A2, and A3 in the
Numbert, Number2, and Numberd text boxes, respectively, Note that the result can be seen

near the bottom of the dialog baox,

Fumtson Argummrsty
(T4
Ml A E - 1}
Mol A2 'i1 = M
] Membral &Y El = W
- Humbnd ;E e
L]
=
Brvarm Tot ieRit CRAMEA mu oy

caremicn mudiple,

Torrali iiufl = e
= | #raeni hundon

MumbmsL: fromber] numiieil b 118 I5% v Rar which pou sl S b

s 3. Click OK. The output will

appear in cell Ad Fig, 134

Creating a fFormula Using Insert Function

2. Click Insert Function | on the
Formula Bar or click the More Funclions
option from the AuloSum menu
(Fig. 1.22) or click the Insert Function
button in the Function Library group on

d the FORMULAS tab (Fig. 1.201.

3. The Insert Function dialog box appears
(Fig. 1.39),
4. In the Or select a category box, select

Al If you are familiar with the function
. categories, you can also select a

calegory.
5. In the Select a function box, select
the function you want lo use and then

click OK.

Fig. 1.37 Enter the cell references to calculate the LEM

1. Click the cell in which you want to enter a formula,

A

1 iz

F) a4

3 ia

q | 396

LTE.‘_EH cancet_| Fig. 1.38 Culpul in
cell A4
s Funcion e
Seari Far & fannlion
[Type & briet deversstion of what peu waet 13 35 and then E G |
I-ri_lﬂ EP —r - — .
Or el & gutegory | Maih &Trg 5 E|
Sebeocl 3 Panctio SeheCh 2 calenoey
FACTDOLEAE -
FLOORMATH Select 2 function
GLo =
[l |
e e e ]
LH -
LG -
LA (et L, il )
Bt Bre leart common maiBigle,
Chck OK

Fig. 1.3%9 Inserl Function dialog b

b In the argument dialog boxes that are displayed for the function you selected (in this case

LCM, enter the values or cell references, or select the cells that you want to reference, and

click OK.
o
[ i
l:'...-"ln - m E Em = B

DX FORD

Wi E T PR
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Tricky Terms=

Formula 2 sequence of values, coll references,
tunctions, and’or operators in a cell that
produces a new value from existing values

Test String  a sequence of characters on which
subtraction, multiplication, and division
cannot be pertormed

memory Buytes

A formula in Excel always starts with an equals
i=] sign.

+ Formulas can be entered in the Formula Bar or
in a cell.

» There are three types of cell referencing—
relative, absolute, and mixed.

* The detault cell referencing is relative.
* The $ sign is used for absolute referencing.

«  Text iormulas involve concatenation of text
strings.

Descriptive Type Questions

1. Answer lhe following.

Eﬂl‘ll‘.’-ﬂ |L“I'lﬂ|iﬂl'l ”“1 F“'“l 55 []1l iI:ZHI I'L'HH.', lesf 'lr'.1|||r-|

in ¢ Series

Function a pre-defined formula that perdonms

specific calculations

Painting adding a cell reference to a formula by

clicking a cell or a range

The concatenation operator is &' (ampersand),
Numeric formulas invalve the use of various
arithmetic operators (7, %, /, + an -,

The AutoSum feature automatically adds
numbers in the selected cells.

The AutoSum menu provides access to Sum,
Average, Count Numbers, Max, Min, and
other functions.

The Insert Function bution is used for adding
and calculating functions in a worksheet,

a. What is a circular reference? Explain with an example.

b. Write the steps to find the LCM of three numbers.

c. The two ways of entering a cell reference in a formula are () by typing and (b) by pointing.
Explain the difference between the two methods,

d. When you enter a formula and click Enter, it displays the caleulated value, What will you do to
display the formula?

e, Name the arithmetic operators you can use in an Excel formula.

QX0 16 :

[}
g = & & . 1
" mEm @& um .i
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f. Your teacher has asked you 1o use an Excel sheet to record the marks of your class in the
following subjects: English, Science, Mathematics, and Computer Science, With this information
you can then calculate the average marks of each student and the names of the students who
scored the highest and lowest marks in each subject.

» Compare the different methods of creating this <heet,

+ Give reasons as 10 why you would select one method over the other,

Assess the advantages of relative, mixed, and absalute reference cells in Excel 2013

Create a table showing your own overall average marks in all subjects. Make separate columns
or rows showing the subjects in which you gained the highest and lowest marks.

- oo

Application-Based Questions

a. Mehak wants 1o calculate the total of three values in cells A1, A2 and A3. She &
has written the formula A1 + A2 + A3 in cell A4, but did not get the required |
ANSWET, 2 14
i, What is wrang with the farmula entered in cell A42 How can itbe corrected? | &4
ii. If she changes any value in cells A1, A2, or A3, will that affect the value | 4 | A1+A2+A3
in cell A47

b. Consider the worksheet on the left:
i. What will be the result in cell B4 if you click Enter?
i, If the formula in cell B4 is copied and pasted to cell D2, what will be the formula and the

resultant value?
iii. Which type of referencing is this?

A |8 ¢ O
1 | 2 a & i
il 5 o N 3 mn
3l & 1 | 2 1
-l_! 2 |=ad+B3 2 &

c. Anam has written the formula =$B81*A1 in cell C1 as can be seen in the worksheet alongside.

i What will be the resultant value in cell C11
. What will be the values in cells C2, C3, and C4,

handle through the range C2:C47

if you select cell €1 and drag the AutoFill

iii. Which type of referencing is this (SBS1 and AT}
e c _
il s 1 9 ) =sBS1*Al
i [ 3
3 i Fi
4 8 6
AR R TR
amE & - - ms m @ R LIE TII1T] B oEE 8 B .=
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N

L " ¢ o d. Aman wants 1o calculate an 8% discnun A
; ""'I"‘rl"“":  em Price | Divcount Amsount | Het Amoint | the item price and then the net amoun as. 0
IR @day 13800 P =

3 Telewision %00 given in the worksheot an the lefi,
4 SO Baver 400 . What should be the formulas in el
5 Tablet 14800

——

_‘___'—_h

C2 and D2?
it How will you copy the formula in o)
C2 10 C3:C5 and in cell D? 1 D305

P E €

l'hﬂmﬁuﬂ Area Cittumleieng |

IN THE LAB 4 — ==
1. His Mathematics teacher has asked Aman to create a & ]
worksheet that will calculate the area and circumference : :
of a circle for radii ranging from 1 cm 1o 10 cm taking the Y -
value of Pi = 3.14. Can you help Aman in his task? How will 4 !
you proceed? 18 3
11 | 10

& L] £ E

] i L3
e u g w s lulwlwlw sl 2 Seemas Mathematics leacher

has asked her to create a
worksheel 1o print the first 10
multiples of the numbers from
11 ta 20. Can you help Seema
in her task? A sample worksheet
15 given on the lefl,

E‘..ﬂ-ﬂﬂ-ﬂ.‘._l—.-
|
R N RN Y 1

3. Myro Pvt. Ltd. maintains data on its Y s = =
salespersons in a worksheet as given on the § o tame &L"'!_ﬁ Comamivuian |16
igh. - o
List the steps to calculate the commission (10% T T Frree
of sales amount), the total, average, maximum g = lmne Gy | viiomn
and minimum of the sales amount, and the " ol
COmmission, y —

o s [ ] E i} [
primml e J e | mee | ow |, The Krio Computer Stationery Shop maintains its stock
: TEE‘? - using the worksheet given an the left.
» i vt — b Write the steps to calculate the total {Quantity * Price
R T and the grand total (sum of E2:E11) of the value of
T ;Lu - = stock held,
1] B8 Jui e H e
u e vy ]
NFORTY .
Enl-nrn LT -] = mn W 1E ;:
B B i EEEE &= B 1
OE DEE EEEE oeE : mey
E B Bm B EEEREm ] = o\ m - s e = =
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GROUP PROJECT

Choose 4 international footballers (preferably not goalkeepers) from 4 different countries.
Carry out a small research project and find out the number of;

times these players have played for their national teams

times they have played for their current clubs

goals they have scored for their national and club teams

Using this information, create a worksheet 1o calculate the average number of goals

and the most number of goals scored by each player. Find out which player scored the
highest number of goals and compare your findings with other groups.

L1
=% TEACHER'S NOTES
* Discuss various real-life applications of Excel formulas,

* Demonstrate the uses of the Sum, Average, Max, Min, and Count Numbers functions with appropriate examples,
* Show sludents some examples of formulas that give ermor results and how 1o correct them,

wll

n =
"] WE |
L] -

19 .
" mm ®m a OXFORD
HE EOEE B @§ @
e - R T i _HEE OUEEN EEE oo
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whapty,

Creating Charts in
txcel 2013
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easier for us o ulluhtr-d.nntl L1r}::-qul..mllqu--.nl clatar, Thiy help in this Chapter
us “see’ the relationship between dhifferent parts of the data,

Excel supports various types of charts, You enter thatar in « Types of Charts
tabsalar form and wse it to create o chart, A chartin Excel is » Companents of a Chare

» Creating a Chart
s Sparklings

linked to data in the worksheet, I the data is moddificd, e
¢ hart wall change too.
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You can create a chart from the data entened in o worksheet,
We will usis thee dhata in igne 2.0 o create charts of different s T L
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{ine Chart

A line chart (Fig. 2.2) compares trends in data

at equal intervals. Line charts are usefyl for
depicting the change in a value over 4 periol
of time. They are a good choice when vou have
many points to plot or when data trends are
important.

Line charts are usually used 1o shaw production
or sales trends over a period of time,

column Chart

A column chart (Fig. 2.3} shows changes in data
over a period of time, or it illustrates comparisons
among items. Categories are organised
horizontally and values vertically. In a eolumn
chart, each data point in a series is represented by
a column that rises from the x-axis.

Column chars are useful when the height of
individual points is more important than the trend
in a series.

3-0 stacked Column Chart

Dietakls of Campany A
1 AR
LN
L5
WD
LRI I
FAENEE -'...._,.r"._
: Tor' 1 .....*:I'u-.- _“Im i LETTR
Fig. 2.2 Line chart
Dietadls of Company' A
LiTimne]
LN
L]
o]
A
AL L
[
— |l-ll|l- -T' bl

Fig. 2.3 Column chart

A 3.D stacked column chart shows the part to a whole (Fig. 2.4).

Bar Chart

A bar chart also illustrates comparisons among individual items, Categories are organised
venicn]ly and values harizontally (Fig. 2.5). A bar chart can be described as a column chart

drawn sideways.

Detally of Company A
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Fig. 2.4 3-1 stacked column char

el

Detalls of Company A
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Fig. 2.5 Bar chan
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scatter Chart

A scalter chart plots cach data point with a
marker (e 2o Unlike a line chart, the x-axis of
a scatter chart has numbers and not text labels,
So, s-axis tick marks are spaced according 1o
their values and not just evenly spaced along the
anis. Scatter charts are useful to plot relationships
hetween linked sets of numbers, for example,
height/weight and price/sales.

The points on a scatter chart can be connected
with a line, but it is often used without

Y
| f
Details of Compary A X
| £
|
R 5
| s .
innh ¥
r -
A
- - - & L]
B ]
a
a 1 1 -1'. £l % %
. e e e —

Fig. 2.6 Scatter chart

connecting lines, You might use a scatter chart when your chart has many data points but then:

is no particular trend in their rise and fall,
o =

Details of Company A || Pie Chart

Fig. 2.7 Pie char

Doughnut Chart

A doughnut chart shows the relationship of parts to a whole,
Unlike a pie chart, it can contain more than one data series.
Each ring of the doughnut chart represents a data series. In the
chart shown in Figure 2.8, the inner ring is for expenditure and .| wesr] S¥eard BTeed BTeard mlamd

the ouler one is for revenue.

— e T

Dhftalin of Compsry &

P W

LT R ]
Phasis W imeea

Fig. 2.9 Arca chant

(¥ FORD
I TIIE LRl IR “ .- “

o H EEEE & i
@ EHER EEERE EEmE ©

IBRE

B e

| A pie charl is used to plot data for a single data series. The

pie chart shown in Figure 2.7 represents the expenditure A
| figures of Company A for the past five years. Each data point

I1 is represented by one ‘slice’ of the circular pie chart. The sizi
svesi1 wteard mrewd sreaed mvews || of gach slice is proportional to the value it represents; so all
the data points taken together make a complete circle.

— —r o —

Detalls of Company A

\
ki el |
f

Fig, 2.4 Doughnut chart
Aarea Chart

An area chart (Tig, 2.9 is similar to a line
chart but the data point markers are not
displayed and the area beneath the lines 1s
filled with colour. You can also plot series
one on top of another, producing a total.

An area chart emphasises the magnitude

of change in data over time, It is mainly

e

used for representing sales and productiof
fipures.
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padar Chart

A radar chart (Fig, 2100 plots data in concentric cirelos, Fach data series is plotted along a

separate axis from the centre point 1o the outer ring. Lines connect values from the same serics

Detalls of Company A i Dietails of Company &
Tran i
Nn
Liiiie]
LEELES ] W)
Trark it L
HINTE ’____,—*
|
[ B figsure |
Vel i
oo Yourd | R wewid 'HI:M“-#
——lErinr g | [ Bt oo B ROy LIS e n )
e 1

Fig. 2.10 Radar chan

3-0 Surface Chart

Fig. 2.11 3-0 surface charl

A 3-D surface chart (Fig. 2.11) creates a three dimensional view of data. A 1opographic map is

an example of this type of a chart.

COMPOMENTS DF A CHART

We have seen the different

types of charts that are possible
for the same data sel. Let us

now understand the various
components of a chart, as shown
in Figure 2.12,

Chare Ticle

Details of Company A
|
1090
Yeanm - V00 Gl
[ ]
-
AT ]
| 2
| o
Aoy Take 1..__ r YeurS -I
[ Slrenas | M7SHO0 | SO4S34T | TOAINAS | B000N00 | | 000000
| = Capendunrs | |00 1M | 300870 | 10000 | 300000 Legend
¥ o S
Data Table o G

Fig. 2.12 Componems of a chart

also known as the category axis,

It is the vertical axis of the chart. Itis also known as the value axis. The value

of each data point is plotted on this axis.

Data Table Il refers 1o the
sol of data
values from
which the charl
is derived.

X-Axis It is the
horizontal axis
of the chart. It is

Y-Axis

AT

2d

O FCrR

EELET RS P
(=]

o
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Chart Title Itis usually placed at the top of the chart and helps the user understand Why

the chart represents, z

Axis Title It is the title given to an axis. A 2-D graph has two axes (x and y) and a 3.

one has three (x, y, and 2). %

Chart Area It refers to the area within which all chart compaonents are placed. Often, i i,

surrounded by a border,

Iis the rectangular area bounded by the two axes. The x-axis and the y-axs
define the two sides of the rectangular plot area.

Plot Area

Legend It identifies the data series, A unigue colour or pattern is assigned to each day,
series 1o make it easier to distinguish them visually.

Gridlines Lines that run across the plot area from each category on the x-axis and from

each value on the y-axis, You can choose -
whether to display them or not. They make it Top Tip el
easier to identify the value of each data point '

on the chart. When you move the mouse
pointer over a chart object, Excel
Data Label A label that provides additional information displays a screen tip with the

about a data point on a chart, COMPanEnt name.

o -l

nr

Charts in 3-D have a base area (the xy plane)
known as the floor, and vertical areas (the yz Sales Amount la
and xz planes) known as the walls (Fig. 2.13),

Therefore, the two walls and the floor make
up the plot area in a 3-D chart.

In Excel 2013, there is no limit on the

number of data points in a data series. This Wl o Yewd

does not mean that you can have infinite ] -

data points. The number depends upon the Fig 2.13 Walls and fioor of 2 3-D chan |
memaory of the computer.

CREATING A CHART y

Now that we are familiar with chart types and chart 1| Name | Testi | Testh |
components, let us create a chart. 2 | Essa o il
' : i|N
1. We first need 1o enter data in a worksheet. In this : 5:;: :: ::_.J .
example, we will use the data from Figure 2.14, Enter

5 | Bisma B4 72
the data of two test marks of four students and select the : = = |
range A1:C5 from which we will make the chart, Fig. 2.14 Data in the workshed |

OXFORD | . ey » 24
g = B EEEER ® ] g u
- - -|=.--‘..-====-..--n.:.n Eu - - = = .1:-'..
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2. Click the INSERT tab. In the Charts group, click the - k- o
Column drop-down menu arrow (Fig. 2,151, ¥ i ) e e

3. Click Clustered Column in the drap-down list (Fig, 2,100, |lE:ﬂ] mH i| {i Coluamn
L1l

It is the first from the leit in the 2-D Column section.

30 Conlumn

Coabamry diogs- o menu aroy m‘m JI|'-=I'|E’-IF ||Il;5q
- E=R & j |
l? ;:'H i B ] E [ﬂﬂ

Hﬂﬂ-l‘l‘ll‘ﬂﬂ‘l‘ldﬂd F . FI‘.‘H'I:I'[C"I-IFI Fiew  clurn CHarks.
Chats P~ ki~ 2 ||
Charts f Fig. 2.16 Column drop-
down menu

Fig. 2.15 Charts group on the INSERT tab

4. Excel graphs the data in a 2-D column chart and places the chart in a box in the centre of
the worksheet (Fig. 2.171.

T Ea [RRE P p—— P Eeal TREX) e v
h [ T B =T TORNNE LT R R E R IEusi B TR g g
—
=0 T —— — ¥ = s .'- r: l F . *  Charweed Cplur
JU & oluman gy gnay goh SEERY e s 4 I | I et
it T K2y [rir [ I l | =
s e 1o o Al el :
Poa® | = L = | =
& [ i (] ] L ¥ GO Foritg el ' l ' l :
o= CWET T TR .
|5 ma ut | . (2 A —=-h =
lo %l | w5 1 & | FISEFLS
i hebas | om @ 1 = I
: [ - H I - ‘=: o+ ! ;H-’-J-.-——-u“w
Bl 1 - - — | |
i - H e
W i T —_— |
ir B i
1] : &
= - —
u - . —
; : ' o s
i 2 i e Rk lerma
L ¥ 3
g e g Fig. 2,18 Insert Chart dialog boy
]
" - . e sl Sl WS # _‘i

Fig. 2.17 Column chant in the centre of the worksheel

You will see that two new CHART TOOLS tabs have appeared on the ribbon: DESIGN and
FORMAT, In Figure 2,17, the DESIGN tab is selected.

* You can change the size of the chart by dragging ils corners,

e You can also move it to a different part of the worksheet by dragging the white background.

If you are not sure which type of chart 1o create, click the Recommended Charts command
iFig. 2150 1t will apen the Insert Chart dialog box with suggestions for several different charts
hased on the data (T, 2,18,

25 OXFORD
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Select a chart in the led prane il click OK. It will be inserted [ Top Tip 1

in the worksheet. Vit
You see the CHART TOOis A

The DESIGN tab gives you different choices on layouts anil tabs—DESIGN and FORMAT—. 1

stylis for vour chart, You can also move your chart o 2 new

location:

only when a chart is seleeted |f
you cannol see therm, it meany,  *

na chart is sebected. Clhick
1. Click Move Chart in the Location group. The Move Chart your chart to select it and the
dialog box appears (g, 210, additional tabs will appear.
2. Click New sheet and type a name lor the new  [leecm s el b-'.i"

sheet. Let us name the new sheetl Column
Chart. The chart is moved 1o a new sheet in
the workbook, named Column Chart (the
name you typed),

The chart is automatically scaled to fill the
entire page in landscape orientation,

Chart Elements

{ramE wheee g wind the iha i o gleond

H_J,-IJ o P e | e (el

ﬁl_i"_iﬂ ) puiete theets i

[ on gyl [ o

Fig. 2.19 Move Chart dialog box

You can add or change many chart components such as Axis Titles, Chart Title, Data Labels,
Data Table, Gridlines, and Legend using the Add Chart Element option. Click Add Chart

Element in the Chart Layouts group and select the required options.

Chart Title

Chart Title options are None, Above Chart, and Centered Overlay i1ig. .20 Click Above
Chart and the Chart Tille text box will be added to the chart (Fig. 2.211. To edit the chart title,

double-click the placeholder and type the text.

T
b Chat Dk
heerwd = Lot -
18 daw B
E!l .ﬂe.lll!ﬂﬂ L]

Chae Taie ¥ = .
JEFE
[lats L abel ¥ M '

Dt Talle ¥ | - |
Abivw Chart
[ives Bait L] Itlﬂ:h

Grudlanrs ’ |.|IJI Cerbeved Darilay
prgend "

BEREE M

Ko TEle Dptafr .

I Truruilorer [l

Fig. 2.20 Charl Title options
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Fig. 2.21 Chan tithe above the chart
.
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anis Title 1p o
Axis 11th¢ allows you to add titles along the x-axis and o
thE '!ll"a“lﬁa Hement= Layout =
1.'] Al ¥

« To add an x-axis title, click Axis Title » Primary B LR Ty S

Horizontal (Fig. 2.22]. The x-axis title text box will et L]

appear. Double-click on it and change the title to & Detalasels  © iy | primary yerwcl

. Data Tagl L !
Name of the Candidate. : g.:w: o | hdoww A Tite Opbemi..

« Toadd a y-axis title, click Axis Title » Primary
Vertical (Fig. 2.23). The y-axis title text box will
appear. Double-click on it and change the title to Marks.

Fig, 2.22 Primary Horizontal option

Results of Test | and Test Il

10
| -0
@U i gl sl Zabibs Plarms

§
i AusTale ¥
& Chae Tale LN | I, .
B Dstelabels @ :Eﬂlﬂ By Yrtical Marme of the Candidate
i ODstaTaple *+ L : ret e
ii t‘l‘l’ﬂrllfl ¥ Hﬂrh&l'l'ﬂtﬂpbﬂl..
Fig. 2.23 Primary Vertical option Fig. 2.24 Column chart with Char Title and

Axes Titles

The chart will now look as shown in Figure 2.24.

legend
Legend displays a drop-down list with many options.
You can hide the legend by clicking None,

T O Click Legend » Left (Fig. 2.25). The legend will be
: :::L:: : placed to the left of the chart (Fig. 2.26),

By Dlata Tagle ¥ I|

& [rres Bany ¥ : Results of Test | and Test 1l
| B grdees 0 .

100
it R e “
| Irending | el i g
; : e : || aTeud o
I8t Er o 4 _ 2

“"[ ] 1‘-; Iep Baw Masel  Sshily  Bism

nj | Mame of ihe Candidate
o i et
Fig. 2.25 Legend options Fig. 2.26 Chart with the legend on the left
B 27 - an - OXFORD
- B e T PRk
fanlal - . .ietasd _3EEE Bea®al

Scanned with CamScanner



Data Lahels
You can display the value of each column on the chart. Click Data Labels and choose the lahe
location (Fig. 2.27). The chart will look as shown in Figure 2.28.

ﬁ Results of Test | and Test Ii
Queck m n® e
Layout® "
E Ages LN &
B AT wTewl i ]
E ChaaTae o] S o — m
& Detslabes  » | li! o
biare Essa Masel  Sabika
: :ﬂ"l".:'ll'l':Ilml : ‘ Hame of the Condidate
AT ¥ ;HE’
ol i | : ! ;
4 Legend I Fig. 2.28 Chart with outside end data labels
L kb * 1
bt Irendine v | flpy Inside Bese I-
I g Dowri Barg 8 |
= — flly Qusdeena I Data Table
e : The Data Table option adds a table with the
Fig- 2.27 Data Labels options data to the chart. Click Data Table » With Legend
Keys iFig. 2.29). The chart will look as shown in
Figure 2.30.
i -
i A TeEln ¥ |
E LhotTde | Hﬂuh‘ldﬁﬂllﬂdTnﬂﬂ
f Datsbeh k] —_— w0
fh OstaTabte o+ [ o | e
i [[rreet Bar K @' o i : II II II II
B Gndhnes . E Yt Lagend Leys w Tesi | 1‘:
ﬂ] Lrgend ¥ BTt EIJ'HLI |'|||||1'I'|.|
et |
L " m Mo Legend Keys alesth & ﬂ il- 'ﬂ
E’I Itufmf“ : _m._unm'rmﬂwm Hame ol ik Condidats
Fig. 2.29 Data Table options Fig. 2.30 Data table with legend keys 1

Gridlines
Gridlines in the Axes group allows you to specify how gridlines should be displayed on the char

Major gridlines are gridlines at large intervals. Minor gridlines are arranged at smaller intervals
(Fig. 2.321, For both horizontal and vertical gridlines, the options available are Primary Major
Horizonlal, Primary Major Vertical, Primary Minor Horizonlal, and Primary Minor Vertical
(Fig. 2.31).
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Fig. 2.31 Gridlines options

Chart Layout

If you want to quickly add chart elements, click the Quick Layoul

button in the Chart Layouts group.

Click, say, Layout 9 (Fig. 2.33). This layout adds the title to the top
(centre) of the chart, axis titles, and moves the legend o the right

{centre).

Chart Styles

You can format Excel chart components to make a chart look
more attractive. Excel also provides ready-made chart styles. To
see them all, click the More arrow at the bottom-right corner of

the Chart Styles group (Fig. 2.34).

Fig. 2.32 Column chart with minor horizontal and
vertical lines

Fig. 2.33 Quick Layout gallery
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Fig. 2.34 Options of the Chart Styles group
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You can trv different chart stvles andl | Top Tip B :
: » that vou like. For
choose the ane 1. lt : ok You can use the Chart Formatting buttons (Fig 215010
example, Figure g SRS whal e quickly add chart elements, change the chart style, and filter
chart will look like in Style 8, chart data
Chart Elements: The first button is used to add chan
_+_ elements, Click the corresponding check boxes.
. Chart Styles: The second button is used to aded 4
."i chart stybe and a colour scheme to the chart. Click the
=% required chart style.
Chart Filters: The third buteon is used to edit data
T points and select the series and categories you want to
Fig. 2.35 Chart style 8 display in the chart.
Change Chart Type [ o o e e
Click the Change Chart Type button in the | (™==="="""
: | o R I-‘-LI = (E=m IE,_I'-Ir oo S
Type group. The Change Chart Type dialog || = ¢, EHIREE &F
box appears. Select a new chart type and el L E— Select A Eyout
the desired layout. Click OK. The selected :‘ ) | T I_ e
chart will appear (Fig. 2.36. e fl-ﬂ:—_:__'-" e liEE=——"
Lo wvsunes | R st PSS o R o=
| |l e i ., -
switch Row and Column Data bl . |t
" . | il i
Click the Switch Row/Column button in | o
the Data group. The rows and columns will o
be switched. Here, Name of the Candidate
and Marks have been switched (Fig. 2.37), - T
F Results of Test | and Test i 1 Fig. 2.36 Change Chart Type dialog box
. FORMAT tab
The commands for formatting text and numbers in/
.| chart are available on the FORMAT tab iFig, 2301
Fig. 2.37 ( alumn Chart after swilching
rovws andd columns
‘B H B s b 1 hgpm J sasiaun HE@ ruq_l? - E_ll
- seNd B PAEAA  MORMELAY  Bala  GEODW W AW DODEM Rl —
| g = B 3 o g 1 A LR O i
"o L Liwslls LA s L S i - *l =d et T
b T S E * ol T | B A A ﬂ il [RtdmeesPes L o' |
! Uiy L e il frham g L e LU L * g = -
Fig. 2,30 FORMAT tab cqions
ORI s
Ea’.nxi'\-lﬂlﬂ-! 8 o BE - Eu :.
B a8 5 BEEEE B ] =
59 EEE _EEEE _EEER @ T l_h
E E BRR B EEEEEE B s = ® HE B AR B = m R =En &
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5

i
. Click on the chart tithe 1o select it, Click the Text Fill drop-down menu arraw in the WordArl
Styles group and select blue from the drop-down colour palette Fig. 2 19 Similarly, make the

axes titles orange in colour,

Select the chart as a whole by clicking it. Click the Shape Fill drop-down menu arraw in the
Shape Styles group and select a colour from the drap-down colour palette (Fig. 2.4,

| |
Theme Colour
E EEEEOEBE

lifssusii
1T
Standard Coloar

EET DEODEERD

Lie Fin
& Move Fll Colours.

B Bicture

@ gozen .
F] Zeaum #
Fig. 2.39 Text Fill

Therse Colouwr
B EEEEm @S

illiii T
Srardavd Colour

Lz Fa

3 Ddore Bl Colaur.,

B Bt

@ Graden #
[ Testuwe "

Fig. 2.40 Shape Fill

Fig. 241 Formaned chan

This will set the background colour for the chart. Fill the chart background with light orange

colour. The chart will look as shown in Figure 2.41.

PRACTICE TIME

i

The class teacher of Vil wants to draw a pie chart that indicates the number of students achieving
a particular grade in a given rest. The class has 43 students Help him create a pie chast lor the data.
Alsn, format the chare and emphasise the grade with the maximum number of studens

SOLUTION

1. Enter the data shown alongside | 1
ina worksheer '
2. Select the cell range A2G3

A 1 & & £ ¥ &

" mhamber of Students in a Partkcular Grade
F Al A2 L} ¥ 1 (&)
3 cumwac| 1S 13 4 2 1 7

1 Click the Pie Chart button in the Charts group on the INSERT tab
4 A drop-down menu appears. Click the first optron in the 3-D Ple wection. A pie chart appeary

on the worksheer

5 Click the DESIGN rab. In the Chart Layouts group, click the Quick Layout button and select

Layout 6
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10
1.

12

13

14,

Creating

Note: If the tabs do not appear on the tibbon, it means the ¢ hart 1s not selected. Click on the
chart to sefect it

Now, click the legend to select it. Click the Shape Outline drap-down menu arrow in the
Shape Styles group on the FORMAT tab and choose blue colour from the palette. This adds a
thin, blue border around the legend.

Click Format Selection in the Current Selection group. The Format Legend pane appears
to the right. Click the Fill & Lime button, then the Fill option, and select Pattern Rl A lst of
patterns appears. Select the desired option.

Double-click the chart title text. The context menu appears. Change the font to Times New
Roman. font size to 14, and font colour to red

Double-click the border of the chart title text box. The Format Chart Title pane appears to the
right with the FILL option selected. Click Solid fill. Click the Color button and select Red from
the colour palette.

Select the chart title and change the text as shown below.

Dauble-click the border of the chart. The Format Chart Area pane appears 1o the night with
the FILL option selected Click Gradient fill. Click the Preset gradient button and sefect a
colour of your choice, say. green.

The percentage dara labels are inside
the pie. Click a label and drag it to the
ourside, Do the same for the other
labels,

Chek the shice with the highest
percentage and drag it out.

The chart will now look as shown
alongside.

a Combo [Combination) Chart

A combination chart is a single chart that consists of a series that uses different chart types. I
may include a second value axis. For example, you may have a chart that shows both columns
and lines with two value axes. The value axis for the column chart may be on the left, while for

the line chart it may be on the right. The steps 1o create A B c
a column chart are as follows: 1| Name \Hﬂ H_p_;]:
1. Select the data range A1:C5 as shown in Figure 242 2 85 SiTEns
5o - pre 242, | iR
2. Click the INSERT tab. In the Charls group, click 4|Mana | 52 | 1
Recommended Charts. The Insert Chart dialog box | 5 [Pasha |~ ss | 182
appears (Fig. 2.43). Fig. 2.42 Select the data range A1:C5
]
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| et Chartstah -
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i I; Lo T Frm
K™ n -
P, :: Weight and Height Comparisan
E : : .': | I : ::
|ty 3 Ciick the Seea . s
e Clamtered pgischeciner T || | 2 hozeh |
— ] | ?n B i
Cick Combo 5 ——— || » ol
1 |l ?.—H..L_- E = " 1586
1§ = ] e B o - . . 14
Select Line Click OK |i -
-,__—__EIIE__IH w—eigre figi  —— Height )

Fig. 2.43 Insert Chart dialog box Fig, 2.44 Combo chart (Weight and Height)

3. Click the All Charts tab.

4. In the list of chart types, click Combo,

. For the weight, select Clustered Column as the chart type.

. For the height, select Line as the chart type and click the Secondary Axis check box.

. Click OK to insert the chart, Give appropriate titles to the chart and the axes, The chart will
look as shown in Figure 2.44.

= & kN

A ] C 5] E F a

SPARKLINES ) g RkaedinteTs Pt -
A sparkline is a miniature chart embedded | S/ T ma [ o T i | o T o _.IHM!
in a single worksheet cell, It provides a e R
visual representation of data. There are LW = T T

2 u 15 b b1
three types of sparklines: line, column, WM e e T e
and win/loss. Line and column 5|::a.rk1ines | _; L ] i& n_
are compact versions of standard line and e . =1 =2
column charts. The win/loss sparklines e T e

indicate whether a cell value is positive i
(a win), negative (a loss), o zero (a tie). To create a sparkline, follow these steps:

1. Select the data (without the column headings) of a single row or if you are creating multiple
sparklines, select all the data, i.e. B3:F12 (Fig. 2.45).

2. Click the INSERT tab. In the Sparklines group, click one of the three sparkline types—Line,
Column, or Win/Loss (Fig, 2.40)

3. The Create Sparklines dialog box appears (Fig. 2.47).

33 -] (-1 -] ] =
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T
e e

m e H_ f —

Chaais 1hs date th you wanl .
o i I m [sts Range | BRA1D s
Line Column Win/ Eheats wheie pou i 188 ipsrickmes 19 Be placed
Lots {pestion Range: ~BGELIGHLN _E
Sparkdines
[ o ﬁl [ canest ]
Fig. 2.46 Sparklines group L |
on the INSERT 1ab Fig. 2.47 Create Sparklines dialog box
4. Specify Location Range as SCSISCS12 [ * ' C gy
either by typing or selecting the required |, il e | ot £[Mhonth 2| Manih 1 [Mianth 4] Manth 3 h
cell range. Click OK. P e o e e e = —_—
5. Excel creates the Sparklines graphicsof s+ 2 5 T o | = T
the type you specified (Fig. 2.48). Notice |3 }—2— 222 1 = L = = =——
the DESIGN tab that appears under N B e
SPARKLINE TOOLS ifip. 2. 49, ul i [TT] ™ Ta |
B = i} bt ¥ u v =,

6. You can change the colour of the
sparklines by clicking the Sparkline Color
drop-down menu arrow. A list of colours appears. Select a colour, say, red. You can chang
the Marker color also to blue. The graph will appear as shown in Figure 2,50,

Fig. 2.48 Sparklines graphics

Sparkline Colowr arrow Marker Colour a1
e T Vg [ ewrboctorest [ltmmord] dme FLt T T T@m - 0O 2
RASILAVOY  FORAAAS  DATA MWW VW TEMM DOGOW by

P Bt [ : gy | e 4 Gt
P A ey S d.'u'.l 'l'.r-F.' "-r-n.' "-h.f "Iﬂr-"u' d,-u.f la] n::':.... E L ren——
T . L B

- S o -

Fig. 2.4% DESIGN tab of SPARKLINE TOOLS

" Top Tip - . s ) : o ¥ RE
. i Attendance In Percentage o
To delete sparklines, do the following: : Hub"*:mu H';fl ‘-n:?l “;:H “T:H T‘E
4 2 e,
1. Select the sparkdines. v 13 : !::' :: :; ::: >
1. Under SPARKLINES TOOLS, click the : : | B Bl B - |
[ 1] L1 [k}
DESIGN b, S T e
3. In the Group group, click the arrow =% = 2 ] T P
it bl e ]
4 Clickcl | | : AT 5l W T 1] s
Fig. 2.50 Sparklines after changing line and marker calou
]
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DESIGN tab (Fig. 2.49), mr— v
g. The Sparklines appear as shown in Figure 2 51, HiEGukkAutptimn e o P

you draw charts and sparklines. Select the

A E C o F : A1C5 data range in the table shawn. The Quick
Y i ﬂ'ﬁ-..'-dlﬁﬂ.-'i.ﬂlll".lﬂ;-;n{.l_. . Analysis button appears at the bottom-right
2 Mell N | Month 1| Month 2| Month 3 | Month 4] Manth 3] Sparkine cormer of the selection, Click CHARTS. You can
: E:— ';‘ ; ’:; . LMY ] [ also choose SPARKLINES, but in this case, the

[h

: 2 - M = s :: . :::: data range selected should be B2-C5.
w4 | m n M 5 - BCR 2

3 B ) B - o= :
:. [} 1 b 1) s :_ﬁ :: '. ;-:. :E E Quick Analysis burron
] T Bl 545 iy a) a1 .o Ee .: i
w i as B 3 | sas M | _wBE H -
1n k] &7 3.8 1] ET) E BN | s — i ——
o wl el =T w 0w lieb agaes

Fig. 2.51 Sparklines in the Column style bl

Itis a good idea to label all your s and DVDs properly so that later you will be able to find the data you

are looking for quickly and easily. Keep CDs and DVDs in proper CD-holders or cases for easy access.

—

o
LN ]
Chart a pictorial representation of data Y-axis the vertical axis of a char, usually the
; - alue axi
Data Tahle the many data points from which a i
chart is derived Chart Area  the area within which all chart
X-axis the horizontal axis of a char, usually the components are found
category axis Data Label 2 label that provides additional
information about a data marker
. i « wa w g  OXFOKD
:.-. i un...= ==== : E m
g P m m Es 8 B " " ® __  smENEWm ..I.=l B = - -J
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memory Bytes

LR TR TR L TR 1-.111-;.- (L hdits i
Eae] 2018 sunch as Bioe chants, ool chars,
b« hats, dhoushinut charts. anea charts. rada
eharts soatter charts. pre Chaets angd 301

sptace hants,

Colum and bar chants compare values acnoss
cateseries, I onlumn chaet, the categon
ands s Borzontal and the value avs is vertical.
Bar Charts aee simifar tocolumm charts but the
catema anis s vertical, Bach column on ba
nepresents o sighe data value troa the data
tabrle

\ doughinut chart shows the relationship of
pats to the whole in a manner similar o a pie
vhart.

A line chart shows change over time intervals,
A scatter chart shows the relationships among
nwumenic values. or plots points between » and
v values.

\ charg has the follow ing components: s-avis.

veanis, chart title, axis titles, chart area, ploy
arca legend, gridlines, and data label.
When a chart is selected, two new CHART
TOOLS tabs—DESIGN anid FORMAT—appy
on the nibbon,

you can change the size of a chart In deagen
s Comicts,

you can mose 2 chart to different part of the
wirhsheet by dragging the white brackgrosmd
On the DESIGN tah, vou can maove a char,
added chart elements, change the chart lvout
aned the chart stvle

On the FORMAT tab, tools are available for
formatting a chart,

A combination chart is a single chart that
consists of series which use difterent chart
tpes, 1t may include a second value asis,

A sparkling is 4 miniature chart embedded in
single worksheet cell.

Objective Type Questions

1. Choose the correct option.
A The chart wsed to plot data for 3 single data series.
i, Column chan it, Pie chart i,  Scatter chart iv. Bar chan
b, It prowides additional information about a data point on a chart.
. Legend it.  Data label fil, Data table iv. Gridlines
¢, The following CHART TOOLS tabs appear on the ribbon:
i DESIGN ii.  FORMAT i, LAYOUT e hetht and i
d. Tomoe a chart to a new worksheet, click the Move Chart option in the prof
i Data ii. Type iit.  Location iv. Chart Stvles
¢, These shortcut buttons appear at the top-right comer of a chan.
i, - Chart Elements i, Chant Stvles i, Chart Filters iv. all of these
OXFORD
Eimaats s - s B8 &
s W = EEEE B & .
am F

e B n

#
E § EF B & m R EE E_
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pescriptive Type Questions
1. Answer the following.

2. Describe all the possible components of a chart.

What is a combo chart? How will you create a combao chart?
What is a sparkline? How is it different from a chari?

How will you delete sparklines?

What do you understand by the Quick Analysis button? Write the steps to create a bar chart using
the Quick Analysis button.

Which type of comparison chart could you use for each of the fallowing? State a reason for your

choice.

i. the number of boys and girls studying in a school over the last five years

ii. the increase in the price of an ice cream at the same shap in the last three years

iii, the average time spent by each student eating, studying, and walching television

g Evaluate the statement: 'Chart formatting options in Excel 2013 are excessive. A few would have
been encugh.’

h, Collect the required information from at least 5 of your classmates to create an Excel sheet to

record their marks in English, Science, Mathematics, and Computer Science. Create at least three

different types of chans to display this data. Make sure you use the chart formatting options in

mopn =

| Tt

Excel 2013,
Application-Based Questions — ;;i; DEIGETIE
a. Muriaza wanis to create a chart for the data given alongside. Buthe o= =005
does not know which chart is suitable for the data. Yeard |97.8

i. What option should he click in the Charts group on the INSERT

tab? Survey of Fast Food Fans
ii. List the steps to create a suitable chart,

a
a
b. Consider the column chart on the right of a survey of IE
fast food fans in different age groups. a
. Mame the age group having the maximum number ;'
of fast food fans. ] LI EL S L
ii. Mame the age groups where the number of h"’-‘ﬂ": #"':": :-ﬁ 0“:’#‘: #’i
respondents is less than 60,
¢. Mohid has drawn a column chart for the data on the right. Class Boys Girls
But, later on he decided that a line chart would be better vi 32 18
than a column chan. vii 41 3
i. What should he do te change the chart type! Vil 7 23
ii. Howw can he move the chart 1o a newy workshest? IX 35 15
X 29 21
- a7 E EE =m b EE‘.":EE‘E
E."'t-f; F @ B EUEEE m @

il SEE mEEE BDEG @@
S — - - - - —-—
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d. Rehan does not have e b e Lo create a chart for a

Marks No. of Studeng,

Prisentabion 91-100 g
o What i the shostout method of creating a chart? 51-90 '1'_1 —_—
i Wnite the steps to draw a pie chatt using the method e lﬁ —_—
suggested in step 1. ~ —_—

bR P b1-70 5

(-59 2
|

i"L IN THE LAB

1. Fatima’s father owns a garment factory. He wanis her 1o draw a pie chart for the data given below;

Region Sales (in Lacs) Region Sales {in Lacs)
Marth 20 South a0
East 15 Wesl 18

The pie chan should show the percentage of sales in the four regions. Use Quick Layout and Char
Styles on the DESIGN 1ab to format the pie chart. Wrile the steps 1o do this task.

2. Saad's father runs a computer coaching centre. F p— No. of Students
He wants Saad to draw a column chart but he Full Time | Parl Time
drew a bar chant for the data given an the right, Multimedia % 5
Using the Change Chart Type feature, conven v
the bar chart into a column chan: L = 3 2 '1:
Write the steps to do the above task, NE":‘IMIME 13 =

_ Business Compuling 10 2

3. The science teacher has asked the students of Computer Science 25 5

class VIl 1o create a combo chant for the data

given below,

' Manth Temperature (in Fahrenheil) | Precipitation (in Inches)
Jan 15 18
Feh 27 12
| Ma 45 12
| Apr L 29
May 4 2]
lun 72 b
Jul 9 10
Aug B3 15
| Sepp 7 12
Oa % B
Nov EE 5
D 13 10
3 PO
e R A
[} &l -=----.-====.--.-':ﬂ - — - - o - -— = —' .
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a Help them create the chart in 2 new sheet named Combo chart
h. f.1,|,||_i i Ih“' 1.I“|'|I'| li'\.i:‘l l||.l'""h. .'“'“I al ll"F..,"{."I'ltj I‘I thl’ Eh.]ﬂ.

¢, Apply Text Fill and Shape Fill features 1o the chart.

1. Thie Computer Science

wacher has asked Sales in Lacs

\iaham to create column b Quarter | | Quarter Il | Quarter NI | Quarter IV
; " Safdar 13 18 5 20
sparklines for the data E
given in the worksheet on Anoosha | 15 20 19

the right, Naufil 22 25 29 3
Help her 1o create the Deena 21 17 24 &2
chart and alsa change Wagar 28 25 21 18

the colour o one of her Naael 30 32 25 28
choice. Darwish 27 30 32 29

GROUP PROJECT

Scattering pies and doughnuts! How are scatter charts, pie charts, and doughnut charts used?

Carry out same research and see what amusing uses you can find. {You can, of course, create
'!.'IEIIJL: own!) Gather together your findings and present llham "f’ the rest of your .Elzﬁﬁ. Select

the best way to present your resea rch to have the maximum impact (PowerPoint?). You want

everyone to remember the important differences. (Try presenting your dnl._1 i_n the wrong chart
and who knows what it will look like! But you will make the point that it is important 1o select

the correct graph style to go with the data being displayed).

4% TEACHER'S NOTES
* [Dhscuss how pq[lﬂr:i.al mpd'mi'nurim of
* Explain the difierent types of charts and
for what type of data.
* Demonstrate how o diaw 2 gra
* Give students time to practice charts

data is helpiul and why charts are important,
help the students get a good idea of what chant type is suitable

ph and show ils various components.
and explore various chan aptions on their own,

a9 OXFORD
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Computer Viruses

| g = -
-rr Toggie halp mie! N oy .
[ Something has happened i + Hmm! Looks ke \
¢ & COMpuler virus.
- [ Ime r__.-'

e

HWihar ket af
vres o rhae?

A computer virus is a software program that has the ability to

make copies of itself, and to attach itself to other programs or e el

In this Chapter .

files.
A virus may or may not be destructive. In some cases, B
; s What Does a Compricer
viruses can erase data or corrupt programs on the computer. Vil
Viruses are written by expert computer programmers and T e o Comntrer Vil el

are intended to run on computer systems without the user’s « Malware
knowledge. « Preventing Virus Infections

Antvirus Solpware

In the same way that biological viruses enter our body and
attack certain cells, computer viruses enter a computer system and attach themselves to an jtem
like the startup area (boot record) or an executable file (a file with a .exe extension).

Most viruses stay active in the memory until you tumn off the computer. When you do so, the
virus is removed from the computer’s memaory, but not from the file{s) or the disk it has infected
S0, the next time you use your computer the virus program is activated Jgajn_ It may then attach
itself to more programs andfor files.

OXFORD 40 "
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WHAT DOES A COMPUTER UIRUS D02

A virus tries to take control of the computer system it has
infected. It makes copies of itseli and tries 1o carry out the often
harmiul tasks that it is programmed 1o do. This pr.r:ut-'-s. can
happen so quickly that the user is not even aware that a virus

is present in the computer. Some viruses are programmed 1o
activate themselves at a certain dateftime, Such viruses check the
system clock continuously, and create havoc when the set time
or date arrives.

Viruses can also infect new files created on the infected computer, or the contents of U5Bs (or
any removable storage media) that are inserted into such a computer. They attach copies of
themselves to these new files and/or files on the storage media,

Wwhat a Virus Can Do

Different viruses do different things. A computer virus could he capable of any of the following:

» It can infect executable program files such as word processors, spreadsheets, and operating
systems.

» It can infect disks by attaching itself to special programs on the hard disk, called boot records.

These are the programs that the computer uses to start itself up.
e It can infect files that are attached to email messages or copied to disks and USBs, In this
manner, it can spread from one computer ta another.

What a Virus Cannot Do

There are certain things no program can do. A computer virus is a 0id you Know?
program; hence, it cannot do the following:

Commwarrior-A

* [t canno!l infect files on 'I.'I'TitE“-]:lmi'E“'L_.tEd discs, such as CD-ROMs. was the firse known cell
; i il hone virus. [t appeared
. fect computer hardware such as monitors a p
It cannot infe p : e mpa

keyboards. It infects only software.

Waming Signals

When you experience strange behaviour such as screen dis#gﬂ.iun,
or characters not appearing on the screen when typed, then it is
possible that a virus has affected the programs that contral the
display or the keyboard. If you are unable to open files, F'.Ir{lll‘.lc'lhi'y

a virus is responsible. The computer’s hard disk is not physically
damaged, but the data and programs stared on it may be corrupted
or damaped.

41 OXFORD
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Flore are some of thie most common signs of o vinis it k:
o The computer runs slower than nomal,

o Applications take longer o load or el et work properly,
» Unusual error messages appear on this sereen,

& Yo police |'111|1“4"1 in Dl stz

o You natice that the hard disk has maore files than it hael carlier,

e The computer affen frecees or Stops rixsponding,.
* The compuler restars on ils fwi.

o You see distorted menus and dinlog boxes,

How Does a Computer Virus Spread?

[ 1bed g Wnow? '.Ei

A Lass U stieleng, Pae bl
Shrema, wiote thie cofmptes
wiroes Fle Clomer in 19811
attae hed isell v Aqppele 1
enmmputirs and spread via gy
cligke, Fwery Wbt that i
cormpiter Faratesel, Bhoe wirnns
made the computer display a
sl [T thai Iu-p_.m sl e
wiorch Tk Clesner: The pragran
with a personality,

Computer viruses spread from one computer to another by the transfer al infected data theoug

emails, USBs, or other sources.

Viruses become active when you start an infected application or starl your computier [rom v
that has infected system files, Once the virus is in the computer’s memory, it usually infects an

application you run,

Different viruses behave in different ways, Some stay active in the memory until the computer
shut down. Others stay active only as long as the infected application is running,

TVYPES OF COMPUTER VIRUSES

Computer viruses can be categorised in different ways. One of them is by their infection targe!

If we group viruses by their target, we can divide viruses into
the following calegories:

Pragram Viruses

Program viruses infect propram (iles which have extensions
like .COM, JEXE, SYS, DLL, .OVL, and SCR. Program files
are attractive largels for computer viruses because they are
widely used and have relatively simple formats 1o which
viruses can attach themselves, The virus becomes active
when the infected file is executed,

Examples of program viruses are Acid Rain, Alien.298,
AmochaA, Crazy. A, Umbrella. 3173, Sunday, and Cascade,

(X FORT
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goot Viruses

viruses infect the boot recn : _ _
poot vl -.I rds of harel dicks and floppy disks.
Generally, D09 ©5 are Considered more dangerous than
program \ Iruses.

paamples of boot viruses are Danish Boot, Devil.041. Fek b, Disk
Killet, ﬁ.i]cheiangeiﬂ. and Stoned virys.

macro Viruses

3 macro is a set of commands written by the user 1o
be executed later. For example, if you execute a <et of

commands often in M3 Excel or MS Word, you can save that
et of commands as a macro.

Amacro virus uses the macro language for its program. These
viruses infect data files. For example, MS Word and MS Excel
files are susceptible to macro virus attacks, as these programs
allow the use of macros, Macro viruses spread rapidly, as

users share infected documents. Examples of such viruses are Melissa, Concept, and Nuclear.

" Did you Know? ﬂ

Melissa Virus was released on 26 March 1999 and was designed to infect macros in
documents used by MS Word 97 and 2000. It propagated by emailing itself to the first fifty
addresses in the address book of M5 Qurlook (the email program that is a part of M5 Office).

MALWARE

Malware is short for malicious software. The word refers to
any program that infiltrates and harms a computer without
the user's consent.

Malware is a general term that includes computer viruses,
worms, Trojan horses, spyware, and spam. Malware can
slow down computers and networks; it can be annoying,
or it can be actively destructive.

Worms
A Eﬂmputtr worm is a F[ngrﬂm [ﬂpah]l: ol mprﬂduting and S-I:II"E&I:“I'IE itself to ﬂﬂﬂlhEr
computer system, uiu-ﬂll}' by means of a compuler network,

Worms spread without any human action, and thus difier from viruses. Viruses spread only
when the user does something, like running an infected program or attaching an infected file.

43 XFO
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A waorm emails copies of itself to other computers, infects them,
and then uses the address book of the infected computer to spread s
further, 4 el o

I Mo -

Computer worms usually do not cause direct damage to programs
and files. However, they consume large amounts of memary and/
or network bandwidth, thus slowing down the computer and
making it almost impossible for the user 1o work. Examples of
computer worms are CodeRed, Sircam, and ILOVEYOLU.

Trojan Horses '

A Trojan horse is a program that appears useful, but is
actually programmed to pass the user's data to someone else, VIRUS ALERT ! I

TROJAN HORSE DETECTED <=4
Trojan horses attempt 1o steal and pass on confidential i
information such as passwords and credit card numbers.
They do not reproduce by infecting other files or by seli-
replicating like viruses and worms.

A Trojan horse enters a compuler system hecause a user
installs it undler the wrong impression that it 1s a usetul and
harmless program. When a Trojan horse is activated, it
typically changes existing deskiop icons or creates new ones,

It may also delete important system files, Its main aim, however, is to steal sensitive informaly
stored on the infecled computer, Some popular Trojan horses are Netbus, SubbSeven, Beast,
Leus.

spyware

Spyware refers to computer programs that secretly gather
information about the user and relay it to advertisers or other
interested parties. They are also called spybots or tracking soitware.

DANGER

Spyware is often installed without the user’s consent when:
SPYWARE DETECTED

* The user downloads something from the Internet.

» The user clicks on something in a popup window that appears
while browsing.

Spyware can consume a lot of memory, making the computer very slow and difficult to work
with. The biggest problem with spyware is that it can steal your information and misuse your
computer.

B
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y Spam
Spam refers lo unsolicited, unwanted email, It may
carry advertisements or serve as a means of spreading
malware like viruses and worms. Some ways of
avoiding spam are:

Do not give your email address to unknown people.

Use the spam filter of your email program to block
unwanted emails.

Delete spam mails without reading them.

PREVENTING VIRUS INFECTIONS

Here are some basic rules to avoid virus infections:

» Restrict access to your system, both offline and online.

Only allow trustworthy users to use the system.

Never use an unknown disk in your system unless it
comes from a trustworthy source and you are sure that it

is virus-free.

Install and use antivirus software and keep it updated.
Keep programs and data on separate disks, if possible.
Scan the files that you download from the Internet.
Never click on a link or attachment in an email, unless
the email is from a trusted source.

Install an anti-spyware program that operates against
malware and spyware and keep it updated. Examples of
such programs are Ad Aware SE and Windows Defender

install a free firewall program to help block unwanted

Internet traffic that can cause problems. Make sure that the

firewall is always on.

If you get a malicious script from a web page and you do not
know what 1o do, or if a window appears asking if you want

1o allow an automatic install, click NO.

ANTIVIRUS SOFTWARE

Antivirus software refers to applications designed to detect and remove viruses from computer
systemns. However, certain types of viruses are difficult to remove and the files damaged by

45

= =

B It

[ Top Tip

Since no security method i
perfect, it is important to back
up your files regularly.

- -

Did you Know?

A firewall is a software
program that helps keep out
hackers, viruses, and worrms that
try to infect your computer over
the Internet,
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them may be lost forever, Whenever the computer system starts up, the
antivirus software starts automatically and keeps a check on every file
that is opened o run and on all Intesoet tealtec, 10t detects a virus,
it will ey 1o remone the vitas, The followang is necessary foran
antivirus program to be eflective:

o 1 should o in the background at all times,

= It showld be kept updated so it recognises new versions
il |'|:'|.|1I|[ LRI ]'"l.‘j:l.ln'l'l!_

o It should have the capability 1o scan email attachments
and files as they are downloaded from the Internet,

* The user should run iull disk scans periodically.
This checks all the files on a computer system,

some popular antivirus programs are;

* McAfee VirusScan * Norton AntiVirus

* Kaspersky AntiVir,

* Quick Heal Total Security * Microsoft Security Essentials

Duick Heal antilirus

Let us study the Quick Heal Total Security system in more detail to understand how an antivin
program helps to secure your system,

To stant Quick Heal Total Security, click Start » All Programs » Quick Heal Total
Security » Quick Heal Total Securily.

Or

Double-click the Quick Heal Antivirus icon in

Sysiem i secune
————

the Windows system tray, S

Cr
Right-click the Quick Heal Antivirus icon in ...&:_.)_ \:_-:‘) U \fd
the Windows system tray and select Open ) , - . T
Quick Heal Total Security. s Smmm— em—n T
Quick Heal main Window = i 7, U

P e

The Quick Heal Total Security main window
appears g, 310,

Fig. 3.1 Main wincow of Quick Heal Total Secun®

(AW R ] ":.IE [ 1
wirTe E E Em = [ -
B & mEEEE ® & | “nt
Bl EEE EEEE EE® ¥ am 1§
- = = Es & EEssss B BN B N [ B 1 B N m = -iJ
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The main window has thiee sections:

« The lop sechion has the follow gL e oplions:

Sottings Foalsles vou o costomse amd o onfigure setlings. You can decide seitings for autermalic
|,LP|.[.'I11.'. Tl sy <t S0, ol
Tools I buddes various tools, such as clean ups el restone tonls aned a track eleaner. Thise |
Wols prevent vinus inlection and help disgnose problems .
Reports | Allows you o view the activity reports of the Scanner, Virus Protection, elc,
Help Prowides imtormation on how 1o use Quick Heal Antivirus and provides details about
_the version, virus database, elc. - '

« The middle wl:linl'l- deals with protection options. Some of the options are:

[_i]l.*.‘- and |"1'I'|I[!_L‘r-_- |'||.-||h vou configure ‘“-‘“llTL‘ that profect r||:"'~ .1I'I-Ii Fn|tfi.'n against l]lrl'.JIl. .

Emails Allowws vou o configure l-.L'II|r1||..,':- related 1o threats that arrive by "'“'“l trusted
| ) | email clients, and protection from spam. ==

Internet & Enables vou to contigure seltings for |1ru1u: I|n|., the s stem when Y are

B -.u_:rl., anling. o - = A

External Drives & | Allows you to configure seltings related 1o threats from CDs, USE, external

Devices disks, elc. _ - o )

* The bottom section has the following options:

o Prow |{]|;_H.. WO W |'||'| [hE I.‘lll_"_-i.‘l I'II'_“"I."n.S |ﬂ'|l"|1 {J'IJI-L_L Hl.'u'll e =]

Scan ' This provides various scanning options, like Full System Scan, Custom Scan,

Memory Scan, and Boot Time Scan. =_——— - =

System Scanning

To perform a full system scan, click Scan » Full System Scan. The scan process will begin (Fig. 3.2,

The scan statistics and reports are provided upon completion of the scan (Fig. 1,31 Review the

scan report and click Close.

[ -
i A et
S ——
I S—
[ [re——
o ——— .—-_i__
; : i [_:- —l:_ ——— e o — [ 8
—— : :"_ ' ——] :- :—u :
e a e e :
—— e [
i - e . _
L s = o - =
= e [
Fig. 3.2 Full system scam in progress Fig. 3.3 Scan statistics and reports
47
5 “ @oa = " e at
[ ] T i . I EEEER = |
EEE me i EEE BEEEE EEE Bm [
o mE W W [ L. parses = ss m m ="

Scanned with CamScanner



Updating Virus Definitions

By virus definitions we mean the database of viruses that an antivirus software scans for. Thig
I_‘!;IIT.‘IIMBE' needs 1o be updated regularly, because new viruses are being developed and release,
all the time. 1 the virus definition file is not updated, antivirus software will not know ahout
new viruses and will not be able 1o catch them.

Updates for Quick Heal Total Security are posted regularly on its wehsite. These updates cony,
information for the detection and removal of newly discovered viruses. By default, Quick

Heal Total Security is <et to update itself automatically from the Internet without the user's
intervention. The only requirement is that the computer should be connected to the Intemet,

Free Antivirus Software (Tap Tip : ‘u
Nowadavs, free antivirus programs such as AVG and Avast are P

. . . P talli bivi
becoming popular. Microsoft Security Essentials is another Before inscalling any antharus

software, it is preferable to

free security application that many people use. Microsoft uninstall any other antivirus
Security Essentials comes iree with genuine Windows software already running on
operating system. You can use Microsoft Security Essentials your computer. Running more
to protect vour compulter against viruses, spyware, and other than one antivinss program on 2
computer may negatively affect

malicious programs. It is easy to install and use, and it runs

o ; . the performance of the computer.
efficiently in the background. Updates happen automatically. s

wil
wi
Computer Virus  a software program that has the detect and remove viruses from computer
ability to make copies of itself and 10 attach syslems
itself 1o other applications or files Virus Definitions  the database of viruses that &
Anlivirus Software an application designed 1o anlivirus software scans for
Memory Butes "
s  Computer viruses usually intend to harm * Based on their targel, computer viruses are of
a computer system without the user’s three types: program viruses, boot viruses, and
knexwledge. A virus only affects soltware and MACTO ViFuses,
not hardware. * A virus infection can be prevented by followin?
*  Computer viruses spread from one computer a few basic rules, including the use of a good
to ancther when infected files are transfoerned anlivirus program.
through emails, floppy disks, or other * Virus definitions should be updated regularly #
means. that the antivirus software can detect new virt®
X ORI & =
Vs hdm = " &8 @ 8 u
S 8 8§ NEEN B @ ",‘i
_ _ _EN _DEN_REEE EE® w5 = E = E .
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Objective Type Questions
1. Choose the correct option,

a. A computer virus may be capable of
i. Infecting executable files,
ii. Infecting disks by attaching itself to special programs on the hard disk, called boot records.
iii. both i, and ii.
iv. none of the above
b, Which of the following are the signs of a virus attack?
i. The computer runs slower than normal.
ii. There is a change in file size.
iii. The computer restarts on its own.

iv. all of the above
c. A computer virus can spread through

i. Emails ii. LISB ifi, Bothi.andii. iv. noneof these
d. Program viruses infect files that have the extension

i, COM . LEXE i, .5Y5 iv. all of these
e, Which of the following is a boot virus?

i. Michelangelo il Sunday iii, Acid Rain iv. none of these
f. Which of the following are infected by a macro virus!

i. .exefiles ii. Boot records i, Data files iv. none of these
B orreceeessseermnsensesess TEfETS 10 COMpuster pragrams that secretly gather information about the user and

relay it to other interested parties. |

i Worm ii. Spyware il Virus iv. none of these
B sovessssssresessnaenneses FEFETS 10 unsolicited mail.

i, Spam ii. E-mail iii.  Mail iv. none of these

Descriptive Type Questions

1. Answer the following.

Name the type of virus that infects data files.

What is the name given to a database of viruses thal an antivirus software scans for?

Define a computer virus, How can it harm your computer?

Mention any three precautions you should take for protecting your computer from virus
infections.

How does a compuler virus spread from one computer to another?

f.  Analyse how boot, macro, and program viruses affect the workings of your computer. Which in
your opinian is more harmful! Give reasons for your answer,

BN oe

]

; 8 . e w a (OxIORD
- an unE SeEE Bem mo
AT EE. o = s am B 8 S R wv s musess RN .. - m

Scanned with CamScanner



g MeAfee Virus Scan and Micrasolt Security Essentials are two popular Anli-virus programs. | i
out more aboul their features and justify why you would choose one over the ather,

h. On page 45 of Keyhoard Book 7 there is a list of a number of measures you can take 10 preveng
infoctions. Create a fun chart to show how each of these measures helps your compulier systen,

Application-Based Questions

a. Sania noticed a few unwanted mails in her email inbox,
i. What is the term given 1o such mails?
i. How can these mails harm her computer?
Hil. Mention two ways she can avoid such mails.

b. Dawood noticed some strange behaviour when he switched on the computer. He noticed that
unusual error messages were appearing on the screen, and that the computer was running slowes
than normal.

i. What must have happened 1o the computer?
ii. Mention two other signs of that event.
1l Suggest two basic rules which will help Dawood avoid such an event,

c. Imran's computer is infected by a computer virus, His teacher suggested that he should install 2
special type of software to detect the virus and then remove it.
i. What is the name given to that special software?
il Give any two examples of such soltware,
lii. Mention any two points that should be followed 10 keep that special program effective,

d. ldentify the lypes of viruses that infect the following types of files:
i. .EXE

it. An Excel document
iii. Boot records of a hard disk

IN THE LAB

1. Irfan has learnt in school how to scan a computer using an antivirus software, He can now easily
scan his computer at home for viruses. Sean your computer (oo, using an antivirus software. Mentit

the name of the antivirus software you have used, the oplions avai :
. J ons available 3
resulls you got, P Hable in the program, and the

2. Nashrah has been asked by her computer teacher to create a presentation on

iruses’ T i Computer
Viruses'. Help her create a presentation of five slides, ypes of Compute

3. Ghazanfar's father wanis 1o purchase an antivirus software. He has asked Ghazanfar to search for

various antivirus software using the Internet, Help him collect the required information and create
presentation on at least five different antivirus software,

OXFORD
Fr —— i E R = 50
=.I--= EEEE B E ]
" B mAHA A -====--....'f-- = T
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4. The students of Class VI have been asked 1o make a project repon on "Comnpuier Vireses' giving

details of what computer viruses are, how they spread, what should be donie 1o JRreRect computers
from viruses, ctc. Make a similar report in Word 201 3,

GROUP PROJECT

Malware alert! It is always best to know what malwares do and know how 1o prevent them.
Find out as much as you can about three different malwares. (Be careful not to get attacked
in the process!) How do they work and whal damage can they cause? Are there examples of

damage caused? How can they be stopped and prevented? It is imporant 1o make others aware
of your findings. Create your own style of presentation about your findings. It needs to be
memorable - perhaps some role play would help?

¥ TEACHER'S NOTES
& The im‘“ﬂ_n[ll |‘ ur.in.ﬂ ﬂﬂ'i\l"il‘l.l!. SHEMJH." anid 1he Erﬁ]‘.lﬂrt-ll'lnl.'[" al Ul"!ﬂti‘l'lﬂ 'I.I'il'l,l.!. :.I'i."ﬁﬂi‘”l]l!ﬁ Euulli b
explained. .
o swosuled b wseslul to gliscuss in class the different methods t'r'l.'l.llltl':f't'd |_1'|,' Iii'pl}l;_'l' criminals and |'|.|:|-'|.'|,-' o
successiully avoid Lecoming a victin.

o A demonstration of how 1o scan a computer using an antivines software and how to update virs
definitions could also be useful.

5l ;
i B m . OXFORD
5B -
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Loops and Graphics in
Small Basic

Jr-" Toggle we will be

learnmg loop staremencs in
i Semall Basic comorrow:. Can
) vou rell me something about

-~ Uimim,., Not very
clearly... Canwego J

Y -|::-|.-'E|".|[ e m,‘:'-?/

-

Do you remember
. foops in KTurde?

Sure, Goggler A lpop
staternent executes a rask g
md.agmn oll a cerrain condison

met. Tell you what! Ler me gve pou!

short introduction to loops |.‘IJ

Small Basic

In class 6, you have already learnt about some statements
in Small Basic. This chapter will discuss looping statements _—— )
and the graphics features available in Small Basic, In this Chapter
In computer programming, a loop is used to repeat a block
of statements a number of times, popreCicior

= While, . EndWhile
There are two looping statements available in Small Basic: £ GraphicsWindow

* For.EndFor

® While Endihile

For...EndFfor

The For. EndFor stalement Fl‘l’.‘l'l.u'idf_'s an easy way to create a |mp It is used
statements a specified number of times. This looping statement is prefe
repelition is known.,

to repeat a block @
rred when the number &

OXFORD G
LEERRIT P B (5] [-]-] -] 5 E =|
@ B B EEEE 8 =& -
EE NOE EEEE BE® &- .::__*
= w g B __NENEES B = § B L T - m ow
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Consider the following program o prin| .
the numbers 1 to 5:
For A =

TextWindow. WriteLine (A)

EndFor

ewplanation

1 To 5 | E

. -
8 1 CAUser\SONW\DesktophSmall base pr... [ = | =1 [[555]

y Lo Conek {PuE. ..

1. Initially the variable A is assigned the
start value 1.

Pl

Fig. 4.1 Ouiput of For..EndFor loop

The computer checks whether the value of variable A is less than or equal 1o the end value

5. If true, it executes the statements between For and EndFoz. Then the value of variable A
is incremented (i.e. increased) by 1. The computer again checks the value of variable A,

3. li false, it gets out of the For. EndFor looping stalement.

The output will appear as shown in Figure 4.1

The step-by-step execution of the program can be explained as given below,

True or False

[-ﬁ Condition

r— |

What happens?

The statement between For.. EndFor is execuled.
The value of A (1) is printed on the screen.
The value of A is increased by 1, becomes 2.

The statement belween For. EndFor is executed.
The value of A (2) is printed on the screen.
The value of A is increased by 1, becomes 3.

The statement belween For, EndFor is execuled,
Thiz value of A (3} is printed on the screen,
The value of A is increased by 1, becomes 4.

| The statement between For. EndFor is executed,
| The value of A (4} is printed an the screen.
| The value of A is increased by 1, becomes 5.

The statement between For..EndFor is execuled,
| The value of A {5) is printed on the screen,
| The value of A is increased by 1, becomes 6.

1 1<=5 .
|
?._ .'!{=5- e
‘-I- 3:=;
: d<=5 ”
el 5o
iEr: <=5

| The For.. EndFor |l]l']-|'l endds

ad

mE (] B
OEEE o ]
OEEE BEE @@
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Step

If you want the variable value 1o be incremented h':.' some number other than 1 (may be posi;,
or negative), you can use the Step command in the For stalement.

Consider the following code;

- R -
Py T -] '-.':-" 3

rextWindow Writeline {Aa)

105 oL
Here, the value of A is incremented by 3
after every loop. The output is shown in
Figure 4.2, If you do not use Step, the
value of A is incremented by the default
value of 1.

The step value can also be a negative number.
this case the start value is greater than or equal
the end value. Consider the following code:

For A = 20 To 3

Step

Texthindow . Writel

o
L]

ine [(A)

[

:I'-_!Jl-l.'r

The output will appear as seen in Figure 4.3,

You can also use a decimal number as the step
value. Consider the following code;

For A 1 To 5 Step 0.3
Lis (™ B

TextWindow. WritelLine (A)

EndFor
The output will appear as shown in Figure 4.4,

EXAMPLE Y

r=
| CAUsers\SONY\Desktop\Small basic —.

S5 ANy key to

el

combInue . -«

m | ¥

In
(]

Write a Small Basic program to print the sum of the
first N natural numbers. The value of N is entered

by the user,

SOLUTION

i b L= » [
rextWindow. Write ("Enter the numbor *)

Hudnbe TextWindow, ReadNumber ()

-] f
For 1 1 Te Humber
TextWindow WritelLine ([I)
S=84+ 1
LI FOYRLY
FatayaT] I 1 1] B
c B = B EEEE = 5]
EEl DR EFEE EODE =B
m Em ma ] LR T = -

Fig. 4.2 Output of For. EndFor with Step

T CAUsers\SONV\DesktopSn... [ = | & [

i i I-.-: U E0 CORCINnUE. ..

Fig. 4.3 Output of Far. EndFar with
negative Step

FIE mm [olfE ==

any RKéyg b

Fip. 4.4 Output of For.. EndFor with 2
decimal number in Step
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EndEor

rextWindow.WriteLine (™ ")

textiindow. WriteLine ("Sum of first "4
wumber +" Natural numbers = * + §)

The output will appear as given in Figure 4.5,

while...endWhile

The While EndWhile loop is used when the loop
count is not known belorehand. The condition
after Whi le evaluates to either true or false.

wilm o
Frens

i D\Revised Keyboardylock TSmall b.lilﬂl!g

Fnter the nunbeFE T

bk * |

r Fiv=st 18 natoesl minbea rs
rOnE IRAE - =

any ey Eo

Hl-'-' 4.5 Outpul of F":.lr'l'li]ll." I

The stalements between While_ Endwhile loop are repeatedly executed until the condition

becomes false.

Consider the following code to print the numbers 1 1o 15 incremented by 4.

Humber = 1

While HNumber <= 15
TextWindow.Writeline

Humber + 4

(Kumber)
Humber =
Endihile

The output will appear as seen in Figure 4.6,

Let us understand the step-by-step execution of this
program,

T CAUsers\SONYADesktop\Small b.. E

Fig. 4.6 Hurpul of While. EndWhile loop

| Condition True or False

1| 1<=15 | T

2| 2a<=1) T

.....

| | '|'|1.E alue of Mumber is mi_rmsnd I1n-r 4, becomes 13,

The statement between "I-"-'I‘Irlnu aEﬂd'i'H'hlit is executed,

The statement belween While...EndWhile is executed.
| The value of Number (1) printed an screen.
[ The -..-.!]UE :|I Mumbeer is ||1|.m I':.-L'lil by 4, |I]-1_'|:_1]r‘l'|1_'!;|. 3.

The statement between 1|r"|."I'||It.-...IE:'llnl'ln'q-'hllr.- is ewcmcfl
The value of Number (5) printed on screen.
mg .1ru-: uE Number is increased I;.-,- 4, becumf_s 9.

The Emu.m._ nt between %lln...fndh‘h:ln is executed.
| The value of Number (9) printed on screen.

The value of Number (13) printed on screen.
I Tiw 1...3|1.]t' ur Numhvr = increased by 4, lmc-r_:mq_:s 17.

2 {17 <=15 | F © e

55

| ] B 0
.'.l BE

E Em m = A § EE_= B

| The statement Whlle JEndwhile Lud-,

OXFORD
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A
{

ENAMPLE 1

.m”m. WIS T WL o program to print the stpuare and cubes of mamilbiers 5 o4, Can Vi
fer with the program code! 1] hlrl

SOLLYT PN

RLalniatwleriteline ("Number " b “Sauars ™ 4 “Cube®)
: E ; =
: “ 3o .
pip B e A de o (W Sguare Cubo
e i LS 1] i L1 t Ll 2.1 IIE
sextuindow.ledite 1™ ™ +0E) 16 21
: WRSARE- | - i 7 19 343
TextWindow.NriteLine(™ %+ o) : 64 512

, ) Bi 729
- 1 | Frocs any koy to continue. .,

The output is shown in Fiawe 4.7 '

- '

Fg. 4.7 Chutpaut of Fuaanple |

EXAMPLE 2

Azam wants 1o write a program o print the reverse of 3 number entered by the user. Whay
would be the code for this program?

SOLUTION

M g M T g s 11 LR | T, - I —— i 3t
2R iIQ3w.GLItel " eEnter the numbher ]
oy o, e ¥ o L B_pp [N, . L. | IO i
- . e R Le LIODW s 2 gl iimbelr | )
T s (= P (59 - BT ey N
ST LA O L] D UM T
Bariumbar =
1 S =
srflll i [WlifipeI = 1,
e b A T LI A M
AT . RER& 1IN0 [N Dar. |
LI e ] B H i i T
PUE T L sis N e L i L
e 1=+ oy g
= ath.Floor (Eumber/10)
g

et BN ey Has f =T I L, 5
AL WLnoon . W LtelLing| el

L] Pl 5 T ¥ AL I " - " = = K
CWimQoW. writalions (TOriginal Numbar = ™ + QriginalNumbies)

ks [ e ik

Window.Writeline {("Reverze Humbar = + RevNumber)

The output will appear as shown in Figure 4.8,

= !l
v DiARevised KeyboardiBook ... | B il

Till now, we have worked with the TextWindow Enter the nunber 6749

object, which is used for input and output of Original Nunber = 674
texl-based information. Let us now take up the R ey ey bo St Seet

cantimue. ..

GraphicsWindow object.

Fig, 4.0 Outpunt of Example 2

OXFORD o6

u
EEEE DEm gt
" ;
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P

[II“EE win fow

(e snadow olect s use :
i Gl i ‘I : o draw lines, shapes, and text in many colours, The
ondins 11-.-1N v ihe graphics window are shown in Fipune 4.9,

il EHH%M ' B e
i
¥ Hetght
y ™
ey
WWhdth |I
— e ee— —

Fig. 4.9 The Graphics Window in SmallBasic

The window is Width pixel wide and Height pixels high. The two values of the coordinates
identify the pixel in the window. At the top left corner, the x and y coordinates are (0,0). The
« co-ardinate increases from left to right. The y co-ordinate increases from top to bottom. The
properties of the graphics window with their default values are given below.

= T p————

GraphicsWindow Properties with Examples. Explanation Default Value
iraghiceiindow.Width = 400 | It sets the width of the graphics b4 '
X B window to 400 pixels. |
SraphlcsWindow,Height = 600 It sets the height of the graphics T 444 |
- - i mndw o 600 pixels. ,
E:_t;:?-;:i‘a‘!'jnli-:lw.':"itle = " Example | |tsets the title of the graphics wmduw _;ﬁmnll B'IS-.H: i
it O B | to Example Program (Graphics Window
rrr':ﬂ”d”" BackgroundColor = | It sets the background colour of the | White
e - gr:uphu:s wm:_jm:.- 10 yellow - S '
shicziindow,PenColor = “Hed® It sets the colour of the pen usedtodraw,  Black |
— ) shapes on the graphics window o mrfl '
“taphicsWindow, Penii dth = 3 | It mthﬂ WIdlh of the pen l|5wj I [lr,l]'ﬁ'-l 2 "
—— i shapes on the graphics window to3. |
Staphicakingon, BrushColor = “Pink" | |t sels the colour of the brush which SlateBlue
| is used to fill shapes drawn on the .I
o graphics window topink. |
N 57 w uE_ B -1 o
" oy B om R EEES BaaTem_ _ L L
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You can also type text in the graphics window. The font used to type text in the graphics

window is specified by four differen

t properties as mentioned below.,

. GraphicsWindow Pr

GraphicsHindow.

nples  Explanation

CraphicsWindow,

| -

Graghicslindow.

_____

ieslindow,

FontHame = "Arial™ | |t sets the font to Arial. Tahoma
FontSize = 22 It sets the font size to 22. 12 |
" an _‘-I
FontBold = "true It has two values—true and false. The true |
true value formats the font in bold.
Fontitaliec = "true” | |t has two values—true and false. The false
true value formats the font in italics.

Graphics Window methods

The methods (or commands) allowed in the graphics window are the following:

Explanation

It draws a line from one point (x1, y1) to another (x2, y2)
using the current pen.

It draws a rectangle (width w, height h) on the screen at {x
¥} using the current pen.

- | - _I
Arewizizngle {xl, yl, »2, ¥3, | Itdraws a triangle using three points and the current pen
P -
DrewEllipse (%, ¥, W, h) It draws an ellipse (width w height h) at (x. ¥ ;lhe SUJ_
using the current pen,
Ei_i_;-{_":;aﬂ.g]-E [%: Y Wy hj It fi“i the I'EEIEHEIE (width W, I'|E|Eh| I"I] an ‘thf_l o 1IIIJII_.
using the current brush, o
FiliTriangle (xl, yl. »Z, ¥2, | Itfills the triangle connecting the three points on “'I_'EE-EFEE:"I_F
¥3, v1) using the current brush.
T FillEllipse (x, ys 4 1) Iffills an ellipse (width w, height ) on the scraen at b v) v
! using the current brush, o
DrawText (%, ¥s text) I draws a line of text on the screen at the specified location
i, y) using brush and font properties,
, B ;

EXAMPLE

Write 2 prﬂﬂl’ﬂm 1o pr'll'l't “Fun with Gfﬂphiﬁ Wil'ld'ﬂ“'"-]n "EIﬂCkﬂddEl’ ] [ f[ml_" sire 40, hﬂ-lr-l
and italic, and blue colour on the output screen, The width and height of the window should be
440 pixels and 150 pixels, respectively, with pink as the background coloyr,

OXFORD B 28
e Y PR -] = .==' | B
m o 3
B8 _EEEE EEO OO a ¥
- -=.I- --“l‘. m £ H N a8 N 8 L B m l". m a
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Bl

5GLUTIDH
E[-ﬂphicsﬁ'ﬁnduw Midth = 140

craphicsWindow. Height 150

Gr..‘-l]l‘hjncEWlndD"""Hﬂuk"”“"-”'“-h'iﬂm ':_H.E*_Iw;h [ 5 i |

“I.Ii.H}:"
graphicsWindow.FontSize = 4 |
graphicsWindow.FontBold = "t rue = —

sraphiceMindow. FontItal o - W pagi Fig. 410 Output of Example 1
raphicsWindow.Brushcolor - "Blua”

G
GraphicsWindow.DrawText (20, 40
r

graphicsWindow.FontName - wy, iekacd
1 a Py Ft

£y Fern with Graphics W indow

| "Fun with Graphics Window”)
The output will appear as shown in Figure 4.10

EXAMPLE 2

Wrile a program to draw lines in

and height of the window should
vellow as the background colour,

red m!nur of differing width in the output window. The width
be 400 pixels and 420 pixels, respectively, with greenish

SOLUTION
GraphicsWindow.Title = “Lines of
Different Width"
GraphicsWindow.Width = 400
GraphicsWindow.Height = 420
GraphicsWindow.BackgroundColor =
“GresnYellow"”
GraphicsWindow.PenColor = "“Red"
¥l = 20
vi = 20
Fer I =1 To 10 Step 0.5
GraphicsWindow,PenWidth = 1
GraphicsWindow.DrawLine (30, yl,
aBl, yz)
¥l = vl 4+ 20
y2 = y2 4+ 20 "
EndFor Fig. 4.11 Output of Example 2

The output will appear as given in Figure 4.11.

EXAMPLE 3 .
Create a program that draws a circle with a red border and Lime as the fill colour, The

background colour of the window is Coral. The text “Circle® should be printed below the figure.

O FORD
EB p ’u - u WERITPEMTT M
o HE EEEE 0@ B B
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SOLUTION
Graphicawi Pirlesis 4 { ] s "Cirole”
ﬁh‘-phil:::.Hi||rlr_w.r.1.-l||ll.h - 400

GraphicaWindow., e | ght = 2060

l'irrlphir;:JHlurluw.l_'-rn;:hgmursdl.'.'ulﬂr -
""L'Ll-r-ri I

r:mphir:rJWE:::lr.uw.[*r-_.r:'nIidL'h =
GraphicaWindow. PenCelor = “Red*”
GraphieswWindow DrawgElli

; ; ipse (100, 20
200, 200) d ' ,
GraphicsWindow, BrushCelor = “Lime”

Gmphin::windnw.FillElllpsE (100, 20,
200, 200)

GraphicsWindow. FontSize = 3§
Graphicsﬂindnmmntﬂuld = "trua”
GraphicsWindow.FontItalic = “true”

Fig. 4.12 Output of Example 3

Graphicsﬂindnw.nraﬂaxt[14!], 240, “Circle”)

The output will appear as shown in Figure 4.12,

Note: The Ellipse command is used to draw a circle; thus, in this case, the width and height wil

be equal.

PRACTICE TIME

W
)

The Computer Science teacher wants the students of Class VIl to write a program in Small Basic
that will draw a blue-coloured triangle with a yellow border, The background colaur of the window
should be green. Also the text "Triangle” should be printed below the figure, Can yoy help them

with the code?

SOLUTION

Let us give the title “Triangle” to the graphics window and take the width and height of the window
25 400 pixeds and 300 pixels, respectively. The code would be written as follgws,

GraphicoWindow.Title = "Triangle®
GraphicsWindow,Width = 400
' GraphicsWindow.Height = 300

\  GraphicsWindow.Ba ckgroundColor = "Green”

GraphicsWindow.PenW idth =3

DX FORD | b

eI I LR L] [} = .==. 7] [ =} E
B B au I
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GraphiocsWindow, Pancel o,

i
Yol Low™

GraphicsHindow. DrawTg fangle

Gfﬂphifﬁ“]ﬂﬂ?u.B1u5hfgjal s T
L. FANTL
ElEFhiCFW:HﬂPW.FL;iT:iungLE (250
g
30, 50, 200, 350,

250)
Graphicshindow.FontSize = 3¢

GraphicsWindow. FontBald = "Lroa®

GraphicsWindow.FontItalic = o —

sraphicsliindow. DrawText (100, 240,

L T 1 it
Lflangle i]

The ourput is shown in the figure given

ongside,

1250, 50

Loop repeat a block of statements a certain

fi]

number of limes

GraphicsWindow  an object used to draw lines
and shapes, as also text in Small Basic

These are two looping statements in Small
Basic —For_prdrer and While Endihile.

The For_EndFor loop is used lo repeat 3
bluck of statements a specific number ol imes.

The while, Endihi1e loop is executed as
lU”L‘- as the condition is true. I the condition is

lalse, the loap is termin ated.

The default value of step in For_EndFor 1S 1.I
l'Ill[hlJ Can F’i.I'IE a F|U5i1i'l-"'|-".. i I'll'_"!_:_..ttl\"l'r or tlecina
¥alue 1o the svep command,

Tht "F-I"C'ﬂFlhi ceWindow ﬂ"i"Ll 15 1|_LI'_H| 1L} dlraw

Iinﬂs :Jl'ld S'hrjliﬂ'ﬁ; ﬂﬂd ﬂim r'“'j:]ﬂ [l i|1 51"1.“
Basic,

* The properties of GraphicsWindow are
Width, Height, Title, BackgroundColar
PenColour, PenWidth and BrushColor,

The fon properties of GraphicsWindow

ire: FontHame, Font3ize, FontBold and
Fontltalic,

The methods that can be used with
Graphicsiindow are brawline,
DrawRectangle, DrawTriangle,
DrawEllipse, FillRectangle,
FillTriangle FillEllipse, and
DrawText.

LXTFORD
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Objective Type Questions

L. Chaose the correct oplion,

A The loop used when the number of repetition is not known beforehand is
l. While.EndWhile @, For. EndFor i, Bothi.andii. v, none of thes,

B What would be the autput for the following program{
For I 20 To 1 Step -7
TextWindow. Write (1)

EncdFor
i 20136 i, 714 i, 201471 iv. Error
€. The command 1o get 3 pen of widlh § pixels is
L GraphicsWindow. BrushWidth = § i, GraphlicsWindow,.Brush = 5
iii. GraphicsWindow, Width = & iv. GraphicsWindow.PenWidth = g

d. The command 1o pet the colour used 1o fill a figure is
i. GraphicsWindow. PenColor = “Yellow”
i, GraphicsWindow.BrushColor = “Yellow”
iii. GraphicsWindow.Color = “Yallow”
I Gl‘dphicswindﬂw.Ea:kgruundﬂulur = “Yallow"
e. The method to draw a square is

b DrawTriangle( ) ii. DrawReclangle(} iii. DrawEllipse() iv. DrawLine(}

Descriptive Type Questions

1. Answer the following,

a. What are the four properties of font in Graphicawindow?

b. Explain the Whi le..EndWhile loop with an example.
c. What is the difference belween PenColor and BrushColor properties of GraphicsWindow!
d

. Write the code to print “Enjoy Small Basic® with the following specifications in
Graphicstindow:

i.  Fonl—Times New Roman i, Sizp—22 iii, Bold and halics

e. Explain the four properties of the GraphicsWindow object—Title, teight, Width,
BackgroundColor—in detail,

f. Compare the two loops you have learned about in this chapter. In your opinion which one woull
be more useful in a program which has to execute a number of instructions over and over again!

B. Evaluate the use of looping in programming,

h. Creale a geometrical pattern using as many features as you can in the graphic window in Small Bas&
OXFORD
Gl T . : 4
Y . oo mem sEem mas - L
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i
. Appliﬂﬁ““'ﬂﬁﬂ" Questions

consitler the following code aned answer (he tju

1 estions pivien below.

for 1 = 20 To 5 Step -4
TextWindow.WriteLine (1)

Endior

i What will be the output of the code?

i, Wiite the same code using Whi Lo Endwn Vi

b, Wite the code 1o draw circles of the following dese ription:
o Width—400 pixels
«  Height—490 pixels

v BackgroundColor—Gold
o PenColor—Black
o  PenWidth—5
« DrawEllipse (100,250,200,200)
s BrushColor—Lime
« FillEllipse (100,20,200,200)
c. Aman wants to draw a triangle with a black outline.
The code he has written is;

GraphicsWindow.Title = “Triangle”
GraphicsWindow.Width = 400
GraphicsWindow.Height = 400
GraphicsWindow,BackgroundColor = "Fuchsia®
GraphicsWindow.PenWidth = 5
GraphicsWindow.PenColor = “Black”
GraphicsWindow.DrawTriangle (200, 100, 300, 300,
100,300)

I you have 1o fill the triangle with blue colour, what will be the
additional line or lines of code required?

d. Consider the following description:
* Coordinates of line 1 = (50, 75) - (150, 350)
* Coordinates of line 2 = (125, 75) - { 50, 350)
*  Width of the Pen = 8
* Title of the window—Draw Lines
* Height of the window—400
*  Width of the window—200
* Background colour—OrangeRed
Using the description given above, write the program code for the figure
piven alongside.

OXFORD
. EH - am . B g
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1.

Pt

I THE LAB

The: Computer Science teacher has 2sked the

5 ||-||l|. T4
"J.'r.-.':|||

ertere] by thes gaer The cat put 5 ghrul

THLE 4]

| | I.l ¥ _ et
s B Laes W i .'.r:‘r;.-_-pr-',;'qrn il

| 7y i i B!
FPELTT rint ! % Thi - .
FEIETLY .IF]-IrII _r;r_-1.5;',.!_- R 30 ni T

i [
a5 shevan an ihe right. What will be the code

irar 1his r.l"JIrj i

1§ r'..'.

Her class teacher has acked Laila 1o wri a
program in Small Basic that will czleulate
rhi-'--'rr-nra-u- of attendance in 2 manth,

1
135
e
11
P

r'ﬂ'l‘ Lher masder psce Cable pos et 13

The- input 16 the program is the total nu
15 present. The program should stop v '-1 r'|:"-
[rrisgram?

Formula: Number of days the student is

. The Science teacher of Class VI has

"

present/Total number of davs in a month = 100

assigned the students to write a program
that converts temperature in Fahrenheit tn |
temperature in Celsius for a range entered |
by the user.
Hint: Celsius = (Fahrenheit — 32) * 5/9 !
The output should look as shown
alongside. Create the code for this output.

Write a Small Basic code 1o displav a filled

=

T Bk memmeg— iy =y -2

rectangle with the text *Rectangle” below it
as shown alongside,

W

d. Grephlcshinds
=
Graphnicadindew, Fenilideh = 1
FraphicsWindow.Width =

. - - 1 -
.f.l.l"_-ﬁl'l_.'..‘:_l'n] . He 1?:'. e = il
E

O FORD

T T T

G4

e
a
aEn

1]
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1]
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h, Graphicsiindow.BackaroundColour Ot ange®
G:’.:.Fhl-:;cl.fln-:l:'u.l'.u”-.;.La._t._ - "White®
graphicsiindow. Penllidth 1
Graphicstiindow . Width = 400
GraphicsWindow.Helght = 400
for 1 =1 To 200 Step 5

.3:\1§Th1251|';'il"|d:?'-'-'pE'l.'.:I.'nIElllPEEiEDI} = Ly 2000= T, I " 2y 1T '® 2}

Endfor

GROUP PROJECT

You have been asked to E,i'n.'i." i Cl]!"l'lpl.lll!'r SCience presentation at the nexi Parents I'I'll;"E'ti-ﬂg. Your tﬂf}iC
is 1o demonstrate different types of loops in Small basic, Visual basic, and QBasic. Although you want
to impress everyone with your knowledge, it is also important to engage your audience. Haw will you
go about carrying out this task? Share ideas together and remember to listen to each other's apinions.
Prepare your presentation to highlight the similarities and differences of the loops. Can you use
cartoons? Can you use animation? Can you use drama? Can you use PowerPoint?

o
== TEACHER'S NOTES
* Thi meaning and use of loops could be explained with real-life examples.

The best way to learn programming is 1o write lots of programs, Thus, students should be given enough
lime 1o practice programming.

Explain the difference between the two types of culput windows—TextWindow and GraphicsWindow—
o the students,

Demanstrate how to draw figures and print text by 1.\|{'mg some examples.,
Efil‘”y’ explain the difference between PenColor and BrushColor,

:u G5
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Introduction to
Visual Basic
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Yoou have leamt uite: a bit of Small Hasic. by now, As you o~
knaw, Small Basic programs are executed one command

In this Chapter

after anotheer G, sequentially), You type in the commands
fesr enetheads) and Yo Siee ths gt of a fRreapram i a _ hieal : s
TexiWindow iWﬂlEiﬂH with lext) or Gml-‘fhif'ﬁWiﬂde < Crap Liser Interface .

) : » Gerting Started with Visual
twtirking with lines and shapes) abject, Basic g L
Vasual Basic (VB is similar 1o Small Basic but has many more = Visual Basic Window

* Developing an Appﬁﬂumi':
* Working with Variables

fesatures,

Visual means that it uses a Graphical User Interface (€ 1)

ey o pieale [lthhllTlh, -'Iﬂ-l'i HEIEFE' TSI |I-|_-.| ”"_. IJ"H”“HH i% h‘ﬂ‘vl'."l'l i 1|.“.,_ HA;__‘H'_ I]'r’F-:rﬂmﬂ'|iﬁ,'.;
language,

In this chapter, you will leam Visual Basic 20173 Fx

prresss, It is @ version of Visual Basic that
Microselt supplics free for siudents and bstinners,
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GRAPHICAL USER INTERFACE

visual Basic has a Graphical User Inierface (GUI, As the name sugpests, GUI software
i windows, icons, buttons, menus, dialog boxes, etc. All these are called controls, All

I . I- III e ] 1 | .
rograms R Te— :1h Visual Basic have Graphical User Interface. So Visual Basic has a GUI
environment for writing programs.

guent-Driven Programining

Visual Basic programming is event-driven programming. An event is an action. For example,
clicking the mouse, double-clicking the mouse, moving the mouse, selecting an item from a list,
etc., are all actions. When the user performs an action on a graphical component, we say an
pvent has occurred.

In event-driven programming, the program responds to events, It does not run step-by-step as
in Small Basic. The user may click on any control at any time, so each control is programmed
independently. We write the code that will be executed in response to difierent actions (events).

GETTING STARTED WITH VISUAL BASIC

Ta start Visual Basic, the steps are:

1. Click Start » All Programs [Fig. 5.1(2)] » Visual Studio 2013 [Fig. 5.1(b)| » V5 Express 2013
for Desktop [Fig. 5.1cll.

T
b Tesmw s il
& Toat P
ol ke ST
o Ty e el eeia 35 ]

i

L B it |
B &} B 910 b

b Frskiari i

Fig. 5.1 Steps to start V5 Express 2013 tor Desktop

Iilﬂ Wisusal Stude

2, The Visual Studio screen appears (Fig. 5.2).

1. Mfter a few seconds, the Start Page - Microsoft Visual Studio
Express 2013 for Windows Desktop window appears (Fig. 5.31.

Fig. 5.2 Visual Studio screen
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Discover what's new In
Exprass 2013 for
Windows Desktop

Youw o find informasten about new
features a5 enkascernents in Express

2013 o Windoen Desitop by reviswing
ik Eollowing sedaand
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roa 1 BT brpmpwegib dd ]

R LI e

Whal s new in Windows Deskiing

Fig. 5.3 Start Page - Microsoit Visual Studio Express 2013 for Windows Desklop

4. Under Start. click New Project.... This will open the New Project screen. Under Installed »

Templates, click Visual Basic Fig. 5.4..

Herm Progeat M
¥ Peresa G lecr Wigual Basle hrlbrl[l.ﬂ']uu m| ;;L ‘EE Laardh Installed Termplintes (CErf+E) ﬁ =
Inctaled

£ D“ Windows Forms dpploaton  Visual Basi Typee Vol Basic
4 Templete: = A pregect Ted entiting s applicstion with a

4 Vsl Bansd J‘H] WPF Application Visual Easic Windows user imerace

e = Select th
Tent 1 Consnle Bpphcition Witnual B L P O,
i Voousl CB - Windows Forms Application
b WeauatCan e
gh. Class Litwiry Vil Bt

fample

¥ Dl Change the defaul; project rurme
Kl Bspi k nd {#mipi
Hame |rHﬂd x I
Lot e ursery) v S i et etudes 200\ Progects o] | Brewe | Click OK
Lol nime Helflo [ Cenate drectony bor eobabian
| E T —
i L_ox ][ comca |
- —
Fig. 5.4 New Project window
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selert Windows Forms Application i e il pratiee, ALt bcttearn o ths wanelens,
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Fig. 5.5 Integrated Development Enviconment (01 window

UISUAL BASIC WIKDDW

Thes Visual Basic 10E window inteprates many different funclions, such as designing, editing,
Lulnpilinyr. and debugping {removing, errors),

W hias the: following areas:

* An empty form

* The: Toolhox 1ab

* The Solution Explorer window

* The Properties window

Click the Toolbox tal, The Common Controls menu of the Toolbox will appear iy 5.0,
69 i
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Fig. 5.6 IDE window with Toolbox

Click the Pin the tab button, the form will move 1o the right =0 that the Toolbox and the form

are visible together (Fig. 5.7).
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components of the Visual Basic Window

The Visual Basic window has many components, as you can

see in Figure 5.5 and Figure 3.6, Top Tip ¥
+ The title bar at th . . If you do not see the

Title Bar: The | g € top of the window displays the Toblbox, Sokation Explorer, or

title of the prﬂ]I-EE _I ig. '1'”“.' By {J'EI..']LIIL VB names Vour projects Properties window, click the

windowsApplicationT, WindowsApplication2, etc, The name View menu, Select the required

shown here is ‘Hello’ as per the Change we had made in option from the submenw.

Point 5 on page b9.

l_ﬂd Hello - Micrasoft Visual Studio Express 2013 for Windows Deskiop m I

Fig. 5.8 Title Bar

Tabs Above the Form: The tab at the top of the form contains the words :
Form1 and [Design]. This means that the application has one form and |Forml.vb [Design] & X
is currently in Design mode (Fig. 5.9), Fig. 5.9 Form tah

Menu Bar and Toolbar: The menu bar consists of many drop-down menus. Clicking on any

option of the menu bar makes it active. The toolbar has buttons that provide shortcuts to some
menu oplions (Fig. 5.10).

ALE EDIT WVIEW PROMCT BULD DEBUG TEAM FORMAT TOOLS TEST WINDOW  HELP
-0 |BLU M| T | b ostat«[Debug -] [amycru MR E=T T L

Fig. 5.10 The Menu bar and Toolbar

Form Window: The Form window is the primary P ————

work area that forms the background of the _ i
application. The user can place objects on the form '
{Fig. 5.11),

Toalbox: The Toolbox contains the controls, Controls |
are GUI components that can be added to the form.
Some commonly used controls are Label, Button,

ComboBox, ListBox, PictureBox, and TextBox ' l.

(Fig. 5.12).

Salution Explorer: The Solution Explorer window

displays a list of all the forms in the current project Fig. 5.11 Form window ,

(Fig. 5.13), TTopTip ——1al
a _'..-'

Properties Window: A form can have many controls e [ loctod the Properises

ON L. Every control is associated with some properties, window will display the Form properties

OXFORD
T o s soEw 8 ® & o
- % mes sEEss smm =8
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(b RE
control or of the form kg . |

e 41 X * i F
Techm ry Alo-s0@@|
Sench Toelbos ae ) P |
- gqavgh Sehdien Exploref (LR
p].!.'ﬁ'nd-nﬂ Foemmi st L} . ,
a Cemman Contreh &1 Solution Hella' (1 pesject] :
n Posle 4 [=] Hello | F
B Butten By Propect |
] Checifa ¥ Appcontiy | |
o Checkedlinfis b Gl Fomlsb |
& Combofe ]
B pPacleefcker | 4
A leke ] .
A eitsbe Fig. 5.13 Solution Explorer window |
0 i=ses
I LV
L MaskedTexBen
B semhalender Faiml Sﬁtlm.ﬁﬂﬂﬂﬂlmﬁ‘“m
Fitdyloe ) i
E NumestUpbown Displays preperies  § S Qu O F | 2 _ !
B Pt categoey woe Backgroundimagelayout  Tile
£ Peopbr Lo wwnhs Seeif, B25p1
& Fadalviten Dizplays propenes & Font Micredoft Sans Senil, B25p
21 RichTotles m alphaberical ForeCiolor Bl controiTed
'E ks ander FormBerdesStyle Sigabile I
by Tocllp Tt
= TreeWiem Thi beat ansociabed with 1he conknol
Fig. 5.12 Toolbox I
Fig. 5.14 Properties window ,
|
Click the appropriate button in the Properties window to display properties alphabetically or by i
calegory.
|
DEVELOPING AN APPLICATION '
In VB, you can use the following steps to develop an application: i
1. Create a form, 2. Place controls on the form.
3. Sel properties for the contrals, 4. Add code 1o the controls to handle the events.
Every control is associated with its individual Properties, Methods, and Events, |
Property: It is a named attribute of a control. For example, text boxes have properties named '
c{lfﬂlﬂ', Fonl, Enﬂhlﬂﬂ' \-"isﬂ;lg! el |
Method: It is an action that can be performed on a control.
OXFORD
A4 @ B0 msea@m & i iy &
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et SUPPOTS vanous events such as click, double-click. mouse over. etc. \When an
[‘H‘E .‘I | g RENLE ¥
o

S particular bit of code is executed. In event-driven programming, you write the
g ek S
"+ be executed when an event occurs.

a
L i

cing Controls on the form

glac ;
vou can add 2 control to a form by using one of these methods.
prst Meth od

. Dauble-click on the contral in the Toolbox. Here the control chosen is a Button. By default,
The conirol 2ppears at the top-leit
comer of the form Fiz. 5.15. To

b sons are named Button1, Button2, etc,
change the position of the control, G Butent

click on it, hold down the leit .
mouse button, and drag it to the
new location iFig. 3.16. Eg

3. To resize the control, drag the Fig, 3.15 Cantrol added B 5:16, Diaggecttenev
resize pointers on its edges or ) e it ocating
COMETs,

» Drag the edges pointer for
changing the size either
harizontzlly or vertically

- -

i

I |
—

» Drag the camer pointers for
changing the size diagonally
Fig. 5.1H4,

Fig. 5.17 Resize horizontally  Fig. 5.18 Resize diagonally

Second method

1. Click on the control in the Toolbox, and with the leit mouse button pressed down, drag and
drop it onto the form.

2. As in the first method, reposition the control by holding down the left mouse button and
dragaing it 10 a new location. To resize the control, drag one of its edges or comers.

Deleting a Control
Too delete: a control on the form, select it by clicking it once and press DEL.

Creating and ewecuting a UB application

Let us now understand how to create and execute a VB application. Suppose we wish to display
the messape “Visual Basic is interesting!” on the form.

: & 73 R EE = G Dﬁiﬂﬁ-li'
T = B EEEE ® B :
T L _.:---..-==!:-..-I-I- m A
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Hle steps 1o ereate, execute, and save a Vi

application that does this ane:

=1

.

OXTORD

~ Click New Project... on the Start page. The New

Project window appears,

_ Under Installed » Templates, click Visual Basic.

Select Windows Forms Application in the middle
pane, At the bottom of this window, change the
detault project name WindowsApplication] 1o
soiiet oher nanme, say Message, and click OK.
Phe IOF window will appear,

Nutice the name of the project, Messape, in the
title har, The project has one form, named Form ]
b dletault. Make sure Form1 s selected.

4. Akl o Button control to the form.

Select the form and make the following changes

in the Properties window:

* To change the title displayed on the form: Click
the box 1o the right of Text in the Properlics
window and type Message iFig. 5,191
Notice that it appears an top of the form.

 To change the background colour of the form:
Click the box 1o the right of BackColor.

A drop-down menu arrow will appear, Click
the armow and select Highlight g, 5,20,

Select the button comtral by clicking it, and make

the following changes in the Properties window:

* Change Text 1o DisplayMessape Fig. 5.210.

* Click the box o the right of Font, and then on
the button with three dots o g, 520,

* The Font window will appear ifig. 5.2 1. Set
Font o Tahoma, Font style to Bold and Size
tin 1.2 Click OK. Notice that the deiault font is
Mictosoll Sans Seril,

Follow these steps to write the code:

o Double-click the button control, The code

Preperiies
Formil Systerm dindews Fomm Faem

L] o, :ﬂ £ | &
RightTalefilayeut Fabig -

] Meussgn

UgeastCiarsor Falue
O Brhavior

AT T Fabe

StV elidais EnablefreventfensChingy

CorkenthlEnuSirg [nond}

DoulbeBufped Fafie

Ensbled Trus ¥
Tewi

Thi text assnciabed with the contral

Fig. 5.19 Text properly of the form

Propectics
Tarmi SystemWindowi FormaForm .
N0 F| A

Arceublefole Dol muslt .
O Appearssse
[ Highltt [-]
Backgroundimage || o '|""'H" |5wm._-|
Sackgroun 4 Dﬁr.lmaﬂllrutt;l;liﬁum |l.'
Cursor B Gy Tt
@ fon =g —,
[l ighlightTest
BackCalous B o Tack
The buckaound coloy] [ InactiveBarder . i
[ brsctreeCaption I|

i v e apion e

Fig. 5.20 BackColor property of the form

Fropertoes -3 X
Battenl Syuemdindow Fasmi Button .
An|DF|E

Pageitay [ tnone) .

Inagelint {noee)

RighiTaleh o

TarEmt— R ol

Teatilegn Wl arak i

TetlmageRelition Creeriay

Uuekinemanic Teue )
Test = ==
Thie best assodisted wilh (e conkiol

—

Fig. 5.21 Text property of the Button

windtow will dppoear il TOMETE I | | .llrp,mh- has a code h-'F‘Il|ﬂ:lh.'. You will add your own

vode 1o this,

4

il
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Imagelndes I:I irone) Efes

Inagehey [:I [=iniE) I ] Bt

i | Lt AnbbYylz
(E)
Thee Tard wied bo daphay test i the correl -
Wealen =
Fig. 5.22 Changing the fon

Fig. 5.23 Fonl dialog box

i
Fomlvb® 4 X
¥ futonl .I; Bk
Highlic Class Tared

1

Private Sub Buttenl Click{sender As Shject, & as fuentirpi) imdles Buttoal. Click

Eind Siils
I € B

Fig, 524 The code window

* Type the code between the lines Private Sub and End Sub as shown in $igue 507,

fn‘ml'u‘h-i'.'l'.'

il (General)

| 188 1D ectarationn)
=Public Class Forel

Privile Suld Buttonl Click{sender As Object, e As Eventiege) Mandles Butteml.Click
MsgBox(~Vizual Basic is interestingl™)
Eined Sagls

Fig. 5.25 Visual Basic code
b. To save the VB application, select FILE» Save Al This first saves the form and then the
project. The file extension for forms is vh. The extension for projects is wbproj.
. To run the application, Click DEBUG » Start Debugging. Or Press F5. Or Click the Starl

bulton |_|" jlort -

10. This will run your first Visual Basic proggam. A torm titled Message with a single button
labiele) DisplayMessage will appear on the screen (g, 5,001,

on the toolbar.

Hick the button and it will display a message box stating Visual Basic is interesting! iy, 507

(]

l'l"ﬁ H.'-HH!I
» ?

EE!

=
:l.l:
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Vigual Basic is interesting!

&)

Fig. 5.26 Oulpul of the program Fig. 5.27 Message Box

11 Click OK to return to the form. Close the project by clicking FILE » Close. Now you can
tart a new project by selecting FILE» New Project.

12. Click FILE » Exil to exit from Visual Basic.

1y

=
PRACTICE TIME I )

Ayesha wants to do something interesting with Visual Basic programming, She wants to view a
website using the WebBrowser control Can you help her with the code?

SOLUTION

1 Click Start » All Programs » Visual Studio 2013 » V5 Express 2013 for Desktop

2. The Visual Studia screen appears. Aftes 2 s =i Es
few secands, the Start Page - Microsoft = —
Visual Studio Express 2013 for -
Windows Desktop window will open.

3. Under Start. click New Project....

4 The New Project screen appears. Under
Installed » Templates, click Visual Basic

5 Select Windows Forms Application in
the centre pane. At the bottom of this
window change the project name to web Fig. 5a
Browser, Click OK The Integrated Development Emaronment window appears.

6 Add the controls—Label, TextBox, Button, and WebBrowser—aon the form by double-
clicking the controls. Drag the controls to the required positions so that the form looks as
shown in Figure 5a

7. Change the Text property of Button to GO,

Charge the Text property of Label1 1o URL

OXFORD 76

FalrRry i 7] -] En B .
= - | mE EREE = 4] .
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9. Select the Label and Button1 cantrols using the CTRL key and change the Font properties

Font Style and Font Size ro Bold and 12, respectively

IEPublLe € lass Fykiebirownpr =

Private Sub Bettgn
I Clck{sender s hjrit, ¢ Ax [ventargs)] Pandles Bubien
| Mekh " Jrit, Ex) ferd Cllek

T _-IIE"I:HH.H:-::,T“'I:] |
Fig.5h |
10 Double - click the button. This will F— " —r— Sl
open the code window, Write the —_— =
code between the Private Sub URL

e =N

ine and the End Sub line a5 shown
above (Fig, 5b).

1. Select FILE » Save All o <ave the
project.

OXFORD

UKIVEREITY FRESE

12 Clck DEBUG » Start Debugging or

press F5 to run the application,

13, The form will appear on the screen.

Type htepe!'www.oup.com and
click the GO button. The Website

called will appear in the WebBrowser control (Fig. 5c).

WORKING WITH VARIABLES

Variables are the areas of computer memory
allocated to hold data. You have already
used variables in Small Basic. Now, let us
see how to work with variables in Visual

Table 5.1 Valid and invalid varable names in VB

| Valid II||I’E|ria|]|.|: I'I_E_I'I'I-E'.i Invalid Variable names

Simple_Interest | Student,Name
Basic, EmployeeName 2nelTerm
: { Mum] | Paper |
Talile 5.1 shows some examples of valid and 1per
4 invalid variable names.

Variahle Hames

A Visual Basic variable name:

» must be less than 255 characters

s should not contain spaces or periods (]

» must not begin with a digit

L s sm @ @  Dxmomo

I i o egEE B E b
I EED EEEE EEE B8
Ime - o EmE W H B0 m [ IEEEER B Aan 2 O o B
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Declaring Variables

One has to declare variables before using them by assigning names and data types. The geney

format of declaring a variable is:
Dim VariableName As DataType
For example:

Dim StuName A= String
Cim Total 25 Integer
iz Percentage 2s Single

There are many data types in Visual Basic but we will only discuss three here:

* String: It holds alphabetic characters, numeric numbers, and special characters with which

calculations cannot be performed.
* Integer: It holds whole numbers.

* Single: It holds whaole or fractional numbers,

You can declare multiple variables in one line, separating each with a comma:

Dim StuName s String, Total &= Integer, Percentage s Single

You can declare more than one variable of the same data type like this:

2irm Numl, Num2, Num3 as Integer

Assigning a Value to a Variable

After declaring a variable using
the oi= statement, one can assign

Table 5.2 Arithmetic operators in VB

a value to that variable using an {UF"““ Operation Examples __J

assignment statement. The general  + | Addition 15431 =46
formal of an assignment statement - Subtraction 78 _34<d4
is: I T —

5 {* ! Multiplication 5%6*2 =60
Yarizble = Constant oOf A i Exponent 5 AY o a5 = |
Expression 14 ' Division _'_] =2 ﬁ_ =

For example: & = 100 or i \ | Integer Division {discards {20v3=6

A=R*C , | the decimal places)
Mod

Arithmetic Operators
The arithmetic operators used in

| =t o sne
| Modulus (returns the remainder | 20 Mod 6=2
from an integer division) '

Visual Basic are shown in Table 5.2,

OXFORD 78
LRYIENT M n . ‘. .
| =B HE EEEER B . :
EE EEE EEEE EEE CO o gl
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creating an APRLCALION with Numeric yariapies

Let us NOW create an application to add twe numbers as an example,

| Add the following controls ta the form:
« Three TextBox controls: two 1o enter the
« Four Label controls, 1o display (he

putpul.
« One Bulton control

3 St the properties of the controls 35 described in Tahle 5.3,

Resize Buttonl as necessary, After setting the properties,
r'lgun_" 5. 2H.

two numbers, and one that will show the output,
heading, and captions for entering two numbers and

the form will look as shown in

Table 5.3 Properties for the farm and i1 canirmls

Controls Properties | e e = &
Labell | Text: Add Two Numbers, Font: Bold, 14, Add Two Numbers

Label2 Text: Enter First Number, Font: Bold, 12 Eoter First Number [ |
Label3 Text: Enter Second Number, Font: ¥

labeld | Text: Sum, Font: Bold, 12 e e i T—
T:-:ﬂ;mzl | BorderStyle: FIKEdSiF;Ig{E . - Sum —
TextBox2 | BorderStyle: FixedSingle

TextBox3 | Hnr_dr:rﬁh,rlu: Fixe:l?_.i_n_g_lt'. Enabled: False -

Buttosn1 Text: Add, Fant: : e :
Julont | Text: Add, Font: Bold, 14 — S Fig. 5.28 Form with controls

3. Double-click the Add button. This will apen the code window,
The cursor will be between the Private Sub and End Sub lines, Enter the code as follows {Fig. 5.29),

Publie Class Forsl

| Private Sub Buttonl Click(sender As Object, & As Eventirgs) Handles Buttonl.Click

TextBox3,. Text = Val(TextBoxl.Text) + Val{TextBox2,Text)
End Sub

End Clasd

Fig. 5.29 Program code for adding two numbers

Note: Data entered in a text box is of the string data type. The Val function converts il into a
number s that it can be used for addition.

4. Select File » Save All 1o save the project.

3, Press F5 1o run the program, Enter numbers in the text boxes (Fig. 5.30) and click Add. The
sum of the numbers will appear in the text box next to Sum (Fig. 5,311,

79 DX FCIRD
]

™ .- ] i ki H Y e
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v, Formi o | 5 v Pl EE)
Add Two Nambers Add Two Numbers
Ester First Number  [12 | Eater First Namber /X .
Ester Second Number ] Enter Secand Number |
|
Som (== Sum |
|
[y,
LR
Fig. 5.30 Enter data Fig. 5.31 Output after clicking the Add button
IP'

PRACTICE TIME ;@‘*

Maaz’s lacher owns a garment shop that is giving 15% discount on the purchase amount. He wants
Maaz to make a program in Visual Basic to caloulare the duscount and net amount on a gven
purchase amount. The purchase amount is entered by the user. On chicking a Display burton, the
discount (15% of purchase amount) and the net amount {purchase amount - discount) should be
calculated and displayed. Can you help Maaz in this rask?

SOLUTION

1. Seart Microsoft Visual Basic 2013 Express and create 2 Windows Forms Application named
‘Discount Calculation’,

2 Place four Label controls, three TextBox controls, and three Button controls on the form,

3. Setthe following properties for the form and the controls. The form will kook as shown in Figure 5d.

Controls  Properties

- Labelt Text: Discount Amount and Net Amount
Calculator, Font: Bald, 14 || v =T
Label2 Text: Purchase Amount, Font: Bold, 12 | | picoust Amoust sed Net Amonnt Cakiatator
Labeld | Text: Discount Amount, Font: Bold, 12 !
Label4 Text: Net Amount, Font: Bold, 12 Ao
TextBox | E—
TextBox2 | Emabled; False Net Amoast
TexiBox3 | Enabled: False . f‘;‘h"- Foe ] am |
| Bulton1  Text: Display, Font: Bold, 14 — s g e |
Button2 | Text: Clear, Font: Bold, 14 Fig. 5d Form after setting
Button3 | Text: Exit, Font: Bold, 14 | propertics
St a A 80
__;-f--: THRITE L
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4 DrHJhl._-.q_'IIEFi [IH_‘ itngam Li¥ Rt ||I[l' llH:lﬂ." H."H'uﬂ'nqrh, Mddd ||'H.,' Ill'll_"'El 2t shrwm in rigﬂﬂ:‘ g,

SPublic Class Forml
= Private Sub Buttonl Click(sender As OGbject, e As Eventargs) Mandles Buttonl.Click
Dim Amount, Discount, MetAmount As Simgle
Amount = 'u'll{'l'r:tﬂ'ﬁrl Text)
| Discount = 15 / 168 * Amount
HetAmount = Amount - Discount
TextBoud.Text = (Mscownt
TextBoxd.Text = Metamgunt
End Sub

l'|..—[

Private 5ub Button2 Click(sender As Dbject, & As Eventirgs) Handles Button2.Click
TextBoxl.Text = ==
TextBox2. Text = ==
TextBox3.Text = =°

End Sub

T —

Private Sub Button3_Click{sender As Object, e Az Eventiegs) Mandles Buttomd.Click
Close()
End Sub
End Class

|

Fig. 5¢

5. Select FILE » Save All to save the VB application

& Press FS to run the apphcation.
7 Enter Purchase Amount (Fig. 5) and diick the Display button. The Discount Amount and Net

Amount are calculated and displayed in the respective text bowes (Fig. 5g)
et folalEs | |t TelE

Discount Amonnt and Mel Amoant Caleulator

Discount Amount sad Net Amount Caloulator

Porchase Ameunt =8 Pusthase Amouat 1200

Discoand Amouat 1"

DHscount Amsl
Nel Amoasi Tepl Amauat .
][] [ | | (] (o] [

Fie. 5F Enter the data Fig. 5 Oulput after clicking the Display button
i : ‘

8 Click the Clear button to clear the dara in TextBox1, TextBox2, anc TextBox3.

9 Click the Exit button to close the apphcation

Bl X FORD
ﬂ ‘l .‘ r. b BIEIRTE P
| n BEEE 8 B B
i@ oEnA EEER EDE =@
HE B llll u BE @@ B & m
e m mE 0 —— SR
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Concatenation

With strings, you can use the + or the & operator for adding strings one after 5“"_“""'*“ This j;
called string concatenalion. To understand this concept, let us create a VB project to enter
first name, middle name, and the last name. On being clicked, the button will display the full

name in the corresponding text box.

1. Start Microsoft Visual Basic 2013 Express and create a Windows Forms Application nap,,

“Concatenation Example”,

2. Place five Label controls, four text box contrals, and one button control on the form,

3. Set the properties for the form and controls as shown in Table 5.4. The form will now logk ,

shown in Figure 5.32.

Table 5.4 Properties for the form and its controls

 Controls  Properties

| Labell | Text: Concatenation, Font: Bold, 14

‘Label2 | Text: Enter First Name, Font: Bold, 12

' Label3 | Text: Enter Middle Name, Font: Bold, 12

Labeld | Text: Enter Last Name, Font: Bold, 12

' Labels [Tu:ﬂ: Full Mame, Font: Bold, 12

| TextBoxl |

 TextBox2 |

TextBox3 |

TexBoxd | Enabledifake
Button! T_TExt: Click, Font: Bold, 14

 fomt e
Concatenafion
Enter First Name
Enter Aiddle Name
Enter Lasi Name
Full Name

Click

Fig. 5.32 Form after setting properies

4. Double-click the Click button to get the code template, Add a line as shown in Fig. 5.1,

Public Class Farel

tnd Sub

— e

Private Sub Buttoml Click{sender As Object, e As Eventargs) Handles B
TextBond.Text = TewtBoxl.Text + * ~ 4 TextSomcd. Text +}- nees Buttond.Click

+ TextBox).Text

= — —

Fig. 5.33 Program code

5. Select FILE » Save All to save the VB application,

. Press F5 to run the application.

7. Enter your First Name, Middle Name, and Last Name in the respective text baxes (i, 5.4

and click the Click button. The information will appear in the Full Name text box (Fi

OXFORD B
e RidTE BRER i =_ nn B
i o B Daon = 1
20 oBEE EEERE OOD .
0 @ @E @ omEEE@ L m nm

B 5.4l

2 B BR B - .
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Concaltenation

Eater First Name AT

Eter MidlaName €

Eater Last Name

Full Name

Eﬁtkb

Fig. 5.34 Enter data

T R e— |
Concalenation '

‘ Eater First Name G

! Ester Middle Name © T

| B, !

| |

| Full Name € Ma |

Fig. 5.35 Output after clicking Click

Graphical User Interface (GUI an interface that
enables the user to interact with an application
by using controls like icons, buttons, menus,
dialog boxes, and windows

Evenl an action in a GUI application, like click,
double-click, mouse over, elc.

Evenl-driven Programming  programming in
which the program responds to events that are
actions periormed by the user

memaoryiBLteE 1

Integrated Development Environment (IDE) 2
programming environment that integrates
many difierent functions such as designing,
editing, compiling. and debugging in a single
window

Project a collection of files that will make up an
application

Property a named attribute of an object

Method  an action that can be performed on a
control

Visual Basic is an event-driven programming
language with an integrated developrment

emviranment for creating Windows applications,

The main components of a Visual Basic
window are the title bar, the menu bar, the
toolliar, the form window, the Toalbox, the
Properties window, and the Solutions Explorer

""iﬂdmw.-'.

* The main steps in developing a Visual Basic
apphication are: coeate form, place controls on
the form, set properties of controls, and add
code to contrals to handle events.

There are two methods of placing controls on a
torm: double-click the control in the Toolbox,
or click the control in the Toolbox and drag it
1o the form, ‘

0
T . i
4 DoEER @ 2 B
SodE DoEE oE@E o9
[ - ] amEE@E@ [ | (1l ] 4} -
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The code is written between the Pri""‘l-rg,*
and End Sub statements.

e To run the application you can press Fs, "«
Sary

\I-ﬂ'u Lan Eh;lnlﬂ_ﬂ'

. thee properties of controls on
Ihl.,:l- Tormy I_'“ U'!:-in-

g the Properties window,

When
Vo T TR
ou double-click a control, vou 2et A

cede template, SeBLIG > Start DEbUESIRE, o¢ Click f
button on the toolbar.

Objective Type Questions
1. Choose the correct option.

a. To run an application

!:_ Clicl: F3 ii.  Click DEBUG » Start Debugging
iti. Click Start button on the Toolbar iv. all of these

b. :Fhe programming code is attached with the
. Label ii. Button i, Box iv. all of these

C. }‘l.'hich window will be the user interface when the program is running?
I.  Properties il. Solution Explorer iii. Fomm . Toolbox

d. The cantrol that is used to accept input from a user is the
i. Button ii.  TextBox ii. Label iv. WebBrowser

€. A window that lists the solution name, the project name, and all the forms used in 3 project
L FormWindow i Solution Explorer iii. Propeties i, Toolbox

Descriptive Type Questions

1. Answer the following,
a. Name any four components of the Visual Basic 1DE screen and their use
h. What are the four steps in developing an application? #
c. What are the two ways of placing controls an a form?
d. What is an assignment statement? Explain with an example,
e, List all the arithmetic operators used in Visual Basic,
f,  Evaluate the usefulness of event driven programming such as that used in Visyal Basic
g. Based on what you have already learned in Class 6, can you pow analyse th ;'If i
between the MS Small and Visual Basic? € dilterences
h. Create a Visual Basic program which displays the output: * like programmin .

OXFORD L B4
it 4 naTE BRERR B m .== . -
B B o |
EEES mEEE o ’
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Appjicatinn-ﬂaiﬂd Questions

: L.lei“'.ln ','I:H.! {!FHTI"I a nf."n-‘p' FIIUIL‘r II IIH" “]r SIS ‘!FH?N._'“I-._ ...I.ilh £y I'r WL "r'lli"_""l I"iff“1 ]
i. Which property is used 1o change the text from “Farm1* 10 *Caleulator™?
ii. Which propenty is usee to change the background colour of the fom?

b, Wite the output tor the I'::1Im-.-ing arithmetic aperations:

i 16/3 “ 1643 i, 16 Mod 3 w373
Write the programming statements for the folloawing:

i. to declare three variables a, b, ¢ of the Integer type

ii. 1o declare a variable a of Integer type, b of String type and ¢ of Single type

4. Name the controls used for the following:
i. togive a caption
ii. toaccept value from a user
iii. 1o execule code on its click

. Write assignment statements for the following:
. Assign a numeric value stored in TextBox1 to the variable Num.
ii. Assign your name 1o the variable MyName.

IN THE LAB
1. The Computer Science teacher has asked the students of Class VIl 1o create a Visual Basic
application to enter a number and display its square and cube on click of the Display button, Help
them with the code and design your own interface.

Hint: Square = Number * Number
Cube = Number * Number * Number

2. The Science teacher has asked the monitor to creale [ bt — == .|
an application that will convert the temperature given {
in Fahrenheit to temperature in Celsius on click of llhE' ‘Temperature Conversion
Display button. The interface should look as given in Ester temp. in Fabreakei
the: adjoining figure.

Can you do this task? Temg. in Cebsing
Hint: Celsius = 5 / 9 * (Fahrenheit = 32

85 i
n « s w g  OXORD
b haet # ® BEEN ® @m @
In " _w = - = wo" RER_NEEE EER a8
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3. The Math teacher has ashed Bebana tocreates o Vistal - o Rectan s
Basic application that sl ispet length and Diesacdth ol Arcaola Rle
areetangle m Testos 1 amd TeatBos 2. On el king the | Eater Leagih
Area button, il showilid ahisplay thee area in Testfiox k. [E——
Cnadee King the Perimeler battesn, it showlid flih|3|n|!r' the i! siiie
penmeler i Testbond The intettace should look as | Aren afthe Rec
seen i e Tgune given .I|nllnj.1,'-|i'.'[l‘r Perimeter of the Rectaagle
3. The class teacher las asked Mohid to create an i : —
application that inputs marks obtained by a stutlent, _! =
calculates the total and the average marks, and displays =B

it on the screen upon clicking the Caleulate bution. Can
vou help Mohid in his task?

The Computer Science teacher has asked Mushtag to create a 'l."isuaI_Eamc a pphca!m;lﬂ for ﬂ;n;e;?g
the height in centimetres and displaying it in feet and inches. Help him create the code, 3 gn
VEELIT ERA I Fﬂll’ﬂlﬂflﬂ
Hint: Height in feet = Height in centimetres / 30.48

Height in inches = Height in centimetres / 2.54

| =1

GROUP PROJECT

A new language to master, Find out more about some different types of Computer Programming
languages, such as C=, Javascript, and Python. Your research should include information on the
development of each language, its common use, and its advantages and disadvantages. Complete a
comparison chart which can be enlarged, printed off, and displayed above your computer to remind
vou of differem ways of compuler programming,

e TEACHER'S NOTES
o The free Microsoll Visual Hasic 2003 Express software can be downloaded from the websile
titpttveww mid resll. comiesprissfdownloads.
o The bassc controds and their propenties could be disoussed with the students and their uses demonstratid
Lyesbeares thisy try ol o restings programs on their ow,

o ot create and run Visual Basic applications could be demonstrated o make students comiortalile
with the user imberface.
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Communication on
the Internet

Towgle, | moed £ wrie
P an pssay on the Internet and

irs Detehd s Dol W SEENTS il

ortly used for net surfing and ) .

checkingemal " Nee ar all Gogglel
— The fgermer offers 2 lot

maore than fust érmail

. and nersurfing. o
e _'T .._'_'_,.-

5
i

* Really Could

yau rell me mare
ahour e s

The Internet offers users several different ways of connecting

with people. You already know about email and web In this Chapter

browsing. The Internet also provides other means of .

communication and many more services. Chat, Instant Messaging and
MEWSEIaLps

» Blogs and Web Feeds

In this chapter, you will learn about some of them.

» Social Networking: Facebook
MySpace, Twitoer
EHF", INSTANT MESSAGING, AND HENEEHHUPE = Dther Seryices: E-Greetings,
Eh]_l prugrnm_i andl instant mﬂsaging let You communicate Cnline G]I‘Hi:‘tE. and Online

i : 3 Telephany
with other users instantaneously through text messages. \ Cloud Camputing and

Newsgroups also allow you lo interacl with many other users, Online Sharing
but communication is not instant.

a7 ONFORD
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Chat Rooms

A chat room is a service in which mitltiple users talk 10 each

other in real lime Iy prosting messapes, H':Hnl”}' on a rn|:|i|:_' of
LAV ||'|.tl“”'l-|.|'l .','\.L”i':" 1‘{1k!|‘i|th‘ 1”-|.1-.r i |'|||! FERENT r-.]Lili"L"E'.

S0 popular ones are 1CQ.com, delphiiorums.com,
praltalk.com, teenchat.com, etc,

nstant Messaging

pid you Know? - r’E
F.Il;!l]l:lﬂl"'- M'EH-EI‘IEEI" i5 an
instant Messaging Service tha jg,

you chat with Facebook friend,
and other users.

Instant messaging (IM) is a communication service over the Internel that a”DWIS instan
transmission of text-based messages from sender to receiver. Like online chat, instant messagiy
also offers text-based, two-way message exchange in real time. It is different from online cha
in that IM is communication between known users, whereas online chat could also hrlF}FlE‘”

between unknown users.

Instant messaging is like a private chat room. It includes 1_'|-r'||':.-' those pEDFI|E whom the user has
invited. It creates a list of all your friends, and when a new message arrives from any one of

them, an alert pops up on your IM screen. Papular IM services include AOL Instant Messenger
IAIMI, Skype IM, Windows Live Messenger, Yahoo! Messenger, and Google Talk. IM services

may require you to download a program or require only a browser,

Using Yahoo! Messenger

Let us use Yahoo! Messenger 10 understand how you can start a voice

call, send a message, etc.

1. Connect to the Internet.

2. Download and install Yahoo! Messenger from www.https://
messenger.yahoo.com

3. Select Start » All Programs » Yahoo! Messenger » Yahoo!
Messenger.

Or

Double-click the Yahoo! Messenger icon on the Desktop. This will

show the Yahoo! Messenger sign-in screen (Fip, 6.1),

4. Enter your Yahoo 1D and password and click Sign in.

l= & gk

5. The: *Home' screen appears (Fig, 6.2).
Fig. 6,1 Yahoo!
Messenger sign-in scrett
OxX10ORD
. = = i1}
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7o send an inslant message, start a
" ideo call, voice call or to send an |
1S, click Actions and select the | v Mmm oo
ﬁe&ifﬂd n.Pt'iﬂ'n {Fig. 6.2), ; Start Video Cal... Cai+d
Start Voeee Cal,.. Curl+
00's and Don‘ts of Chat Sand an SMS MESSACE. Crrl+T
\hile chatting can be fun and informative, Serdank e
¥ g I Sh

hese 00 and don'ts are important, E::smul:l m:L E::mm

' Request Contact Detals  CHT4Snfte
Do's

3 ¥ Friends (0/1) send a Fis...
» Use a chat nickname and not your real Shave Pheotea. .
o ik Chesose Plug ...

[peTie: e ) Irssite ta Conference..
« Check the terms, conditions, and privacy |1 v racebook friends| e ;

statement of the chat site before you

begin chatting. » Address ook (3)

s Use decent language while talking,
Don'ts

Fig. 6.2 Starting chat

+ Do not reveal any personal information in a chat room.

+ Do not agree to meet someone you have talked to only in a chat room.

HEwsgroups

Mewsgroups are similar to email, except that messages are not posted to somebody’s mailbox
but an a bulletin board where any member can read and respond to them. This allows a

discussion to take place among several people.

A newsgroup may have several active discussions at
one time,

The difference hetween newsgroups and chat rooms
15 that newsgroup communication is not instant, As

with email, people read and write messages al their

Convenience,

There are thousands of newsgroups on the web.
N_““F,"Eupﬁ are organised into official category

| lerarchies of names and dots, which are read right
o left,

F“'F“mple. alt.music.jazz means the jazZ mu5i+:1
M in the alt (alternate) category. Other calegonies
3 :
"t Mentioned in Table 6.1,

Table 6.1 Newsgroup categories

Category  Description |
. l;{inE_ Computer-related lopics |
|Misc | Miscellaneous topics |
News | Hewsgruun-r:elmai_nlﬁs_
| Rec 1' Recreation, |n|_|uc:|mg i
.| spons, hobbies, etc.
;Ev:_i_____ !Scinnlifi{:—tnpiﬁ - -
i soc _ 5_u-:u.1.|.u'|rlLu|'luraI lt:_pi-iéﬁ_
Talk | Politics-related topics |
LAl . ."n.-'-'arie.d ;ﬂpEs =y

o —
Alt.binaries | Images and videos |

Biz Topics related 16 busine-_r;s.._'
L | commerce, jobs, el
o Al w . u  OtwoEp
E EEEE B @ g :
.uﬂlll EEEN mmE gg
[ ] - -_—
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gLoGs

A blog ; - . .

log o o Wl."hlﬂg s wehisiles o wliic b artie fes e [ il o Koow? m
M i ] ] ¥ I

Posted repularly il tispalayed i genveersee sesuential orde,

It with 1y Frrs] o ”'ll'll'rl‘“\"l'f'hl“'r'. PSR i g

by Jeabuin Barger (U R TRV

o Preted Pbsalagh
. . programmaner Pelet il
b ! A bl s hhll.lll}- b uses o purlic ular ares of shtirtened welilugs to Sy I
st Sanme Dlogs, espue filly thoses of celebritios, discuss
F“'rh'””iﬂ “:""I“.r""“:_ s

cent entey fist, Blop entries can have

e, hy - : :
Peest images, aned links (o other web poges, video,
aticdion, g

Coalbegpe student, Justio by,
created the hirst Blag, linkspey
1904, At that time, it e called 4

Authoring a hlog W , ,
¥ B mrntaining a blog, or adding an article o
i 5 h personal homepage.

AN existing hlog is called blogging, Individual articles on a
blog are called blog posts or entries. losges are cresated through
bl lg-puhfi'il‘lirlg [atlorms offeris by 1o hesesed ¢ rpmrmni:'ﬁ.. For vmr’rlp]ﬂ, w‘""!l""w't"m I
popular h|!=u-hn.-ling platform awned by Automattic, i web development company, Hogger,
owned by Google, is a1 present the maost popilar blogging platform.,

WEB FEEDS

A web feed or news feed is a facility that informs you when a woebsite you are interested in has
new content. It is a good method of keeping up with blogs, news sites, and other sites, You se
updates from many sites in a single place and don't necd 1o visit mulliple URLs. A progeam or
website that allows you ta keep up with new content from websites of your interest is called o

feed reader. You tell the feed reader which sites you want 1o see; this is called subscribing 10
the website,

All sites do not provide web feeds, You can only subscribe to websites that provide a wel feed.
Feeds are often known as RSS I:lenlii}r Eimplu synilication). Th;_--ll.- are weh pages f.l[!":'rllgﬁ{:'ll o b
read by computers rather than people,

Muost browsers and email programs have feed readers built in them, Some other feed readors ar
as follows:

» Feedly tweb-based, mobile devices) * Feeddemon (standalone program)
» My Yahoo Reader (web-hased) * Awasu (standalone program)
» Omea Reader (standalone programi

SOCIAL HETWORKING

A website that provides a virtual community for people 1o keep in touch with friends or share
common interests is called a social networking site. SixDegrees was the first social networking
site. It existed from 1997 10 2001, Then came Friendster in 2002, Myspace in 2003, Facebhook

OXFORD i o es e 30
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= "'1"I|_T-=. ﬁﬂd T'-'- ith—'r in ..!”[:lh_ Ti |1:|.,|'l|'I ll“r mosh
nd Twiller. Let us leam more abog them,

isceboak ﬁ

pacebook is a very popular social networking service
.+ 0.3 Itwas founded by Mark Zuckerberg, who
a5 2 student at Harvard University, USA, in 2004,
initiallv, membership was for Harvard students only,
Later it was extended to other universities, and then to
the general public.

popular secial netwarks are Facebook, Myspace,

"
!:-EJ- et

tacebook S— —

e S i B e — Crgate 8 RECOLE
s et e - s i

Fig. 6.3 Facebook loginfsign up page

To use Facebook, you first register as a member. After that, you can fill in details in

vour personal profile. You can add other users as friends and exchange news, messages,
phatographs, etc. Users can also form common interest groups, for example, of colleagues, of
chool or college friends, etc. Many companies have set up their own Facebook pages. It helps
1o connect and communicate with clients and customers, especially young people.

In the future, Facebook plans to develop applications
that allow people to share information in difierent
ways. Facebook keeps adding new features, for
example, location tagging, and mobile advertising.

Facebook is the most popular site today for uploading
photos,

Myspace wimyspace

Myspace was started by Tom Anderson in July 2003

Fa 6.4 Between 2005 and 2008, it was the most
popular social networking site. Myspace lets you
Create a personal profile that you share with family

and friends. It has a strong focus on music sharing,

with instant messaging and video-playing features. The
site hecame slow and less user-friendly due to heavy
édvertising and slowly lost out 1o Facebook.

Myspace has plans ta improve performance and
EFH-‘FE, and to make the site mare n:t'u'lgrltinn-llliﬂmﬂy.
talsg plans 10 help users express themselves through

tindividual tastes in music, photos, videos, and
"her art forms,

My ,
Pace now has an enhanced visua

a1

B o m B E:

| Did you Know? ﬁ

Linkedin is a social networking site
focusing on professionals, including job
seekers, It is the world's largest professional
negwork and is growing rapidly,

Fig. 6.4 Myspace home page

| design and also has a version for mobile devices,
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Twitter |

Twiller was created by Jack Dorsey

in March 2006 Fig. 6.5. It is a social
networking service that allows you 1o
communicate by sending short text
messages, up to 280 characters long, 1o
your friends or followers, These messages
are called tweets, Most people use
Twilter to inform others about the latest _
happenings in their lives. However, it has I .
also played a larger social role by helping ‘
organise protests. A good example was
the 2011 Egyplian movemnent that led to
the overthrow of the Egyptian President, Hosni Mubarak. It was called a Twitter Revolution’,
because people used Facebook and Twilter to organise and coordinate the mass movemen,

Fig. 6.5 Twiller sign in/sign up page

In the future, Twitter plans to add features for improved security. Twilter has also been
successiully used to inform people about livie TV events. They have also launched a feature
called Twitter Amplify, used by companies (o advertise their products.

OTHER SERVICES

The Internet has transformed the way we entertain ourselves, how we keep in touch with
iriends, and many other things. Let us learn about some more Internet features.

E-Greetings

You already know that you can send mail over the Internet (email), We can also send grecting
cards or e-greetings over the Internet. These are some wehsites that allow you to send

e-greclings:
e R e
« hitp:/fwww.egreetings.com e e
I —
* hitp:/fwww,123greelings.com : W o Latrima s mg O
. ) s o A
o htip:/fwww.americangreetings.com ——r—y——w—Trr s

- AW e
Let us see, as an example, how [ HA‘FFT "'!.".,
o send a birthday e-card through R —

12 33r;:n:1ing5.cum-

L Lot ST ———
e ——

1. Open the websile
www,123greetings.com iFig 0.6,

"re=m Eew Tr s R P - = L

Fig. 6.6 Home page of www.123greelings.com
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1 T#‘I“—“Bi"hd“w ok th.i: Search text box and click Go. You will see cards available in the
celected calegory (Birthclay),

wote: You could also click the Birthday tab in the card categories.

3, Click the card you wish to send. The card page shows you the full version of the e-card
(Fig. bk

4. Tosend the card, click the Send
wutton. Then follow the steps to
select the friends and send the card.

‘_?-__ s

Iif you want to send an e-card
1o many people or add a message
to the card, click on Send this

card to multiple recipients.

Fig. 6.7 Full version of the p-carc
gnline Gaming
Online gaming means playing any type of virtual game over the Internet or over a COMp uter
network. Online games can be divided into these broad categories:
+ Shooter + Action-adventure

» Simulation  Strategy

* Role playing

Requirements of online gaming:
» High-speed Internet connection « Proper hardware

» Gaming control devices, e.g., Xbox, Playstation, joystick

+ Gaming software » Latest Flash and Web browser versions

Some multiplayer games are heavy games that must first be installed on the local computer.
They are then played over the imernet with other players. Examples are Heedlfnr Speed and
Call of Duty. A Massive Multiplayer Online Role-Playing Game (MMORFPG) is a multiplayer
game with a huge number of players from around the world, in which players take on roles in
a virlual world. Such heavy games are usually developed by a studio and then published by a

company.

Multiplayer games played on browsers have to be light, since they are downloaded from a
website and stored in the browser cache, Games like FarmVille, CastleVille, CityVille, and
Mafia Wars are not installed on the local computer, and can therefore be called purely online

Fames,

: a3 oo s & o
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Online Telephony

- : ; srs in make leleph
Online 1.['11:],'1."'..”1“ or Internet 1{!."1":""””}'. 1% 41 1:::_|'mn[ug1. that allows users 10 PNone

calls over the Internet. You can talk to somebody who is using a CONpUIRG G R on0 m ke
domestic or international calls from vour computer 10 4 telephone. Sl mﬂﬁe el
phone, vour call goes over the Internet to a local telephone network eyl : ; Iﬁjijphunﬂ
vou are calling. The only requirements for online telephony are that your compuier m“hE ;an
Internet connection, speakers, and microphone. Calls made over the Internet are much chegape,

than international phane calls.

Skype is the most popular Internet telephony software. with Skype, mmpuler—rm-cnmpuler calls
are free. Calls from Skvpe to a telephone number are nol free, but rates are quite low. The Sk,
softw are is available for iree download from the website www.skype.com.

File Transfer Protocol [FTP)

File Transfer Protocol is the simplest and most secure way to exchange files over the Internet,
\When vou download a file from a website, you are using the Internet to transfer the file from the
other computer to your computer, That is why there is a T (Transfer) in FTP. FTP servers can be
public or private. Public FTP servers do not require a login and password, whereas privale FTP
senvers do. An FTP address looks like an http or website address, except that the prefix is ftp://
instead of hitp://.

How FTP Works
FTP works on a client-server madel. A client program lets the user access information and
services on the server computer. Follow these steps to access an FTP server:

1. Open the FTP website. A dialog box appears, asking you to enter the username and password
2. After connecting to the FTP server, use Windows Explorer to upload, download, or delete files.

CLOUD COMPUTING AND DHLIKE SHARING

Cloud computing is a technology that uses the Internet and central remote servers [computers) lo
hold data and applications. It allows organisations and users to use applications without installing
the soitware. They can access their files and data from any computer with Internet access.
Centralised storage, memory, and processi ng allow efficient and cost-effective omputing

ThinkFree, Google Apps, Google Drive, and Microsoft Office 365 are examples of cloud
computing services. Office 365 is an online service for organisations. It offers email, shared
calendars, the ability 1o create and edit documents, instant messaging, conferencin : nd more.
ThinkFree Online gives access to a set of ofiice programs withou 9

t needing to install the
| . m on
vour personal computer, You can write, save, share, and open office dua;Emem_; online

Cloud computing has enormous potential. It is expected that, by 2020, most people will use

OXFORD 94
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-::Iﬁfil‘lu software ﬂpr.ll:m;lliung-; and sgve thesir

; files online, rather than depending on software and
an their pl.':lE-E"F’lﬂ| SYsSlems,

files

4 online file sharing service provides 2 way to slore and access information in the ‘cloud’
rgther than locally on a hard drive. This information could be anything: documents,
]“['-:.Ef'l!ﬂl-iumr data, 13I|'II}[':'_'IE.r "-'iL’.lE{:SI etc. The ﬁl'"-’ijl'ﬂﬂgl.': of using an anline Eh.’.‘lriﬂf:’, service is that
Lou do not have to support and maintain the data and computers yourself.

|pformation in an online file 5hﬂli|'lg service can be accessed from any device with an Internel
connection, including smartphones and tablets, and by anvone who has data access rights,

some examples are OneDrive for any document, Picasa for photos and images, and YouTube
for videos. Let us take them up one by one.

7

OnoE; TR e =, arvtm e
OneDrive (previously called Windows Live ' F

fie

SkyDrive) is a password-protected storage area
in the cloud, like an online hard disk, hosted by
Microsoft Corporation (Fig. 6.8). You can use it
1o store your files, and access them any time you
are online. Users can choose which files they
want to share with contacts, make public, or .
keep private. They can control permissions and Fig. 6.8 OneDrive opening screen
decide wha can view and/or edit shared documents. OneDrive provides 15 GB of free storage
and you can pay to get more.

Picasa c

Picasa is a free photo-management software
om Google, The Picasa program lets you:

* View and organise all the photos on your
Lomputer,

* tdit and add effects to your photos.

* share the photos on web albums in the B T T S ——
1 M »
Picasa Weh Albums site.

P Fig. 6.9 Picasa home page
€253 Web Albums is a website where

Yo can slore and -_.;|'1:|r{_- |‘,|I'|r:|EU5. ThL" Picasa i][(}HrJ_m and ||'|L" Pirﬂﬁﬂ "lu'l'ir‘;'l.} A”:”Jms, E‘itE' "n'r'ﬂrk
xpethe b
UBelher. Follow these steps to use Picasa:

' Download the Picasa program from picasa.google.com and install it (Fig 6.9),

a5 OXFORD
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: N asd.
- Double-click the Picasa shorteut on the Windows Desktop to start Picas
0. memaory card, scanner, wehear,
ays them autamaticy)),

] .
1. Picasa seans the computer and [f';_n.phn-; all the pichu
can alun Impwsr ;}hmu-. Itom many sources: camerd, c

etc. Picasa saves these imported photos on your compules and displ

. L.
. The Upload button lets you transier photos to your Picasa weh albums accoun

L'sing a photo sharing service like Picasa has two advantages:
* It allows Casy |;‘||hur|1| ghnrinﬁ_ e [f pm.x'i{[-r_'i online hﬂEi{UP.

Email is cumbersome if you have many photos to show (o your friends. It is better to put them
somewhere on the Internet, set up security so that you can control who sees them, and then |
vour friends where to find them. Keeping photos online ensures that the photos are safe even i
something goes wrong with your computer.

vouTube T““

YouTube allows people to discover, watch, and share self-created videos. The founders of
YouTube were Steve Chen, Chad Hurley, and Javed Karim, At a dinner party in 5an Francisco,
they got the idea of starting a site 1o allow sharing of video

clips that were toa big for email. This led to the birth of [ pid you Know? ﬁ

YouTube in February 2005. In 2006, Google purchased it for

$1.65 hillion. Javed Karim posted the very
first YouTube video in April 2005
Many companies now use YouTube for launching and The 18-second video, entitled
advertising their products. Every minute, 24 hours of video is "Me at Zoo', shows Karim and
uploaded on YouTube. It is believed that an average Internet some elephants.
user daily spends at least 15 minutes on YouTube,
Tricky Terms: SRS i
Chat Rooms  websites offering online chat Feed Reader 3 program or website that allows
facilities you 1o keep up with new content from
Newsgroup o proup that posts messages on an wiehsites of your interest
anline bulletin board where anyone can read Online Gaming playing any type of game throush
and respond the Internet or over a computer network
Blog  website on which asticles are posted egularly - Online Telephony  techn ology that allows users
andl displayed in reverse seeuential osder to make lelephone calls aver the Intemet
Blogging  authoring a blug, maintaining o blog, Cloud Computing technology that uses the
ot adding an article o an existing Lilesgs Internet and central remote servers 1'cwltm|
Blog Posts individual anticles on a blug tor ol elata and applications
oxtokn L 96
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Chat programs let you communicate with other

Memory Bytes - - o

Many websites allow you i send egreeting

users instantaneously through lext messages, over the Intermet,

Ablogora weblog is a website on which *  Online gaming means playing any tyjee

artiches are posted regularly and displayed in of virtual pame over the Internet or Over A
reverse sequential order. computer netwark,

A Web feed (or news feed) is a facility that o Cloud computing allows organisations ant
informs interested readers of new content an a users 1o wse applications without installing the
wehsite. software on their systems,

A social networking website provides a vitual — »  An online file sharing service provides a way 10
community for people 1o keep in touch with store and access information, such as documents,

iriends or share common interests,

clata, photos, and vides, in the cloud,

Objective Type Questions

1. Choose the correct oplion.

d,

+ Which of the following lets you

Which of the following are feed readers?
.. Google Reader ii. My Yahoo Reader jii. both i, and ii. iv. none of these

. Which of the following was the first social netwaorking sitef

i 5|;Dgﬂmf_-5 ii. Facebook ini. Twitter iv. none of these
. individual entries on a hlog are called ....coeeee... |

i. Posts ii. Blog posts iii. Blogging iv. none of these
. Which of the following should be kepl in mind while chatting?

i, Usea chal nickname and not your real name,

i, Use decent language while talking.
iii. Do not reveal any personal information in a chat room.

iv. All of the above.
communicate with other users insta ntaneously through text

i 'Chaf programs i Instant messaging iii. both i, and ii. iv. none of these

B? = L] 2 | E:::-EEEE
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. Popular instant messaging pregrams incluee
i Skype IM i, Windows Livee Messenper
i, Yahoo! Messenger v, all of these

. Facebook was founded in

i 1904 i, 2004 i, 2010 iv. none of these

h. Twitter was created by .
i. Jack Dorsey ii. Tom Anderson jii. Mark Zuckerberg v, none of thise

Descriptive Type Questions

1. Answer the following.
What are the advantages of using an online sharing service!

a.
b. What is the use of Picasal

€. Name any two online games.

d. Give any two examples of cloud computing services,

e, What do you mean by online telephony?

f. What is social networking? Name any two social networking sites.
g What are feed readers?

h.  Mention any two things that you should not do while chatting,

List three of your faveurite forms of communication on the Internel. Give at least two advantages
and two disadvantages of each of these.,

Ahmed's older brother uses the Internet to communicate with his friends on Facebook, Twitter,
and appropriate chat rooms. In order to create his account, Ahmed's brother has to provide
basic personal information. List some of the salety hazards that he may face due 1o sharing his

personal information.
k. Practice writing a blog on the importance of communicating wisely on the Internet. Your word
limit is 200 words.

Application-Based Questions

a. The Computer Science teacher has prepared assignments for students of Class VI She wants 1o
ensure that all the students receive the assignments. What would be one of the ways to share

the files?

b. Yameen recently visited New York with her family. She took pictures using a digital camera. She
wanis 1o share these pictures with her friends. Which Internet service service(s) can she use for

this task?
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¢. Insia forgot to send birthelay grectings 1o hor fricnd Maaz, Which Internet service can she use 1o

wish him on his birthday? Supges ANy one site she can use for this purposee,

il Hammad's sisler has gone 1o the LISA for higther studies, Supgest o popular Intermet service by
can use 10 call her,

IN THE LAB

1. Your school recently organised some inter-school competitions, You have been given the
responsibility to share the pictures of various competitions with other participant schools. Select an
Internet service for this task. List the steps needed to upload the photos.

3. Using an Internet service, send New Year greetings to two of your friends,

3. Search the Internet and find two relevant websites for cach of the following:
a. Online file sharing b, Online gaming
¢. Internet telephony d. Photo sharing

1. Waleed has been asked by his Computer Science teacher 1o create a blog where students can post
some interesting facts about animals, plants, etc. Help him with this task. What could be a possible
title for this blog? Also create a relevant blogpost.

GROUP PROJECT

Blogging time! Let the fun begin! As a group find out how to create a blog in WordPress or
Blogger and create one for your group think of an interesting name for the blog first. Select an
interesting topic that you all feel passionate about and also one that you think other people will
want 1o read and enjoy. Consider what needs to go in your first blog, Do you need 1o introduce
your tapic as well as yourselves? How many words should it be? How do you make sure you
haven't written anything offensive or silly by mista ke? Make sure you include at least one visual

 suppont your ideas. Best of luck at the start of your blogging journey.

¥ TEACHER's NOTES
* Spend sume time telling the students ahoul anline safety and lht.r :I.l_np,m of I:n;'frimrj'rn}.-, strangers. Tell
them 1o be careful and protect their own privacy and that of their friends, family, school, etc.
* Online bullying on social networking siles 15 A s.:.-rIer;_F:rut:nrem amaong, children and young adults. If
possilile. the school counsellor should speak 1o the children about this,
* Discuss the advantages of e-greetings, cloud computing, and online sharing,
* Discuss the uses of Picasa, OneDrive, YouTube, and FTP in different situations,
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more Tools in Flash

Thanks' Vol you
el e Al sorme
L mare of these Tools

There are many Toolk ™
ir R lewt Knose adsae | |

Fhiere o cne (i aoks ke

s

A pren tal | waarmcler idsar ol
w8 used for

—y

That 15 rhe Pen Tinw,
it o wesed for drasveng

srfay hr ines.

In Class 6, you learnt about some Flash C53 Tools, like the
. E——
Line Tool, the Oval Tool, the Rectangle Tool, eic.

In this Chapter

In this chapter, we will discuss some advanced leatures
of Flach.

s Pen Tool

» Eyedropper Tool

w | » i
PEN TOOL '&, mPﬂHmh.r!P-:tum

= Transforming Objects
The Pen Tool is used for drawing precise paths like straight * Working with Text

lines and smooth curves. You can also adjust the angle and
length of straight-line sepments and the slope of curves,

Straight lines can be created by simply clicking on the stage, while curve

S : d lines can be create
by clicking and dragging,

The steps to use the Pen Tool are:
1. Select the Pen Toal.

{]!FI'EJHI‘J'

o [-F-] [ 5] 1“][]
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s Click on the stage to set the first point,

3. Click again 1o set the second point and
keep clicking 0 set more points, Flash
automatically connects the paints as
you set them.

4. You can leave the path open or create 3
closed shape (Fig. 7.1).

+ To complete an open path, double-
click the last point or click the Pen
Tool.

» To close a path, position the pointer
over the first point. A small circle will
appear next to the pen tip. Click to

r—

IR0 bkt om0 Pt + i 11
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Clesed pash

P anwE

i IE%m mBe @

Open paith

%

pmns s Bl

Archor posnts

Fig. 7.1 Using Pen Tool

close the path. Unlike Flash 8, Flash €S3 does not automatically fill the closed path with
colour. Fill colours have to be applied separately.

(YEDROPPER TOOL

The Eyedropper Tool is used to pick up colours and style from existing lines, brush strokes, and
fills. You then apply these colours and styles to other objects. The Eyedropper Tool is linked

to the Paint Bucket/Ink Bottle Tool. You pick a colour from one object with the Eyedropper
Tool and fill the same colour in another object with the Paint Bucket/Ink Bottle. The steps for

using the Eyedropper Tool are:

I. Select the Eyedropper Tool. You will notice that the pointer changes to an eyedropper.

1. Click the line or fill from where you wish to copy the formatting.
3. You will notice that the pointer changes 1o an ink bottle if you select a line colour, or to a

Paint Bucket if you select a fill colour.

4. Click the line or fill to which you wish to apply the copied formatting (Fig. 7.2).

Lie the Eyedropper Tool 1o pick ug
the e eclour and lire ‘.-Irllﬂll'-ﬂ'll heret

The poweer changes 1a an ink bottle
Clicks b fin o want t change

Fig. 7.2 Using Eyedropper Tool
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IMPORTING A PICTURE
To import clip ant or any other (- ___ﬂiq
Image from your computer; - = T L S s
) e =Ll
1. E-Elﬂfl File » ll'l'lPﬂl'l | Iml}ﬂrl B Oeian T poeturps library Mrpsey i, ‘i
lo Stage. E e Eo )
= I —
2. The Import dialog box —— ' - - E H :
i, 7.3 | . .
appears (Fig. 7.3 | B ; Dot e o
3. Select the drive and folder. | == CET -] oA =
Select the picture you want to | ‘{E m
insert and click Open, - 1m'u:, i towe g s fem
| e ]
The image will be added to the e
stage. Now you can work with it — Com B [
in the same way that vou work !I - - = — =
with other objects. Fig. 7.3 Import dialog box

TRANSFORMING OBJECTS

Once you have an object on the stage, you can transform it in various ways. You can move i,

rotate it, or change its shape and size. If a gradient was applied to the object, you can chang
the gradient in various ways.

free Transform Tool 2!

The Free Transform Tool is used to move, rotate, or scale an object. To scale an object mears
to increase or decrease its size. Let us consider an example to understand how to use this todl

1. Draw a figure on stage or import a picture,
2. Select the ohject and click the Free Transform Tool.

3. As you move the pointer over different parts of the selection, it changes to indicate which
transformation function is available. 5 —

moving an Dhject
To move the selected object, position the pointer

over the selected ohject so that the puinter changes K
to a cross. Drag the object to a new position with
the left mouse button pressed iFig. 7.4). et
Fig. 7.4 Moving an objec!
OXIORD . ga s 102 ¥
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potating an Object
To rotate the selected object, position (he
pointer over one of the four comer hanedles,
when the pointer changes 10 a curvid arrow
click and drag 1o rotate the object (1. 7.5,

. 7.5

Je r i awrl
FLRET |
Wl i

R r
rrll Filgte the

Fig. 7.5 Hotating an ohjec

Scaling an Object

To scale the selected ohject in two dimensions, drag
a corner handle diagonally.

To scale the object in a single direction, drag one of

Fig. 7.6 Scaling an oliject the side handles in the desired direction (Fig. 7.00,

gradient Transform Tool S

After you have applied a gradient to an object, you can transform the gradient by adjusting

ils size, direction, or centre, To modify the gra
Transform Tool. Then click on the object that

Lingar Gradient
An object filled with a linear gradient looks as

shown alongside (Fig. 7.7a).

Notice the boundary around the object,

The: line on the right has a rotation handle and a

width adjustment handle.

You can change the gradient fill in any of the
following ways:

dient fill of an object, first select the Gradient
is filled with the gradient.

Rotacion handie

Widch adusement
handile

Centre pont

Fig. 7.7a Lincar gradient fill

* To reposition the centre point of the gradient fill, click and drag the centre paint. You will
be able 1o drag the point only after the cursor changes to a four-arrow cursor pointing left

and right, up and down. Bring the cursor 10
happen (Fig, 7.7b).

E
am
=

the circular handle at the centre point for this to

103 OXFORD
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F ot -3l ndes

CLaOe
Drag the i,

o= ad|usperers

handle lph
rﬁha

Chek and |

drag the

CENTIE PainT

Fig. 7.7b Changing the centre i
o e Fig. 7.7c Changing the width of the gradient ill

paint of the gradient fill

Dirag the reganon
handle claciness
oF ani-Co hwes

* To change the width of the gradient fill, drag
the width adjustment handle to the left or right.
Note that only the gradient is resized, not the
object iFig. 7.7¢).

* To rotate the gradient fill, drag the circular
rotation handle clockwise or anti-clockwise
{Fig. 7.7d\.

Fig. 7.7d Rotating the gradient fill
Radial Gradient

When you select the Gradient Transform Tool and click on
an object filled with a radial gradient, it looks as shown in the
adjacent figure. Natice the ellipse around the object (Fig. 7.8).

As in the case of a linear gradient, you can drag the centre point to
adjust the centre of the gradient. You can also drag the adjustment
handles to change the size or radius of the gradient (Fig, 7.8).

Changing Colour or Transparency of an Instance
In Class 6, you learnt how 1o convert a drawing into a symbol and

store it in a folder called Library. You know that an instance is s Fig. 7.8 Radial pradien!
occurrence of a symbol. Each time you insert a symbol in a movie,

you create an instance of that symbol.

We can modify the colour properties of a particular instance or change its brightness or
transparency. The steps are:
1. Use the Selection (Arrow) Tool Lo select an instance of the symbaol,

2, To change the colour: Click the drop-down menu arrow for Celor in the Property inspeci®
window, choose Tint, and change the percentage (Fig. 7.9). A higher percentage gives a
lighter colour and a lower percentage gives a darker colour.
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Select che insrance

Select Tint

— —

— . TH

_.: iy . Ed-:'"d: w] B amt o]
r_“_—ll_ﬂ'j Fam: 1 AT EI T !-:;] li_El El

Fasd: Seerml

Specify percentage

-

Fig. 7.9 Changing the colour of an instance

3. To change the transparency: In the Property inspector window
arrow for Color, choose Alpha, and change the percentage (Fig,
it at 44%, the instance will look as shown in Figure 7.10.

click the drop-down menu
7.10). For example, if you set

2sE Ssami

- welecr the ingtance

Select Alpha

=

i — R

| (oo =] e |

Sunhmmmuy

Fig. 7.10 Changing the transparency of an instance

Crgn
"Whing Dutlines and Fill
1 You draw an object, say a rectangle or a circle, Flash creates two objects: one is the
e and the ather is the fill.

i 1 DE (%] (<] ] [} E-%L?E‘E
il‘. . 1 E ODEEE 8 [ N -]
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Unprouped abyect shape

To move the obj o cuined
Db]L‘EI Y-8 By |'IH.‘-llr[lr'|. F"u T L arsd il can meve apart

need to select both the fill and the outline. I G
you do not select both, anly the selected parl k| .
will move, : ﬁ *

G
To solve this problem, it is good to group the * Lhmihlﬁ
outline with the fill and make the drawing a .
single object. (Fig. 7.11) *

The steps to group the outline and the fill are: Fig. 7.11 Grouped and Ungrouped objects

1. Using the Arrow Tool, select both the
outline and the fill.

Ty Ti —i'ﬂ“‘l
2. Select Modify» ( Fast Forward f?.f—s.-““’ . v
Group. To break apart a grouped

Break apart grouped objects CTRL+B select Modify ™ Break Apart

WORKING WITH TEHT

Flash allows you to add text to your movies, You can set various attributes for text: style, font,
size, colour, alignment, etc. You can also create special effects by manipulating text, just like
you manipulate other objects.

TeutTool T

The Text Tool is used for inserting text on the stage. Let us consider an example to understand
how this tool is used.

1. Select the Text Tool.

7. Click on the stage and start typing. Notice that this | ogs |
creates an expanding one-line text block, Asyou | KBE_P SIIllllIl !
type, the block gets wider, If you want text in the
next ling, just press ENTER. K

3. You can also set the width of the text block. To do this, just resize the Eep
text hox Manually. You will notice that the width is now fixed. Words sy
wrap 1o the next line when they reach the edge of the text block. Smﬂlﬂ

4. To format the text, select the text block, and use the Property inspector to set font, font size,
color, and other attributes for the text,

5. Ta change the orientation of the text, select the text block, and use the Property inspector to
change text orientation from horizontal to vertical (Fig. 7.12), -
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Font Font Size Fant Colnr il atie  Tewt Qrientation
_'_'_-_._'__ — —— —— - R — T i 'l
¢ Pzpetes | 5
T [ stagic Text »| A Times tiew foman * = vl @ (psiipe@ET = 9
]
iy 1 1
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g ™ 1504 3 010 4] bl Pl SR L kil

Fig. 7.12 Changing text propertios with the Properly inspector

converting Text into Basic Shapes

Flash has a unique feature to convert text into a basic shape, You can then reshape a character
using the Selection Tool. You can also fill characters with a gradient. However, after converting
tex 10 a shape, you can no longer edit it as text.

1. Select the text.

2. Select Modify » Break Apart. This breaks the single text block into ; r[v T h
multiple _tEJ_-:E blocks. Each l_:!_1aracler has its own separate text block. H:'P_i c iEl ﬂji_-
The text is in the same position. b

3. Select Modify » Break Apart once more, The characters can now

be converted into shapes. They cannot be considered text any more. ?
You can no longer change the font, font size, etc. In i and |, the dot, Hﬂ"e F un.

and the vertical line are separate characters.

4. Click outside the converted text to deselect the shapes. Now

you can manipulate these shapes like any other shape, Move the :HHVE Fun!
pointer ta the edge of one of the characters and drag to reshape it. 4

You can use the Paint Bucket Tool to fill this reshaped character
with another colour or gradient.

Animating Teut with Timeline Effects

Flash provides built-in Timeline Effects that help you create animations by simply selecting a
few options, You can apply effects like fade in, fade out, explode, etc. Consider the following

‘example to understand how to do this:

i 1. Create a new Flash document. Using the Text Tool, type Smile! on the stage,

2. Right-click the text. From the context menu that e
appears, select Timeline Effects » Effects (Fig, 7.111 \ Top Tip ',
Then gol e from the list. Or select
jnmr:: :::L thtz desired efl [L*ZT IF!:I'“ =iircj[ i it Timeline Effects can be applied 1o a
imeline Effects and then se drawing object, a picture, or a symbal,

effect from the list (Fig. 7.14),
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Fig. 7.13 Timeline Effects in the context menu Fig. 7.14 Timeline Effects in the Inserl meny
3. Choose an animation, for e =
example, Effects » Explode. The | rowe (=
Explode dialog box appears, o [
On the right, it shows a preview E'I_
of the animation with default Y
settings. 2 P
. - a B iy [ | e
Change the settings if desired s et B
and click OK (Fig. 7.15). B e
4. Notice the change in the Tt .
Timeline window (Fig. 7.16). It
now has frames and animation, [ [
5. Save the file. Fig. 7.15 Explode dialog box showing a preview
Y — 6. Press ENTER to play the movie. You

:_Hmh_mrﬂmmmm_.

can also press CTRL + ENTER to test
the movie in a separate window.

| R R T " weew  PAnimating Text with Shape Tweening
27 Another simple method of animating te!
;: is 10 use shape tweening. The steps to
s, apply shape tween to text are:
oL
o Smrile! 1. Create a new Flash document.
4 2. Select frame 1. Use the Text Tool 12

write ‘Pl '
Fig. 7.16 Timeline Effect applied to the text AR Ot yoor work'.
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Lise the Arrow Tool to select the  feommmme— —

Lidk

wext and select Modify » Break S o i e tren oy e oy

Apart (Fliz. = 17k it a0l + w w = o » 3_s = W W
4 Select Modify » Break Apart  aa . s mbe e b

again. g

5. Select frame 40 and insert a
kevframe by pressing Fé,

6. Delete the old text, Use the Text
Tool again and enter the words
‘and work out your plan’

iFig. 7. 18,
-

o Wark

You can also change the font,
colour, and size of the text if you
wish 1o.

Fig. 7.17 Frame 1

[Iull-.llnl-\n—-l-mn ]
[N i e e ey e leeeaes e

1 * | - L] - "] [ i -
i

[T g oy

m THaw 0Lk Yok y e [k

Fig. 7.18 Frame 40 Fig. 7.19 Applying shape tween to the text

. With frame 40 still selected, select the text with the Arrow Tool. As you did earlier, select
Modify » Break Apart twice.

+ Select any frame between frame 1 and frame 40. In the Property inspector, click the drop-
down menu arrow of the Tween option and select Shape (Fig. 7.19),

- Save the file and play the movie.
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PRACTICE TIME @

, . — rian to change the
Asma has been zesigned by her Computer Science teacher o Create an animatian to change the

' ; A ; . i P voad hele herwith the steps?
text ‘Enjoying’ inta “With Flash' How should she proceed? Could you help Rer with the StEp

SOLUTION

1. Create a new Flash document

IE ioying!
2 Select frarme 1. Lise the Text Tool to write Enjoying’ on the L_ nJoy g_:,

sLage

3 Use the Arrow Tool to select the text and select Modify > Break Apart

4 Select Modify » Break Apart again

5. Select frame 40 and insert a keyframe by pressing Fé&

6. Delete the old text. Use the Text Tool again and enter the words "With Flasht.
7. Wich frame 40 sl selected, select the text wath che

Arrow Tool As you did earlier, select Modify Break W l 1h F I as h!

Apart owo times

B, Select any frame between frame 1and frame 40, In the Property inspector, click the drop-
down menu armow of the Tween option, 2nd select Shape.
8 Save the file and play the movia.

The surroundings of the computer should be kept neat and tidy. It is a good idea to switch off the

computer and keep the monitor, keyboard, and cabinet covered when not in use. Good-guality conef®
protect these devices against dust and damage.
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mbal 2 graph ”T' image, animation, or button Instance an necurrence (capy) of a symbol in a
that is stored with a Flash movie. It can be Flash movie
iple times :
used multip Library  a folder in which symbols in a Flash
mavie are stored
e
L |
« The Pen Tool is used for drawing precise paths  » The Gradient Transform Tool is used to
such as straight lines or smooth curves, transform the gradient applied to an object.
+ The Eyedropper Tool is used for acquiring * You can change the colour and transparency
colours and styles from existing lines, brush of an instance of a symbaol,
strokes, and fills and applying the same to * You can add text to Flash movies and change
other objects. attributes like style, font, size, and colour,
* You can import external pictures into your * You can convert text (o basic shapes.
Flash movie. * You can add simple animations by using
» The Free Transform Tool is used to move, Timeline Effects.

rotate, or scale an object.

Objective Type Questions

1. Fill in the blanks with the correct words.

instance corner Library animations Property

i, E}WTIEHJFS are stored in HRE .oosnrairsnansrsmissmanarrennsss folder in a Flash document.

b. An oCcurrence of a f_;nl,.-mhul on the SIEIEE is Called @0 .o

C. YOu have 1o drag a ....ccovunsessmmrrasssssesssss handle to scale the object both horizontally and vertically.

d The ... .. inspector is used to set the lext properties.

€. YOU Can adt] SIMPIE 1..vvensrenssresssmssrsssissoniss USIG Timeline Effects.
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L

The Break Apart option is available on CHeking e o ML
i, Maodify i, Bl i, File iv. none of These

You can apply Timeline Eliects o
L Dranwing object i Picture iii. Symbol iv. all of thise

- Fade in, Facle Out, and Explode are examples of

i. Timeline Eflects ii. Break Apart i, Text oplions iv, none ol these

. The keyboard shorcut to break apart a grouped object is

l. Cirl + G i, Cirl + B iti, Shiit + B iv. none of these

When you draw an object, Flash creates which of the following objects! _
i. Outling i, Fill iii. Both i. and ii. iv. none of these

To change the transparency, in the Praperty inspector, click the drop-town menu armow of the
Colour option and choose
i Alpha ii. Tint iii. Colour iv. none of these

The Free Transform Tool can be used for which of the following purposes?
i Move ii. Rofate iii. Scale iv. all of these

. The Import option is available in the ..., MENU.,

i, File ii. Modify i, View iv. none of these

Descriptive Type Questions

1. Answer the following,

e Em R T

What is the use of the Pen Tool?

How will you import a picture from your computer on to the Stage?

Which tool will you use to rotate an object?

How can you move an object from one position to another?

How can you scale an object in a single direction?

Mame the folder in which symbols are stored.

List the steps to group the outline and the fill of an object.

Can you conver text into basic shapes? If yes, list the steps to do so,

In Flash software, why is it important to be able to change text into basic shapes?

Flash provides the user with the ability to work with colours in a number of different ways.
Based on what you have learned, evaluaie the use of different colour options in Flash and their
impartance,

Create a short Flash document about your school, using as many of the tocls you have learned
about so far.
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Applicaiiun-ﬂased Queslions

5 Observe the :tditlﬂil'lir'lg.rllqure 'an;h_ — — e
and answer the tollowing BT bt by ar G Ged Bt i b
BELinnE: ' 'll‘.‘lg i W m bW '
D
i same the tool used to s
3 i - i LR | Powaw el i) pm = o=
write the word “Smilel"on || 37l " wem, b A
the Stage. o,
ii. Can vou convert this text b
into a basic shape? Name |[|oa .
. -
the menu and the option || 45 S i ] o E
that will be used for this i
purpose.
jii. Which tool will you use ==
Frpprs | 5
to change the shape of the p o] A e— - mEimenmYy, P
characters of this word? L Ry Bl lm——" )
“ - o i e
b. Alvina has written her — = srus

favourite quotation in a Flash document, She wanits to give some animation effects 1o e test,
.. What are built-in animation effects in Flash called?

ii. Name the menu and the option that will be selected to give these animation efiiects.

iii, MName any two animation effects.

c. Umaima has drawn a circle with a red outline and a yellow fill on the Stage in Flash, When she tries
to move this circle to another position, she is able to move only the outline,
.. Can you explain why she is not able to move the whole object?
. How can this problem be solved?
i, Write the steps that will be required as a solution to this problem.

d. Shehla has collected pictures of butterflies. She now wants to use these pictures in a Flash movie,
i. Name the menu and the option she will use for this purpose.
il. Which tool will you use to change the size of these pictures?
iti. Can you rotate these pictures? List the steps.

INTHE LAB

1. Amir has been asked to create a Flash document that contains his name. Then he has to apply a
timeline effect to the text, Help him create the document. Then you may use shape tweening to
Lonvert Amir's name into your name.

- Ghazanfar has to create an animation in Flash in which he has to write the word *HAPPY* in the first

frame and “NEW YEAR® in the 20th frame. Help him create the animation and select a timeline effec
that you prefer,

E. M . & s o (S
P. .r- A m HE OEEE = B @
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% Sani-’l‘hﬂﬁ designed pictures of flowers in Flash. Help her convert these into A
them in the Flash Library.

converted the characters into shapes. Do the same using the name of your school and conver th

characters into different shapes. Also change the colour of the characters.

GROUP PROJECT

Enjoy playing with the time line effects. Create your own animated text using timeline effects (see
pages 107-108 in Keyboard Book 7 if you need some help). How far can you go with this animation?
What are the different chaices you can make? How do you think you can use it in your schoal? Coulg
animated text be used on a screen welcoming visitors?

2% TEACHER'S NOTES
* Before starling the chapter, briefly revise the tools already taught in Class 6.

* A demonsiration of how to create symbols and instances, and then how tq modify instances could be
useful.

= Students should be encouraged o experiment with convertin

B text to symba : :
different timeline effects. symbals and with applying

OXFORD
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) Animations in Flash

P W Terale
[ Wallned & CafTonn

ovie CIEETE0 UENE FI2En ar ]

i g friend’s plece yesterday it
v RS prEily ool
¥ ?

rl'l; EIH:E-E {-':.f :'rn.u [EarnT hgw o Create hEEiL' El.ﬂi.mﬂliﬂ ns. YU’U i---—'-'''______,4---._-—--“‘1-ﬂ-"’--\l

also learnt that a Flash movie consists of frames, which are in this Chapter 'Lb
the hasic units of a Flash movie. We enter the content for .

each frame, after which Flash diﬁpi.?l':r'f- the frames in a series - The Timeline and Layers

o |3Fa ¥ the movie. = Animation with Motion and

Shape Tweening
« Lsing a Masking Laver

THE TIMELINE AND LAYERS

« Animnation LSHE & Moboan
The Timeline window helps to organise the contents of a Guide

« Applyving Filvers
= Applying Timeline Effects

Flash document, It contains layers for organising the contents
on the Stage. Figure 8.1 shows the main elements of the

: » Working with Sound
Timeline,

The Timeline shaws frames as a series of rectangles in each layer. Every fifth frame has the

Hame number, Frames with black dots are keyframes. The light red rectangle in the header, with
3 red frame and red vertical line below it, indicates the Playhead. That is the frame currently on
'hE Stﬂgﬂ'. This fram& pati shivwe the I"ILilTlhE[ of frames per mcund your animation will PIE'!.I'.

» 11‘5 I a (-1} ] (=] EHEH
Bata Ga®end 3585 Sua®al
- -.I.':I - - HE.-. EEEEEN I.E- S
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Keyframe wih 3 black dot Playhead
| Timeine x | =
*a0: s w sfffxo» 3 w B XN B N
T —
Lager |
I3 0 il hnen oy uees e W ]
Ciovent frame . N FFrame rate
Fig. 8.1 Timeline Window
To insert a frame or keyframe:
. Fast Forward |
1. Click on a rectangular placeholder where you want to insert
a frame or keyframe. Insert a Frame ks
2, Select insert » Timeline » Frame Or  Insert » Timeline » Insert a Keyframe  F6

Keyframe

Understanding Layers

You can think of layers as transparent sheets stacked one on top of the other, You can rearrange
the order of layers to set the order of objects in the movie, i.e. you can decide which object(s)
should appear first {in the top layer) and which objects(s) appear later (in a lower layer). You
can draw, edit, and animate objects in one layer without affecting the objects on another layer.

Each new movie contains a single layer by default, but you can add as many layers as you wanl,
The Timeline displays layers as rows. It provides options to insert, lock/unlock, or hide/ unhide
a layer (Fig. 8.2).

To select a layer, click on the layer
name,

Lapers ShowHide kayer

| Timenne = |
Milaveras el el
W Layer 2 e |

Inserting a Layer
To insert a layer, select

Insert » Timeline » Layer

W Layer 1 " a Er
Or
Eﬁ".t_i___ . B —
Click Insert Layer at the boltom of L —'mwl e
. . i
the Timeline (Fig. 8.2). = . il
Fig. 8.2 Timeline with layers

F-EEEEE i Hm mR B 116 .
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qaming a Layer
5 ename 2 layer, double-click the layer
Mmeﬂﬂd type the new name (Fig. 8.3).

nhal‘lﬂmg the Order of layers
+ images on different layers —_—
objects in higher layers appear in front of

Double-click the byer name

and type the new name
| Timelve I;!_ ki - s =
a0 s 3
A Laver 3 -+ Ol '

Al bayery

o=l -,
& @ n:.

octs in layers below them. Tg change
ihe order of the layers, click the name of

the layer you want to move and it to
ihe required position.

peleting @ Layer

when you delete a layer, you also delete 2| ob

name of the layer and click the Delete Layer b

ANIMATION WITH MOTION

LT
e

1
|r_| Bh B[l 8 120f ods
8B e

Fig. 8.3 Renaming a layer

jects on the layer. To delete a layer, click the
utton at the bottom of the Timeline.

TWEEHING AND SHAPE TWEENING

In Class 6, you learnt how to

create motion tweening and shape
tweening animations, separately.
The example we will take up

now will create an animation that
includes both motion tweening and
shape tweening.

1. Create a new Flash document,

e - L

El—r—.

- -y
n EE

o = Hra

L. Rename Layer 1 to Circle.

3. Click Frame 1, Select the Oval o=
Primitive Tool, et fill colour
o arange, and draw a circle .
: e e —
(Fig. 8.4), . - res
— k.. |
i ; e
change the Inner Radius, Start el it =5
angle, and End angle so that :
the shape looks as shown in
Figure 8.5,
Fig. 8.5 Changed shape of the circle
. 117 ‘NN : OXFORE
! “oed B8 Bes"af
. o B S Lo % sEsEme @ a BE =
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Select frame 50 in the
Timeline and insert a
hevirame by selecting
Insert » Timeline »

Reyirame.
b. Change Il|‘|r+.'uln.:|,|r and ;: ﬁ s
shape of the circle as . 3 bt omem e — ™=
. 5 - EEE e K1 = ek b 2T o ——
shown in Figure 8.0, H“ bR ah ws e —
. delect any frame L5
between 1 and 50, In
the Property inspector, . :
SEILTt S‘hﬂ.lm l.ll'lt‘rEI‘ FEH' H'r[F Chﬂngn-lg cﬂlﬂur ancf $|'h'!FIE' of 1_|"lE I:II"EIE' i Erill:'ﬂE 50
Tween options.
8. Add a new layer by clicking Insert Layer N e ——
at the bottom of the Timeline. Rename this [\ -En:s;'ﬁ:ﬂ e e
new layer and give it the name Ball, oy [
"‘-.H‘. ey | boma W R 8 SR R G
9. Click Frame 1 of the Ball layer and draw a 2.4 i P —
: 5 e L s
circle using the Oval Tool at the position £e
shown (Fig, 8.7). -
£y
10. Double-click in the circle to select both the  |m
outline and the fill. To group this object ! O
select Modify » Group. .

11. Select frame 50 of the Ball layer and insert

G Fig. 8.7 Drawing a circle in Ball layer
a keyframe by selecting Insert » Timeline » E‘ !

Keyframe.
(T — 12. With frame 50 of the Ball layer still
ki R SR AT [T selected, change the position of the ball
T - 13. Create a motion tween in the Ball layer:
N P T Select any frame between frame | -'i_“'j
N~ - frame 50. In the Property inspector, click
== | the drop-down menu arrow of the Tween

option and select motion (Fig, 8.8).
® | 14 Save the movie.

FE TR R N S Bl

15. Play the movie by pressing ENTER or

Fig. 8.8 Creating motion tween in Ball layer selecting Control » Play
I
?-EEH a o BE 1] ' 113 i j
- B EEEE = BE m N af
_ o SJEN_SuE SRR ROSCER - C o Gaval & g _ R
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gint the Onion shin Feature
I

rhe Onion Skin E,L.'.Imm lets you see the relative
qgeition of an object over several frames
I

Turm an the onion skin feature by clicking the
onion skin button at the bottom of the Timeline
window (Fig. 8.9). YOU €an control the number of
rames by dragging the Start Onion Skin and Erd
Onion skin markers in the Timeline.

usING A MASKING LAYER

you can create special animation effects

S
I
— P Flasty e Ceeaem G e Bemes

S p——

SAE 1 = ir

= s o o
il 1

L
g i
4T

ul
>
W
; .
]

“E R | i

S T I A iy

Lk B oy

+m | COnbon Skin  Stare Onbon Skin
s butan

End Onion Skin

with the Mask Layer feature. You can think Eeeeee—m——=

of a mask layer as a curtain with a hole in

it. The curtain hides the layer behind it, ae

s b T

except for the little bit you see through the va

hole. 8

- | -,

Let us learn more about this feature with -

the help of an example: o
1. Create a new Flash document.

2, Select Modify » Document to display
the Document Properties dialog box
and change Background color to black.

1. Rename Layer 1 and give it the name

LRl | IRTEL N

—

B

Fig. 8.10 Type this text using the Text Tool

Srﬂllﬁl T S T T gy r——e

4. Select the Text Tool and choose
your desired font, size, colour, etc. A
in the Property inspector. Type KEEP
SMILING! on the stage (Fig. 8.10)

5. Click Insert Layer at the bottom of the

Timeline to insert a new layer. Rename

the new layer Mask.

Click frame 1 of the new Mask layer.

Use the Owal Tool to draw a white-

coloured oval that is bigger than the

hEiHhT of the text (Fig. 8.11). Convert il

Mo a symbol.

118
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Fig. B.11 Drawing a white oval
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To convert a drawing into a symbal:

1. Select the drawing and press FB, The Convert to Symbol dialog box appears.

2. Type a symbol name, choase symbol type as Graphie, and click OK

. Select the Smile layer. Click frame 50

and press F6 to insert a keyframe.

. Select the Mask layer. Click frame 50

and press Fo to insert a keyframe.

With the Mask layer selected, drag
the oval symbol to the far end of the
text (Fig. B.12},

10. Create motion tween in the Mask

1.

layer: With the Mask layer selected,
click any frame between frames

1 and 50 and choose Motion in

the Tween option of the Property
inspector.

To convert the layer named Mask
into a Flash mask layer, right-click
the layer name and select the Mask
option in the context menu. This
locks the Mask and Smile layers
topether. The Mask layer hides most
of the Smile layer (Fig. 8.13]. Notice
the change in the layer icons.

12. Save the file and play the movie. You

will notice that as the oval moves
across the screen, the text behind
it becomes visible. The oval in the
mask layer acts like a hole in a
curtain.

ANIMATION USING A MOTIDN GUIDE

Flash also allows you to move an object on a definite curved path, For this, you have to use
something called a guide layer. The guide layer has the motion guide, which is the path along

which the object will move.

OXFORD
el Fhis B B BB g
a @ 0 EEEE O
EE EEE EEEE BEER AL

Fig. 8.12 Final position of the oval

Ths lock
wichiestes [
the mask and

sl [avers wall

. e EEE:'.-'II:‘T

Fig. 8.13 Using a mask layer

Tas)

[ Top Tip e

The mask layer should always be
above the layer that you want to mask.

120
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a bind ki S04,

4. Click frame 50 and insert 3 keylrame by ‘
pressing Fo. :

. To create a motion tween for the bird Fig- 814 Picture imported an the Stage
click any trame between frame 1 and 50
and choose Motion in the Tween meny

fal

of the Properly inspector. ]
b. Click Add Motion Guide in the Timeline e —
indow. This ¢ ' i oa |
W reates a motion guide 931 i Meiko
laver above the Bird layer. The name of 2-|  Guide bucen
this laver is Guide: Bird. N

. With the Guide: Bird layer selected,
click the Pencil Tool, and draw a path
on the Stage (Fig, 8,13),

8. Select the Bird layer. Click any frame

Fig. 8.15 Draw a path in the guide layer
between Frame 1 and Frame 50. '

9. Click the Smap checkbox in the Property =‘ . T RO R R
inspector. Selecting Snap will snap the ol p=— —
registration point of the object to the 24 — ’
mation path, Also select the Orient to ;E : ==
Path option. ’n ™ ot i
10. With the Bird layer still selected, click ot : rovres i i

frame 1,
1. Place the bird on the path such that the

registration point of the bird is exactly

above the start of the path (Fig. 8.16),
12. Click frame 50 of the Bird layer. Fig, 0,16 Starting position of the bird

el « wa u _u SXEOR
L - 2 BEEE B 2 o

BE g i HEE EEEE EEE OO0
— M obm o= o= - R B v n sEEEEm B EE B8 nm non
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13. Now place the bird such that the
registration point of the bird is
exactly above the end of the path
(Fig. B.17),

14. Hide the motion guide layer.

15. Save the file and play the movie.
You will see the bird flying along
the flight path you drew!

&

Fig. .17 Final position aof the hird

PRACTICE TIME

Samreen’s teacher has asked her to
create an ammation in which she has
to set a landscape as & background,
and then show & moving car on the
road. Can you help her with the steps
1o creace this animanon?

SOLUTION

1. Create a new docurnent in Flash,

2. Rename Layer 7 as Background ﬁ
and draw the background shown

in the figure alongside.

Sefect frame 60 in the timeline and insert a keyframe.

Insert a new layer above the background layer and name it Car.

Draw or import a picture of a car on the Stage.
Click frame 60 in the Timeline of the Car fayer and insert a keyframe,

e B TS LR

To create 2 motion tween for the car, click any frame between frame 1 and 60 and choose
Maotion in the Tween menu of the Property inspector.

8 Click Add Motion Guide in the Timeline window. This creates a motion guide layer above the
Car layer. The layer is automatically named as Guide: Car.

9. With the Guide: Car layer selecred, chick the Pencil Tool, and draw a path on the Stage,

QUMD 4 e w w  VEE .
0 a i EEEE = . Hl.l

If EES EEEE EEE @8 pl'

- o EmE i H R & = - e — -
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. Lelect the Car |.'-|:||'EF. Click dly frame between fmme 1 and frame 60

i1, Select the Snap checkbax in the Property inspector. Selecting Snap will snap the registraion
paint of the olbyect to the mation path, Also select the Orient to Path opoon.
12, With the Car layer still selected, click frame 1

13 Place the car on the path such that the
registration point of the car is exactly
above the start of the path.

14. Click frame 60 of the Car layer.

15, Now place the car such thac the
registration point of che car is exactly
above the end of the path.

16 Hide the motion guide layer,
17. Save the file and play the mowvie.

APPLYING FILTERS

Filters are in-built visual effects in Flash. There are different types of filters, like Bevel, Glow,
Drop Shadow, Gradient Glow, etc. You can apply more than one filter to an object. These are
the steps to apply filters to text and animate it using motion tween:

1. Open a new Flash document, B’ 2
2. Select frame 1. i Tt e =
3. Select the Text Tool and type Having i
Fun! on the Stage. L [ReERES—
4. To apply a Bevel filter to the text: i _
a. Select the text block using the EH' T ———
Selection (Arrow) Tool. :‘._::
b. Click the Filters panel in the Flash _deaim |
window. ‘ ;
t. Click Add Filter on the Filters panel. qu!@ﬂ’
d. Click Bevel in the menu that appears Fig. 8.18 Adding a filler
(Fig, B.18).

3. The Filters panel will now show options for the Bevel filter. Try some of them:
* Click the drop-down menu arrow of the Type option and select Outer,

123 OXFORD

FEIFIAMTY Plili

Scanned with CamScanner



=T = W

- S ————t h"
[.._......-.n.rl.lrr-‘l--'" e -

* The Blur X and Blur ¥ oplions sel  [@ st s i oy mmi= == —-.__:__JI

this width and height of the Bevel. E_u--a-r-ﬂ"*""" ey
: - e -

Lise the shiders and ey ditierent . L S
values. Here set the values to 30. 4 el i, T
i o iyl =% =

o Select the Shadow colour to blue — |f S e L
and Highlight colour to green. T o o

s The o sreseifios this = e W
The Angh oplion specifies the . T S— g
angle of the shadow cast by the ;" 1av Eﬂ{
bevelled edge. Set the value to 45, ||& s

: : »
* The Distance option specifies the L '

width of the bevel. Set the value Fig. 8.19 Bevel filter

o 11. Figure 5.19 shows the text B e P s it 77

with the selected options. :

b. Select frame 40 in the Timeline and
insert a keyframe by pressing Fé.

. Apply a Glow filter to the text,
following the same steps as in the
case of the Bevel filter,

e

8. Glow filter options appear in the

4
gl

Filters panel. Use Blur X and Blur ™ |Hﬂ\fiﬂ9 ] Fl.l'l"ll

Y to set the width and height of =

the glow, and set the glow colour
(Fig. 8.201. You can also change the Fig. 8.20 Glow filter along with Bevel

settings far the Bevel filter in this frame,

9. To apply motion tween, click any frame between frames 1 and 40 and select Motion in the
Tween drop-down list in the Property inspector.

10. Save the file and play the movie,

APPLYING TIMELINE EFFECTS

Flash provides predefined motion tweens that can be applied to a graphic symbal, Let us create
an animation to apply these effects,

1. Open the last animation in which you applied a filter to the text Having Fun!.
2. Select frames 41 and 42 and insert Keyframes,
3. Select frame 43. Select Insert » Timeline Effects » Expand,

4. A dialog box appears with options for the Expand effect (Fig. 8.21), Specify the required
options. You can preview the animation, i.e. the text expanding. Click QK.

OXFORD 124
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Sev the durasion

it Directian
of Movement

5, Naotice that the layer name changes

Fig. 8.21 Expand dialog box

_lwll-ﬂlhl—l-h—-.l:
to Expand and 20 frames are added | === == t= == -
in the Timeline. Now there are 2 oy O 4= & K A
frames (Fig. 8.22), 5 ¢
BT § ik
gy CEEET | i mE Wi R BN A W
.-’."r|;-'l=;'rl S LS - <=
WORKING WITH SOUND ] Lo —— ==
MNow let us learn how to import a el
sound file in Flash and add sound to an ||
animation. m .
o Having Fun!
Flash supports various sound formats
like, MP3, AIF, WAV, etc. The steps Fig. 8.22 Timeline effect added 10 the text
dre:
B teguin ey = i
1 GP‘E‘“ H'IE: Fl.ESh ﬁl-E' in Whil:h w]u _gﬂ::::-r::h-. WA ] & ) miA w|om |l Bapys 3.0 : .I-.- '..-
want to add sound. e T S = ————
:“'—- Be ASITnm w Ll
L. To import the sound to the Library: :_""" | = AiNM ke T
3. Select File » Import » Import to et I
Library, ey
b. The Import to Library dialog box | %oy |
dppears (Fig. 8.23). A g O E—
|1__| [ o |
€. Select the file and click OK. —eeeee
Fig. 8.23 Import to Library dialog box
125 OXFORD
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3. Notice that the sound file is added 1o the Library and ey —

has a Sound icon (Fig. 8.24), Iy ===
4. To add the sound to the animation: S et |
a. Create a new layer by clicking the Insert Layer e
button in the Timeline, el T T e

b. Rename this layer as Sound. o = 'f;::m;

c. Select the first Keyframe in the Sound layer. i% = = _n-r_:ﬁz_

d. Notice in the Timeline that the Sound layer displays <
the sound waves of the sound file (Fig. 8.25).

goe 3+E] :

Fig. 8.24 Sound file added to Library

_i-".ng .'. PR T i _.?'.,!.,P.‘.- ot 4 ™ 1 B P

Fig. 8.25 Sound waves of the file in the Sound layer

Frame the basic unit of a Flash movie Keyframe a critical time in a Flash animation
Stage the white rectangular area where we add where an object begins.or ends an action
the contents of a Flash movie Filter in-built visual effects in Flash

Memaory Bytes _ s
» A Flash movie consists of many frames, * Shape tweening makes one shape appear to
* Layers are like transparent sheets stacked on change into another shape,
top of each other, * Using the Onion Skin feature, you can see
¢ There are different ways of ﬂmﬂling animations the relative PD'Sil.iﬂ-n of an Dhjﬂc! over m‘erﬂl
in Flash. frames.
» In motion tweening, we only specify the * You can creale special animation effects using
position of the first and last keyframes. Flash the mask layer feature,
automatically fills in the frames between the » Toconvert a layer into a mask layer, n'gh;-::llil.'I~
twio. the layer name and select Mask in the contest
men.
OXFORD 126 g
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an object alonge a dofinie
4 can move | s« chedinin * Flash provides predefined motion tweens

] i T
ping 8 Guide Layve iR
curved path 1 .E' : BT (Timedine effects) that can he applied 1o a

ro create mation path, select Snap in il praphic symbiol.

L
, mepeclon.

property e o B * You can impon an audio file and add sound 1o

, Filers arc in-Duilt visual effects your can apply AN aniemsation.

o ohjects

Objective Type Questions
i, Choose the correct oplion.
1. Bevel, Glow, and Drop Shadow are examples of

i. Filters li. Motion tween iii. Animation iv. none of these
b, The mask layer should always be ...................... the layer that you want to mask.

i. Below i, Above iii, either i. or ii. iv. none of these
C. THE sovveecmessssseneeeess fEALUTE lets you see the relative position of an object over several frames.

i. Onion Skin ii. Motion tween iii. Shape tween iv. none of these
d. The Onion Skin button is present at the bottom of the ...

i, Properties panel ii. Tools box jii. Timeline window  iv. none of these
e. Toinsert a layer, select Insert® ...............c...... & Layer.

i. Timeline ii. New iii, Add iv. none of these
f, EVENY vvvrecesssssrenssnens frame in the Timeline displays the frame number.

i, Fourt ii. Fifth iil. Sixth iv. Seventh
B THE oovvvoeeseososseenee. ShiOWS frames as a series of rectangles in each layer.

i. Property inspector il. Tools box iii. Timeline iv. none of these

h. The Timelina cantains layers for nrgan[sjn:g the contents on the ...
i, Stage i+ Teols box iii. Property inspector  iv. none of these

Descriptiv.re Type Questions

I Answer the following.

& How can you convert a layer into a mask layerf

. What is the use of the Onion Skin feature?

€ List the steps to change the order of layers. ‘
. Can you delete a layer? How!

¢ How can you identify keyframes in the Timefine?

i L = mm m " S i
o U @ W EEEE @ B &
h..' - -=.-...H====-...-.!- e o= - - I
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f. What are the keyboard shortculs to insert a keyframe and a frame?

g, List the steps to apply a filter 1o an object.

h. How will you add sound to an animation in Flash?

. Analyse the use of layers and their importance in making animations in Flash.

j.  Ali was asked o create an animation in Flash to welcome new students to his class. Explain to
him the different ways of doing this using masking layers and filters individually and then both
together.

k. Create a new Flash CS 3 document about the four seasons. Use text, pictures, sound, timelines,
and layers,

Application-Based Questions
a. Observe the figure on the right and answer the following questions:

i. Can you change the name of — === e i — 4
‘Layer 3' to 'Polygon'? oo w8 8. 8.3 R
ii. How can you move the Circle g+ -
layer above the rectangle layer? ;_u:_,“_,__ T =

iii. Contents of which of the three
layers are hidden?

b. Ohbserve the Timeline window on the right and answer the questions given below:
i. Name the two keyframes created in the layer,
Balloon.
ii. Which frame is selected in the figuret
iii. How can you insert a new layer above the Al AT
Balloon layer?
c. Sidra has to create an animation to change the shape of a rectangle into a cat.
i, What type of tweening should she create in Flash?
ii. What should be kept in mind while creating such an animation?
iii. Can she add sound to an animation created in Flash? What type of sound files are supported by

Flash?
d. Label the parts of the figure given below.

i o L R | PR —
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IN THE LAB

1, Kamran has learnt how to use the masking effect in Flash. His teacher has foldl him ta type the lext
‘Nothing is InjpDS‘!-lhtE' and then display the text using the masking efiect. He also has to add music
to the animation. Help Kamran complete this task.

?L Rﬂ_hmﬂn‘-‘& IEa‘:th hEIE tﬂughl |'IiF'|1 5hﬂm h\lmningl H“.-" hﬂs hEEI'I ﬂs_-ked to L'I'E-.'l[E' an ;“'|i|'|'|.'“i{]|"| tﬂ
change the shape of a circle to a five-sided polygon. Could you help him with the steps?

3. Anam's teacher has asked her to create an animation to shaw 2 paper plane fly along a curved path.
Help her create this animation.

4. Ramla has to creale a decument in Flash and write ‘Happy New Year'. Her teacher also wants
her to apply filters to the text, add some timeline effects, and also a masking layer. Can you help her
with the sleps!

GROUP PROJECT

You are an animation team! You are challenged with creating a Flash animation which uses both
mation and shape tweening. Show the transformation of at least three shapes. Don’t make it too
complicated to start with. Some of the best animations are the simplest, One of the hardest things 1o
learn in group work is collaboration with one another, Once you have mastered this very difficult
skill, you will be ready to tackle anything. When you watch a cartoon or animation film you will see
in the end credits juist how many peuplie are involved in the making of the film, They all had to star
samiwhere!

"t
= TEACHER'S NOTES
* Explain the uses and impartance of layers. It would be useful to demonstrate how to add layers to

a1 movie,
* Have a class discussion and ask the class to think of uses for the masking effect feature.

* Students should be encouraged to use motion guides for creating animations and to apply filters and
make text more attractive. Discuss animations that combine filters with motion tweening,

" H[‘I‘lﬁ' m"d Can Eﬂhanr_‘ﬂ '|J'|_El effect of an an]milhﬂlﬂ cuuld iliﬂ h’E d'fi-l:l.lssed- and a i..]mplﬂ animation
with sound could be created and demonstrated.
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Introduction to HTNML 5

Wtar s HTAIL
Toggle? Would you
el e mvare about (17

=1 wonder how ™,
7 they create these
. eoabiooking
""'«. “fbmgﬁ-‘__

Lsirg HT |'.--'|'|:_..‘.’_

You know that the Internet is a worldwide network of e -
computers. A computer on the Internet that is used for storing In this Chapter
and running a website is called a server, Other computerson |,

the Internet are used to access websites on servers, e e

» What isHTML?
* HTML Editors
= HTML I'_":!-|:|n|_.=I

A website consists of web pages that are written in HyperText
Markup Language (HTML).

Let us first discuss the structure of a website and then * atructure of ap HTML

. Decument
undErs.tand what HTML is. * Line Break Element
| 2ak Eleme

* Cascading Style Sheets

STRUCTURE OF A WEBSITE - Background Properties

A website is composed of three main sections: the home page, the main section and
subsections. :
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Hamse pape
| T e
Makn section
§ _L T e e !—Lﬂ
| k- Fil | " e
I L E S B Ir i [_] . Subsections

the home page "‘ the 'if5| page of the website, This page usually tells visitars what the site

.« about. The main Sf.'i:hnn usually contains the headings for particular areas of the website,
whereas the subsections contain most of the content, For example, the structure for a school
website may look as given below,

]
v ' v . v
Homesarkf
| Main section
Abeuir the School B, and Bupnes Admisskars Ausignments Resuls m 5
3 '
ibweructure  Teaching and Latest Student e Class 1 = Clas 1
Hon-teaching [ Admizgaon
Eacult Circulars Dietails
Y Subsections
= lags 2 = Class 2
School
Achievements = Class 3 = Class 3

WHAT IS HTML?
HyperText Markup Language (HTML) is a computer language used to create documents (web
Pages) for display on the World Wide Web.

In this chapter, you will learn about HTML 5. HTML 5 s the new language specification

Proposed for web pages. This new version attempts to remove the limitations of previous
versions, Rules to handle HTML elements and errors have also been added to HTML 5. You

will learn how to create, save, and open an HTML 5 document. We will also discuss Cascading

Yyle Sheets (CSS) and background properties.

The mosy striking feature of HTML 5 is the facility to play audio and video content without
need for additional software EuCh as the Flash P]-ﬂ}"ﬂr- It has new E"ﬂ]:l'hits 'EE“UTEE such d%
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EAHH."’HS. which detines a H"Hlli'll'l 1] |:|r.|'|.'|,'i|1H within a woly g, wilh Whlli'l'l y{:u croate Ehﬂpﬂﬁ;
graphs, and even animations.

Two basic tools are needed to create HTML documents: an HTML edilor 1o create and save the
documents, and a web browser to view them.

HTML EDITORS
There are two main types of HTML editors: WYSIWYG editors and text editors.

WYSIWYE Editors

WYSIWYG stands for What You See Is What You Get. WYSIWYG editors let you create
web pages without knowing how to write HTML. They have graphical interfaces and tools 1o
develop web pages, and they allow you to insert images, tables, lists, hyperlinks, etc.

Google Web Designer and Adobe Dreamweaver are two of the popular WYSIWYG HTML
editors. Microsoft Front Page, which was a popular WYSIWYG HTML editor at one time, has
been discontinued.

The two main advantages of WYSIWYG HTML editors are:

* Websites can be created quickly.
» Knowledge of HTML tags or commands is not required.

Tent Editors
You can also create HTML documents with Notepad, WordPad, or any other text editor,

But, in this case you need to be familiar with HTML coding. This is how you create an HTML
document using Notepad:

-

1. Open Notepad by selecting Start b All | 3 Cedel - Hotepad = (@
Programs P Accessories P Notepad. ZTD;‘ e h;"-"ﬂ .
The Notepad window will appear. Abals

" <head>

2. Select File » New from the Notepad <tlle>My First P

menu to create a new document. </head>
<body> 5

3. Type the HTML document exactly as Leaming o creale & Web page using FITML
shown in Figure 9.1. (We will discuss </body=> 8
</html=

HTML coding later in this chapter.)
4. Select File P Save As.

5. In the Save As dialog box, choose the —
location where you wish to save the Fig. 9.1 HTML document typed in Notepad
document.
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+ gnter the file name with the — -
nsion .him or himl, and

L:IE ﬁ_',__.f':l-l__:_nfl-lliT b O Il o =]y 1 faacnfasir i s
click save (Fig. "0, e D poe il
e R T TV T Dabs rendibiast Tpe
:I_E_ L. Chagaer 11 Fapic BELM-TERR Liin Py Fered
B e b Chaiapr 1h HTRAL diate 8- LEJERD |aos Filp ez
yiewing HIML DocUments in a weh P Ay
prowser hoey g
i By |
you can use any web browser, say mmarisns | _
internet Explorer or FireFox, 1o view an - = F'_'fw.'.f.'f"f”?“_-.! :
HTML document. The steps to view an (S ey — ==
HTML document in Internet E’"Pmrer o Sove 01 e ot Dt wrmert 10 Save burron ___','I',
1. Open Internet Explorer, L )
2. Select File P Open... (Fig. 9.3, Fig: 9.2 Save As dialog box
3. The ﬂ!ll!l‘l dlﬂ|ﬂg box is diip]a}fed “:iﬂ. 9.4), Top ‘ﬁ-p. J?/;:L\{_’J'
Click Browse.... T -
you do not see any mMEeni in
4. A file selection dialog box (& )@ Mrrrmmnney ~Mt=met Explocer, press ALT. The
will appear. Select the HTML | [lvasomas “mi 'T‘:;“:t'm- Youcan '“:"
; ' T 5 v Femcite Toob right-click above or next o the
file you just created. [r—— CoeT address bar and select Menu bar
5 Click Open.... Dpbeate lab Cariet in the options 1o get the menw.
P wardine ol
s 3 Mw issinn
B The Open d|lalng box will iy by 0 =2 fad
reappear. Click OK and you Bkt with Morepad B s e
§ ¥ e
will see the file in Internet i it oo .
Explorer, Close tab ke
LS - -
Fig. 9.3 Open... opticn of
the File menu in Internet Fig. 9.4 Open dialog box in
Explarer Internet Explorer
HIML CODING

Next, we will discuss how to code in HTML. Let us start by discussing the various components
that make up the HTML code: elements, tags, and attributes,

HIML tlements and Tags
A weh page is made up of HTML elements, and HTML elements are identified by HTML tags.

AN HTML tag always begins with a less than sign < and ends with a greater than sign >

For example, the tag for making the texl bold (darker) is <b>.
* We put <b> before the text that we want to farmat in bold. This is the Opening tag or the ON tag.

. 133 u =m g " OXFORD
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* We put </b> after the text. This is the closing tag or the OFF tag. The OFF tag is the same as
the ON tag, except that it has a forward slash / afler <.

50, 1o make the text 'HTML tag” bold, you will type the following in the text editor:
<b>HTML tag</hb>

When you view the web page in a browser, the text will look like this: HTML tag

An HTML element consists of the opening tag, the closing tag, and everything in between.
Some elements do not have a closing tag,

Container Eflements
HTML elements that include both ON and OFF tags are called container elements. For example,

<brThis text is in bold< /b

DM g OFF cag

Empty Elements

HTML elements that only have an ON tag and da not require an OFF tag are called empty
elements. For example, the <br> tag, which is used to give a line break, does not require a
closing tag. Another example is the horizontal rule tag <he>.

HTML Attributes

Attributes give us extra information about elements. They are always specified inside the start tag,
and have a name-value pair.

For example, the 1ang attribute of the htm1 tag specifies the language of the web page, while
the title attribute specifies the title of the paragraph, and the sre attribute of the <img> lag is
used to specify the URL of the image.

Examples: <html lang = "en-GB"> <p title = “HTML 5"> <img src = “flower
giE"s

HTML Aules
These are some rules for writing HTML code:

1. Tag names and attribute names are not case sensitive. For example, <BoDY> is the same as
<body>,
However, using lower case is recommended.

2. Attribute values should always be enclosed within quotes. Double style quotes are the most
common, but single quotes are also allowed.

OxXrorD 134
MUF Pl Y ™ am o B P [ B
0§ B § EEEE B B & g @ B
n - 50_EEN_@mEEE mE@_®H_ _ _ a m omE e - TRLL

Scanned with CamScanner



- lues can be case senejt;
yribute va =ensitive. The World wi .
3. :L-;t develops standards and specificati e O Wb Condisiess (WAC, the hiody

ons for HTML dac
ribute values. uments, recommends lowercase
spaces between tags do not maiter,
b El:lld- text "‘:.l'rh}

> Bold text </bo

For example,

and
B
gold text
</b»
5, Tag names cannot contain spaces. For example, <b o d y> is not the same as <body>.
Also, there should be no space between < and > in a tag. So do not write < b > or </ b>.

6. Elements can be nested. For example, if we want to italicise text and also make it bold, we
can write:

<h»<i> Correct order of tags </fi> </h>
However, the following is incorrect;

<b»<i> Incorrect order of tags </b»</i>

STRUCTURE OF AN HTML DOCUMENT
An HTML document contains two distinct parts: HEAD and BODY,

* The HEAD section contains information about the document.

* The BODY section contains everything that is displayed on the web page. It includes text,
graphics, etc,

Here is the basic structure of an HTML 5 document:

“IDOCTYPE html>
<htmls

“heads

ol T T et M ek </title>
“/heads
“bodys

-
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<IDOCTYPE html> element: This element is the starting element in an HTML .;;I,_:::urnent and
specifies the type of document. It is an empty element and does not have a closing tag.

<html> element: The <html> element is written after the <! DOCTYPE html> element and

defines the document as an HTML file. It is a container element. The document Ellﬂl'ﬁ with
chtml> and ends with </html>. A browser will interpret everything that comes in between as
an HTML document. An <html> element contains only the <head> and <body> elements. They
in turn can contain other elements.

<head> clement: The <head> element is a container element that includes identification and

additional information about the document, Mast of this is not displayed.

<title> element: The <titles element has the title of your web page. This is the title that is

displayed in the title bar when you view the page in a browser, It is a container element. Each
<head> element should contain a <title> element. 0id you Knows? ﬂ
<body> elemenl: The <bedy> element has the main content
f your web page. It includes text, i ML Sttt of B
ory page. s lext, Images, elc. <body> tag have been removed.
‘E: Wl
PRACTICE TIME €3,

Mishal has to create a simple web page on "Rice Culcivation”, Help her with the HTML code for this
web page. What are the sceps she will have to follow?

SOLUTION
1. Start Norepad
2. Type the following HTML code:
<!DOCTYPE html>
<html>
<head>
<title>Rice Cultivation</title>
<f/haad>
<body>
Rice is a cereal grain that is consumed widely as a staple
food. The traditional methed of cultivating rice is flooding
the fields while, or after, setting the young seedlings.
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£ fpody®
£ fhtml>

select File & Open....

BRI

the Open dialog box reappears,
click OK 1o open the page.

7. Theweb page appears 2s shown
in the figure given alongside.

LINE BREAK ELEMENT

The Open dialog box appears. Click Browse...., Select the

Now select File » Save and save the file 2 rice.html
To view the document in 3 Web browser, apen, say

Internst Exploresr,

file ricehtml and ciick Open. \ren
= il

i T T T——— mwrn:a: .:IT::_?._ e
53 Fice Cutimytinn r
L

| Rl Eft Yew FErome Tosh Help

m‘ffllmmuumednﬂruamp!lﬁﬂm
traditiosal method of cultnvating rice is flooding the fields while. srafter, |
sefizng the yeung sesdlings, il

i e e

The browser does not recognise paragraph formatting in HTML text. If you want to start a new
line, you need to insert a line break with <bz>. This element has no end tag. Let us consider an

example.

Type the following HTML code
in Notepad, save the document
#an HTML file, and openiitin a
h‘mﬁeﬂﬁg. 9.5). You will notice
hat though our text is in four
Paregraphs, the browser displays
35 a single paragraph.

“DOCTYPE hemls

“htm]s

“heads

f:%{lj;réjnwwhm - M Kieyhiasd T\ Chaptes M Chagtar O - & |

(= |

=23 i

&5 Mupviaomy ==}

—_—

Tre 081 Vaew Fevaries  Tosh B

<k
111E}Hushrnnmsdftitle}

A rsushroom is a feshy, spore-bearing fruitng bedy of & fangus, npizally produced
sbove groucd om sed or on ity food souree. Mushrocms are o Jow-calorie food usnslly
eairs cooked ar ravw. They e mrich soose of Vitamin B and essenmial menemis Al
mashrocmi are oot edible. A number of ypecies of mushrooms are pouoncas. Peaple
who eellery musbaessm for consumphion &fé kasuwn & Evbophagusis and the anof
eollsciamg them for s purpose 3 knavwn 88 mushroos hunting

They are alsp knews as the "mest of the vegesable werld”. China n

il ol s lergest edabile musbeoces produces,

“heags
"-I:":Iliy y

Prog
UCed above ground on soil

Fig. 9.5 The browser ignores paragraph breaks in the text

L f :
““Ehr{:nm is a fleshy, spore-bearing fruiting body of a fungus, typically

or on its food source.

OXFORD

}3? -} (1] [~} LTy pam
m . 2 EEEE =
ia avs S3EE S

I B
IEEE

Scanned with CamScanner



Mushrooms are a low-calorio lood usually eaten cooked or rfaw. They sre ;
rich source of Vitamin B and essential mineralsz. All mushroom
edible. A number of spocies of mushrooms are POLSGNOUS.

La
[47]
[
ir
=]
i

People who collect moshrooms for consumption are known as mycophagises Are
the act of collecting them for this purpose 15 known a5 mushroom huntige

They are also known as the ™meat of the wvegetable world®. China iz =&,
world's largest edible mushroom producer.

</ body>
</html>

In order to start a new line, we need to use the <br> tag. Insert <br> tags in the same HTML
document as shown.

<!DOCTYFE html>

<html>

<head>
<Citle>Mushrooms</title>
</head>

<body>

A mushroom i= a fleshy, spore-bearing fruiting body of a fungus, typically
produced above ground on soil or on its food source., <br>

Mushrooms are a low-calorie food item usually eaten cocked or raw. Thay
are a rich source of Vitamin B and essential minerals. All mushroocms are
not edible. A number of species of mushrooms are poisonous. <br>

People who collect mushrooms for consumption are known as mycophagists and
the act of collecting them for this purpose is known as mushroom hunting.
<brs»

They are also known as the

"meat of the vegetable -5 (=[5 e
world”, China iz the 9@@_"““%:' .T'mwm:mnv ol AT E
world's largest edible [Fe 3t View Pivsites Toi Faip
mushroom producer. A mushroom i & feshy, spore-braring fruiting ; ity contiated _{!
":.I'Ibtlﬁhl'.} .ﬂJﬂ‘.‘E,p‘tmﬂMiﬂl-ﬁz;:ﬁHﬂ.tg s
!-;l.mhnm&mihlrm hﬂdhnllljtﬂ.nmni:ednm_i‘hqru: & rich source of
</html> "Wamﬂmﬂﬂlh-mmhmmmmamnrnhd
Imualeeom [aadbbeT
oy Peope whe collect muaks oy i
Save the document and open it in otcolicting i T s ,m‘m"m“ and et
3 browser again (Fig. 9.6). YOU Will || wke Chme s he works Lo e o ot
see that the text has been broken “
Into paragraphs according to where
you inserted <br>.
—d
You can also
use the <br> tag to Fig. 9.6 The browser shows paragraphs now
OXFORD
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or multiple lines. Insert four <cpps  ——u

ine
4? [ ow and see the result (Fig, 9.7, SN i e
4 i d ot M, e Uephsnat Mol kg [T Chapi [0 v
w T b e e e
HEERDIHE EW"'E EHEETE rb:::::;zt"::’;:::::?';hﬁth Tipicaly pradasd __!
efs or i
Jdi“g Stflﬂ She CS‘S 153 EI}I'IE' :I.:I:::T.T:h'd'“r““"“’-“hmmhdnm-hq."..p.m,.: :

et that provides the set of style rules for e e ol s A ks ot st o Ao st |
: T ying HTML elements in a web page. " .
ghapﬁ multiple web pages of a website

ghare the same fr::rmattingl, AlSO it Provides || e e e e of e opesite "
sore flexibility and control in the manner

i which the content is presented on a web

Poobls whas colless ervsbiserns for
CIREIIPE Wt kneon m erreophag aod e
o o ther fv o prrpeaie i fonewn -.:h— Ip-:.,.- =

S

—
—
= — —

Fig. 9.7 Web page with multiple blank lines

F,;EE.
¢s5 styles can be included in an HTML document in one of the following ways:
+ using external style sheets Did you Know? w

o using embedded ST':.I'lE' sheels
W3C has developed some rules for creating and

« using inline styles using style sheets in an HTML web page. In the larest
specification W3C has recommended that HTML
elements which deal with style-related aspects should be
selector (propertyl:propertyl- avoided and their replacements in CSS should be used,

value; property2: property2-value;

-

Where selector stands for the HTML element for which the rule is defined.
propertyl, property2, elc. represent properties (or atiributes) of the element.

propertyl-value, property2-value, elc. represent values assigned to the properties.

The syntax of a C55 rule is as follows:

gl forexample, body [background-color: pink; background-repeat: repeat-X}
The above code specifies that the background colour of the web page is pink and the
fl Vackground image is repeated x times.

Inthis chapter we will learn about background properties and create an HTML document with
i ﬂTI!Jedded style sheets. Using inline styles will be discusseld in later chﬂple:'m An Eml;:eddetdl
A loe "“H'llil:l SEFIE sheet is defined in the <head> section using a <style> element, Inline styles

"3 slyle attribute in HTML elements.

| B
"CHGROUND PROPERTIES .
“thgroung properties are used to set the backgrou nd style of an HTML element. Backgroun
/ 'es are explained in the following table (Table 915
: - 139 m EE B B EKEE
LT  y ® mEEE B ©® ©
N L= mmm WBEEE EEE BA —
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Pl 0.0 B kggrownel properties

i J % 3
(Property  Description Value®) iE""L“F‘F‘_‘E
1 L
bachyround. apseines e D ksl ol it abor value! | "; E‘“““ltuhr
| Cotor Lashin tarsfanent o Y
: T ackpround-imag.
|!$4'11-F.!.{r11|,1114| !t.!n.n ifies thie |1.1l'|'|.=|:lulil1:| LIRL o ilie P laai ' B J!.Iﬂ'."] Im
in"h.'llli.' A TU . LH“ 'l'-k}'.”']n ]
background-  Specifies the initial tefl topledl contrededt bottom? h*":?“_;m”mj'
position pasition of the | right top/right centrefright bottomd | position: cenlre
background inge centne lopfoenine centrefoentre centre

| hottom x-pasition, y-position
X% Y% - B

background- | Specifies whether the | scroll, background.
attachment  background image is fixed | fixed attachment: fixed
or scrolls when the user
scrolls the rest of the page | I

background-  Specifies whether the repeat background-repeat
repeat background image is repeat-x | repeal-x

| repeated or not repeat-y
|- no-repeat B

Let us discuss these properties in detail using some examples.

Setting background color

The background-color property allows you to set the background colour of the HTML element
or document.

For example,

<!DOCTYPE html> _ E{Eﬁ'
<html> 16 ‘*:l[ﬂ DAKeyboand Updation 2013 - P-c| B ir r;_'
<head> E&m“umiﬁ_
<style type= “text/css"> File Edil  View Faensites 1;.,.. Help
body {(background-coler: yellow] Mﬁwm
<fstyle> N
</head>

<body>

Changing the background color
< fhody>

</html>

Figg 9.8 View in web browser after specilying
The output in Internet Explorer is shown in Figure 9.4, the background colour
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gating the Backoround image

an enhance the background of the
you can enhan nd ol the HTML document by acdci i i
W chground using the hacltgmun:l-hmgu property, PR R P

consider the following HTML document: TG

L1 Byt Uptiwn ) XIOR D < 8| 2 |
L{BOCTYPE html> .

Atnld _For I Vew Tewim Tosh
dnead>

sstyle bype= “text/css">

pody {background-image: url({‘flower.
-p3' Vi backaround-attachment: fixed:
rackaround-repeat: repeat|)

istyled : =
< head> - """\,.
<body> k|
fetting a background image J
<'body> '
¢/html> g
Fig 9.9 View in Web browser after setting a
The output in Internet Explorer is shown in Figure 9,9, background image
i
PRACTICE TIME If

s

Qacdlir wants to create a web page on "Penguins”. Help him write the code for the web page. Set the
background image. and use appropriate background properties for the image.

SOLUTION

- Lonrshumniinen
LN NN —
1. Start Notepad. <IDOCTYPE bt

st

i e

2. Type the HTML code given alongside. <> Praguii<ite>

<atyle By "Wadican™

body ek gt ek peapie by
3. Select File » Save and save the stachinien fse, bock rovid-repeat scvrepeat)
document as penguinhtml b i
Premguiins e ke Bor fhir a2t 0F eaping in and oul of the water |
4. Open Internet Explorer. Select File & e “m;‘:nﬁm-mwﬂ“ma; |
Open il af alering the bads 8o breathe moee segulichy,
pen.... o
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ey

2 Click on Browse... in the Open ﬂ a1 it S 5 P-8 Lo
dialog box thar appears - e e - — L
6. Select the file penguin.html and ':“:ﬂ:; h;;,_;u..._uunrﬁ mmim.
click Open, """:E:‘”‘ Hn-n-hn-ﬁef-lb-ﬂhlﬂr !
"

When the Open dizlog box
reappears, click OK.

The web page will be displayed in
the browser as given in the figure
alongside,

Home Page the first page of a website Empty Elements HTML elements that do not
HTML  a computer language used to create require an OFF tag
documents (web pages) for display on the HTML Attributes  extra bits of information that
World Wide Web appear inside the opening tag of an element
HTML Elements  building blocks of HTML HEAD part of the HTML document containing
documents. An HTML element consists of information about the web page
opening and closing tags, and the content BODY part of the HTML document containing
between them. everylhing displayed on the web page
HTML Tags identifiers of HTML elements. They Cascading Style Sheets a set of style rules for

always begin with a less than sign < and end displaying HTML elements in a web page
with a greater than sign >

Container Elements HTML elements that
include both ON and OFF tags

Mmemory Butes = .

* A website is composed of three sections: the
home page, main sections, and subsections.

e A website consists of web pages writlen in
HyperText Markup Language (HTML).

ROy
e B EAITT THEA [ =] [ -] BB [ 7]
-, E EpEE B L]

agmn

An editor is required for creating and saving

an HTML document, This can be a WYSIWYD
HTML editar or 3 texq editor.

' A WI.'|:I hrm'lu'ﬁlEf 15 used to vi
view HTML
documenis,
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105, elements, and attributes arg the
' _:“‘,”F,ment; that make up an HTML code.
L

4 HTML document consists of two distinct

parts: the head and the body,

, The HEAD section contains information about

thi document,

, The BODY section contains everything that is
displayed on the web page and includes text,

gr,l‘phiﬁ.. =

The <title> element has the title of the web

page which is displayed in the title bar of the
web browser,

<br>lag is used to insert a line break. It is an
empty element.

C55 is a style sheet that provides a set of style
rules for displaying HTML,

Background-properties are used to set the
background style of an HTML element.

Objective Type Questions

1. Choose the correct oplion.

a. An important feature of HTML 5 is the facility to play

i, Audio i, Video iii. Both i, and ii. iv, none of these
b. HTML 5 helps you create

i. Shapes ii. Graphs iii. Animations iv. all of these
c. Which of these are container elements?

i <html> ii. <heads iii. <body> iv. all of these
d. Which of these elements contains the main content of a web page?

|, <html> i, <head> fil. <bodys iv, none of these
e. Which of these has no off 1ag?

i, <body> ii. <br> fil. <title» iv. none of these
fo soremssieesssariessesinns provides the set of rules for displaying HTML elements.

1. C85 ii. Head iii. Title iv. none of these

g. In which of the following ways, can C58 be incorporated in an HTML document?
il. Using embedded style sheets

i. Using external style sheets

iii. Using inline styles iv. all of these
h. The property that specifies whether the background image is fixed or scrolls is
i. background-position i, background-attachment

iii, background-repeat

v, none of these
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Descriptive Type Questions

1. Answer the following,
A Name the difierent topes of HTNL editins. Give ome esample ol cach iy,

B W are DITAYL edeanenls?

¢, Difterentiate between contimer and coply elements.

. What are the ditierent values that the bac I-.:.l,|u|||n|-|1'pu'.|l [Ty an takar!

o, What does OS5 mean? What does it specily?

Lo Evaluate the rode of WYSPRYYG oclitors in making il l.l{'_‘-i!lll e pogualar,

2. There are a number of |1.1-.'|n.gm|.m-.| propedies in HTML, Take g lsok at vour school's welssite ang
identify the different background propertios used on any three pages.

i AVrite an HTAML code which chisplavs vour tirst name, your age, the st names ol Yo sibilings,
and vour school’s name.

Application-Based Questions - -

R o T e pe—— Ty TSR E R E e e

-
a. Observe the web page given on the right and :
K

answer the tollowing questions; [ G e Gt Ve by

L. Name the property that was used to set the |
background image.

I, Mention the property and its value that
should be used so that the image appears as

shown in the figure.

The Earth |ivughe m (liwrria

b, Inava wants to create a simple web page about
her school. She wants to set the image of her
school as the background.

i, Name the property and its value she should
use, so that the image appears at the centre of the page,
ii. Which property should she use so that the image appears only once on the wel page!
What value should be assigned 1o that propey?
c. Farhan has written the following code for the embedded style sheet in an HTML document.

<style = “text/oss"> [ == PSR
body |background=image: yellow) i LT W) Oy Updtion 2001 - By P hater I bt B = 8

; e i e '

s e —1

D

Identify the errors and write the correct
code.

d. Danyal has created the web page shown
on the right. ldentify any three HTML
elements and two background properties
he has used 1o create the web page,

OXFORD 144 |
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1

Fachan has 1o crcale a simple web page on the topic ‘Our National Bird”, Set an image of the bird as

the background. Help him create the wob page and set suitable properties, Then view the page ina
wil browser,

. Rabia has learnt 1o create weh pages in HTML. She has now been assigned to create a web page on

Elhl'.'lﬂl SFIL'IH.E .I"iCHI'I.'i’iES", Set the ]]EIEkEI'DLII‘Id colour as pinh and use the activities that YEHF school
aifers to create the text,

Faiza has to create a web page on the topic ‘Historical Places that | Like’, Which are the historical
places that impress you the most? Create an HTML document in Notepad on the

topic, save it, and view it in a web browser. Include a short description of each of the places

that you would like to visit or want to visit again,

- Which is your favorite outdoor game? Write an HTML document to create a web page on your

favorite sports activity. Also set an appropriate image as the background, and set background
properties for the image.

GROUP PROJECT

Web page creation. You are going to have a go at this mammoth task! But working as a team vou will
be successful. Listen and advise one another carefully. Based on what you have learned so far about
HTML, create two web pages about a topic of your choice, e.g. an endangered animal, a family pet, a

classic car or a special celebration outfit. When creating your web pages think about your audience.
Are you creating them for younger people! What difference will it make?

n TEACHER'S NOTES

s Demonstrate and pive stutdents plenty of practice in creating HTML documents in Notepad and viewing
them in a browser.

o Explain to students why the
created in Notegad,

* I possibibe give examples of Case
how to create embedded style sheets.

extension himl or hitm has 1o be given while saving the HTML document

atling Stybe Sheets from external sources and give a demonstration on

D
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] l] Basic HTML 5
' Commands

Taggle, is therea ™
< command ro beeak up |11:.r.'1
CeXT Ato paragraphs in my
x  HTML documenr orher
than the <bes rag?

o Yeg Sure! We wall
;- learn thar along wich
+ same acher basic HTML

element vou can specify |
paragraphs and format
", your document, .«

p DT

We have already discussed how to create an HTML E—
document, save it, and view it in a web browser. In this Chapter

In this chapter, you will learn some basic HTML commands,
These will also include elements that allow you to format sOLLVILElements
HTML text, i.e. to change its font, size, and colour. Also we gLEttb(upertics
will discuss how to use inline styles.

«» Fant Propierties

* SETTNE Margins

s Setting Borders

= |nline Sryles

HTML ELEMENTS

There are some basic HTML elements that you will need to use frequently, Let us understand
them one by one. We will use C55 1o style these HTML elements.

There are some elemenits that are called deprecated elements in HTML 5. Far example, the
<centre> element (which centres text) is deprecated in HTML 5. A deprecated element will

become obsolete in the future, so its use should be avoided in the code we are writing today. i
i ™ .

g B @B EEEE B B o o m I=
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f al."'-'.”']'III
-l,-..ll-l I"‘..'IIJ:':.I .1;111- ;‘]L‘”“."'”t {P:l ljv’l“_u:h d I"t“ﬂl:l

l'lhlll 'i” I Ill"ﬂl. uﬂ'l'l.'l."'-.l_"l"-i. i"-"'i s W v Dirven ¥ . I
= sers insert empty Lines belome ang
e ;".14.']"- i\.t:.i}!‘rdph. A ],_h’lf:tgmph 5 Ly

WS with the <p> ON tag and ends with the «/p> OFF tag,

..;;n:muat Aule

eontal rule eleme Yol ;
the korizontal rule element <he> defines 3 thematic break in an HTMI page, Lo itis used 1o

oIt content inan HTML page. 1t is an empty element and has no end tag,

T t'll."l.'l:l,'lr'ﬁ':l.l rule is used (4] 5';.17..1.[.,1:![" P"“*"F"ii‘h‘-* or sections in a weh page. The horizontal rule

i L-n'ﬂll.‘d mnda !‘:—“"" line and the test that follows this tag is also displayed in a new ling.
Hllh':-l- W LH Li=e? Cahto '-';h-h.‘ thl"‘ <hrs E."Il"“]l."“!,

Weadings

The heading E-hwenm_ tell the browser that a piece of text is a heading. The browser then
displavs it differently from normal text, HTML provides for six heading levels. Headings are
container elements and are written like this:

«we» heading text </hn>

Here n is a heading level and can take values from 1 1o 6.

<h1> defines the most prominent heading and <h6> defines the least prominent heading.
Type the following HTML code and open it in a browser,

L'PBOCTYFE html>

ey |
~himl> ﬂ555-'.';:;;:.:.:..;..;-1-“-...-.“_:-.-»_5-3-- B
<head> (G o Rladee TS e e
<title>Heading slement</title> DL L e = ;
atyle typas “textlosa®s This is heading level one
body |{background-color: yellow] This Is heading level twe
‘ir.Et}'lE} This Is heading lrvel thres
</hesd> i : e
<body> i
<h1>This is heading level one</hl> AN e i
<h2>This is heading level two</h2> b ¥
“h3>This i{s heading level three</h3> 5 . —
“54>This is heading level four</hi> Fig. 10.1 Heading levels
“h3>This is heading level five</hd>
“hé>This is heading level six</hé>
“‘hrml>»
3¢ how the browser displays different heading levels (Fig, 10-1)
147 R " el
T ie mem ==== =ll.-=
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pard fjra [lh
1he p..n.rgr,lph element <p> dlofines

a paragraph -
yier gach PJ’-‘R”'Ph* A paragraph s Paragraph in HTML. Browsers insert ¢

larts wi
with the <p» ON 13 8 and ends with the </p> OFF 1ap,

yorizontal Rule

The horizontal rule element <hes defines ;

. thematic break | o
parte content in an HTML page. 1t is an ak inan HTML page, i.e. it is used 1o

empty element and has no end tag,
The hnrimlﬂﬂl rule ;—5 used to Separate Pﬂrngraphg or seclions in
js created in a new line and the text that follows this 13 i also displ ' |

we will use €55 1o style the <hr> elemen, ’ LRI

yeadings

The heading elements tell the browser that 3 piece of text is
displays it differently from normal text, HTML
container elements and are written like this:

a heading. The browser then
provides for six heading levels. Headings are

¢hn> heading text </hn>
Here n is a heading level and can take values from 1 1o 6,
<h1> defines the most prominent heading and <h6> defines the least prominent heading,

Type the following HTML code and open it in a browser,
<!DOCTYPE html>

mply lines before and

a web page, The horizontal rule

<tk ﬂ i Dt s 1 - 301 iy et P i LTt D - L;'I#ﬂl._.
<head> | @it 3 [1]
<title>Heading element</title> R N T —
<style type= “text/css"> This is heading level one
bedy [{background-color: yellow] This Is heading level two
siatyle> This b beading level ihree
</head>
it This s heasing level Bosr
<hl>This is heading level one</hl> T,
“h2>This is heading level two</hZ> R JJ
<h3>This is heading level three</h3> - .
“0d>This is heading level four</hd> Fig. 10.1 Heading levels
<h5>This is heading level five</ha>»
“hé>This is heading level six</h6>
“/bodys
< html>
See how the browser displays different heading levels iFig. 10.11,
= ' 147 i@ mE = B Ex_r_{m£
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TEHT PROPEATIES

All elements have various properties, for example, text, font, margin, etc. All these properties
have default values. These values can be chanped by the person writing the code.

The text properties provide you with various text formatting options that help you style text in
a web page. Table 10.1 shows various text properties, their description, and the values that they
can be assigned.

Tahle 10,1 Text properies

(Property  Description Values ~ pampls )

color Specifies the colour name color: red '
| foreground colour | hexadecimal colour value color: #243533 I
| of the text RGB colour values | color: £gb I
| | __ | (45,65,150) 4
text-align | Specifies the et | text-align: right
horizontal right
alignment of text | centre |
| or block of text justify ' ;
line-height | Specifies the - normal (default) line-height: normal |
| | distance between | number (a number that will be | line-haight: Bpx

twa lines multiplied with the current font size 1o
set the line height)

length (fixed line height in px, pt, cm)
percentage value (line height in percentage
of current value)

| text- Specifies the none (defaull—delines a normal text) text-decoration;:
| decoration | decorations that | underline (defines a line below the text) | overline

are added to the | overline defines a line above the text! | taxt-decoration:
| text — underlining, | line-through (defines a line through the | ., .
_ line through, etc, | 1€XU i
text- Specifies a list of | none text-shadow: 2px |
shadow shadow effects to be | colour name 2px green
applied to the text | calour value
text- Cantrols the none (defauli—the text appears as it is) | text-transform: |
transform | capitalisation of | capitalise {the first character of each uppercase
text word in uppercase)
uppercase (all characters are in uppercase)
' lowercase (all characters are in lowercase)

S ———— e e ——— e Em—— - —

Let us discuss these properties in detail.
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colors G20 be defined in one of the following ways:
p;edﬂ'fi"Ed colar names

' i decimal color values

L]

" REIE colar values

psefined colos TR like blue, aqua, gray, maroon, yellow, etc. ean be used for calor
@:iﬁcatinn in C55. For example,

color: Silver

color: navy

uexadecimal color values are specified as #RRGGBB, where RR (red), GG (green) and BB (blue)
are the components of the color and the values must be between 0 and FF. For example,

color: #FEFFOOD

rGB color values are specified as rgh (red, green, blue). The values for red, green and blue
chould be from 0 to 255 or a percentage value from 0% to 100%, For example,

solor: rgb(255,163,0)

ealor: rgb(0%,100%,0%)

Consider the following code to set the text color for different HTML elements.
<atyle type= “taxt/fcss">

k1l {color: orange)

p lcolor: §#FFBeCL)

“/atyiex

The above cade tells the browser that the text of the HTML element <h1> should be in orange,
and the text defined by the <p> element should be in the color given by the code #FFBGCI.

Test-align Property
The text-align property is used to specify the horizontal alignment of text in an element. The

default value is left. Consider the following code to set the text-align praperty of different HTML
tlements;

tEtyle Lype= “text/css’>

L‘liﬂitt-ﬁlign: justify)

e l.te:-'.t-—a‘.lign: centre]
ltext-align: left)

i ltexr-a) ign: right}
Iatyles

The ahgve code tells the browser that the paragraph text is fullfajusiiﬁed,lhe?ding level two is
“ntre-aligned, heading level three is left-aligned and heading level four is right-aligned.

15 148 « wu 0w @
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Tent-shatlow property
The text-shadow property applies a shadow 1o 1ext. The value of this property is given as follows:

text=-shadow: h-=shadow v-shadow color
where,

h-shadow specifies the position of the horizontal shadow.
v-shadow specifies the position of the vertical shadow.
color specifies the colour of the shadow,

For example,
text-shadow: dpx 2pX green

in the above example, 4px specifies the position of the horizontal shadow, 2px specifies the
position of the vertical shadow and green specifies the colour of the shadow.

You can specify a shadow for each HTML element separately. For example, the code below sets
the text-shadow property for the paragraph element, heading level 1, and for heading level 2.

<style type= “text/css">

p {text=-shadow: 2Z2px Zpx blue}
hl {text-shadow: 5px Spx redj
h [text-shadow: 4px 4px black]
<fstyle»

Teut-transform property

The text-transform property controls the capitalisation of text. This property can have the
values - none, capitalise, uppercase, lowercase.

Consider the following code to set the text-transform property for different HTML elements:

<gtyle type= “text/css">
pltexc-transform: nonej
hi{text-transform: capitalise}
hfd{text-transform;: uppercase]

</style>

The above code tells the browser that the text of the paragraph will appear as it is, text of
heading level one is in title case, and the text of heading level two is in uppercase.

Comment tag

HTML comments are not displayed by the browser. Any text placed as a comment will be
ignored. You can use comments to explain your HTML code, which will help you or anyone
else who reads or edits the document in the future,

OXFORD
=.-.‘: BEEE B B & g B .=
E B ma = i====.l..I-&n - oEm e e o o = = ._Et-- L

Scanned with CamScanner



 comment 1Ags ¢ <V=< and =<3 This is how Vi

i W enler a comment:

sammirht LeXl ==

gold and italics tags

e tags 1or marking test as hold aned inalics

AR =l anel < | s, prsgaet

2 i I :
nm1ﬁuqLdPHHﬂﬂ\.“IIdeH“ﬂU_ | Sl
ol

axk B VT e & P R R B

L%t 13 1n =saxitalicacris

Yous £ e ombine these bags. For example, if vou wish 1o

| make text bold aned italic. you can
code it like this:

text 18 in <b¥<i>bold and is alse in Ltalics</i></b>
The output would be:

This test is in bold and is also in italics

FONT PROPERTIES

Using font properties, you can change the font, size, and style of the text.
Let us discuss the font property in detail.

font properny

The font property is used to set all the font properties in one declaration. The font properties
that can be set are:

fonts font-atyle fonct=size font-family
Here,

tont-style specifies the font style for the text and can take the values, normal, ttalic, or
ciligue. The default value is normal.

font-zize cats the size of a font and can take any one of the values given in Table 102,
I you specify an absolute value for this property, then you can give the value in any unit like,
Fx, P, et

font-family propery specifies the font for the text in the HTML element. For example:
:.LT—fﬁni]T: arial, "Times New Roman®

Note: Font names are separated by commas and if a font name consists of spaces, then it must
b written within quotes,

Consider the following examples that set the font properties for different HTML elements:

]5] . i P:’El‘ﬂﬂﬂ
5 = s m ® mam
8 e Nl HEE EEN
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<style>

p {font-size: xx-small; font-style: italie; font-family: arial]
hl {font-family: "Comic Sans M3”; color: red)

h2 {font-family: “Times New Roman”; font-style: obligue; color: navyl

<fatyle>
Table 10.2 Font properties
i"l'ﬂP’H‘fl"_ ~ Descriplion 3 Values } E:aw_qlh:_j
font Specilies all the font properties “fant-style font-size font: italic 20px |
L | e dedantion font-family v |
font-lamily | Specifies a list of font names font name font-family: arial |
font-size Specifies the size of a font xx-small font-size: large |
; x-small | font-size: 17px
small font-size: ldpt
| medium (default)
' large |
: x-large
i xx-large
larger
smaller
value
percentage
font-style Specifies the style of the font normal font-style: ital =
italic font-style:
' | | oblique oblique |
PRACTICE TIME
Sumayyah has to create a short note on e-waste T

and display it in a web page. She also has to set the

following

propercies of the web page:

'+ Background colour should be yellow.

+ Paragraph vext should be in green colowr, fully
justified. Font size should be large and font should

be Comic Sans MS
Y = Space berween the lines should be 8.

§

i

152
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i
:
i

Scanned with CamScanner



. ypading level 1 should be centre-aligned,

e 14 .:'_'EIII:I'JF. uUppercase and in l'ﬁ'-"a.l fonc
pow <hould she proceed? ::_--;‘._5:&9::'5-_:!1._!i_ﬂhm..;u:ﬂ;q: :1 - )
e —
7 sﬂl UTIEM ——
1 Start Motepad and type the HTML code iig E-WASTE

given in the figure on page 158.

7 Savethe cocument as e-waste.html,

3 Openinternet Explorer and then open the
fle, e-waste.html. The view in the weh

" the frash thet wa generats whis we
e comptery matiny ‘eicainom refegeraton

wlectriznl and wiertremc gadpats They cumtan o
Faeis Furtesary bl e fadmum ats

R e

browser 15 shown in the figure alongside.

INE MARGINS
he margin properties are used to sel the margins for an HTML element (Table 10,3,

Table 10,3 Margin properties

_ Description | Values e _w%
Sets all the margin properties in | “margin-bottom margin-left| Margin: 10px
| one declaration margin-right margin-top” | 9px Spx 10px
margin-battom | Sets the fixed bottom margin of ' length margin-bottom: |
| an element in px, pt cm, etc. | Default value is Opx lem
margin-left Sets the left margin of an length margin-left
element in px, pt, cm, etc. Default value is Dpx i '_E:m ) .
Sets the right-margin of an length margin-right:
element in px, pt, cm, et - Default value is Opx | 10px !
N, v e i o —
Sets the top margin of an length margin-top:
element in px, pt, cm, elc. | Default value is Dpx EFm B
gin Properties

= Margin property is used to set all the margins (left, right, top, and bottom) in one declaration.

ider the following examples:

fargin: 10px Spx Bpx 12px

Hhe above example, top margin is 10px, right margin is 5px, bottom margin is Bpx, and left

A1gin is 12px,

OXFORD
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If you write the margin property as
margin: 20px 15px
Then, top and bottom margins are 20px, right and left margins are 15px.
If we specify the margin property as
margin: 15px
It means that all the four margins are set to 15px.

SETTING BORDERS

CSS allows you to set styles of the border of any HTML element. You can set the border width,
border style, and border colour (Table 10.4).

Table 10.4 Border properties

(Property  Descripion  Values  Eample ]
border Sets all the border properties in border-width, border- | border: solid
L - one declaration style, border-color 3px green
| border-width | Specifies the width of the border | thin border-width:
medium (default) thick
thick border-width:
length (you can define | Spx
the thickness of the
) border)
border-style Specifies the style of the border none (no barder) border-style:
| dotted solid
- dashed border-style:
solid ridge
double
groove
ridge
| inset
i L outset
 border-color | Specifies the colour of the border | color name border-color:
|__ ! color value red
Note: You should specify the border-style Top Tip -r‘é}
property before the border-color property as : .
an element must have a border before you Ifyou want to apply a style to many selectors, then
change its calour, just separate the selectors with a comma. For example,

hi, h2, h3, h4 [color: green}

USTIRHFY i
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INLING SIVLES

; . vusedd o a i P ) b
“'IJ““" !Ih.' Il ";- WL . |t “l lE1| il "-I'!| ||; ||I hl““--"ll{' L'h..”“.""“'!:l on a w{q] F;IHEI -Fur LI"L‘-'I:lII!'Iﬂ and
Tisis 1 * sl IS, UL :
apphying infine s Ve |11.I| th 1o add o style attribute 1o (he FITML tag. This type of style is
ysectul whien votr want 1o gefing specilic styles {or individual HTML elements,

{mstehe ther tollowing FITML code g apply difierem styles 1o the word ‘Welcome”:

R Tl “u
NI Lygmld
et
"aI'I 1™
cr it le=wirloeome< tit Lo
< Heand™

<howay™

- T n R i = . f
1'!'1 l'l.ll font—-Ss12e: L .|.|-||'||-'|L"r' E‘l:lll::lr: marﬁﬂn; I:E.xt-ﬂllgn: EE:I'LI::.'E; bﬁrdEE:
zalid dpx I.'h:-"""-'i'ka]-.':::ﬂm_u:,-fp:-
<p style= “font-size: x-large; color: green; text-align: right; border:
dashed Jpx orange”>Welcome
/P>
<p style= "font-size: medium; color: navy; text-align: left; border:
groove «px pink">Welcomed/p>
i t.,k-,:l_.r LY

</html>

The output in the web browser will be as shown in Figure 10,2,

i (= [ i |
GL "-HE'J i&qmmwﬁr_@j-mummﬁh;uﬁwﬂ&gﬂmlp - G| w5}
I welcome L

File Edit View Fovorles Took Haelp

Welcome |

L b b tesliek bl b L L

prmmmmmmmoes cm———— Welcom

L e T ]

______________________ D i il

Welcome

Fig. 10,2 View in the weh browser—Dilferent styles for ‘welcome’
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PRACTICE TIME

Wi

Create a simple web page on the "World Wide Fune for Nature (WWE ). Set suitable properties for
the text. Draw a horizontal line after each paragraph. {Use inline styles to set the properties).

SOLUTION

1. Open Notepad and type the following HTML code.
<!DOCTYPE html>
<html>
<head>
<title>WWF</title>
</head>
<body>
<p style= "“font-size: xx-large; color: maroon; text-align:
centre; border: solid dpx blue">
The World Wide Fund for Nature ([WWF) is an internaticnal
non-governmental organisation working on issues regarding
conservation, research and restoration of the environment. </p>
<hr style= "margin-lefr: 200px; margin-right: 100px; border-
width: thick; border-style: double; color: blue“>
<p style= “"font-size: x-large; color: green; text-align: right;
border: dashed 3px orange™>
It is the world’'s largest independent, conservation organisation.
Its mission is to stop the degeneration of the planet’'s natural
environment and to build a future in whieh humans live in harmony
with nature. </p>
<hr style= “border: 4px groove yellow">
<p style= “font-size: medium; color: navy; text-align: left:
border: groove 4px pink">WWF was conceived on 20th April 1961,
under the name of World Wildlife Fund, and its first office
vwas opened on llth September 1961. WWF has set up offices and
operations around the world. In 1986, the organisation changed
its name to the World Wide Fund for MWature., </p>
<hr style= “margin-left: 150px; margin-right: 150px; border-
width: 10px">
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</ hody>
</html>

bl

£ tad

save the document as codes, hmi,
Open Internet Explorer and then open the document codeS html

The view in the web browser is shown in the figure given below:
HIT 11 7 Dy gt . i - Lo ot
o “*‘“.__‘?FFE"W“‘""!E.'!—‘"*FE'E"“‘.‘ R— 3.

hlﬂh—l“1-,"_,' = .

The World Wide Fund for Nature (WWF) is an international |
nﬂﬂ-gm'ﬂlj‘lmmlnl orgamisation working on issues regarding
conservation, research, and restoration of the environment.

¢ s the woelds largest independan, conservation cegnmiaation. T1s missmn i 16 sopi

—_— e

the degeneration of the plaset's natural envicomwent el to bkl a fishare i wlach
eenenc Jimans bive i armcny with watue

S

Font a set of printable or displayable text
characters in a specific style and size

* The paragraph element <p> lets us define
Paragraphs.
* The horizontal rule element <hr> draws a line. *  The heading element <hns is used to add

ACT4s the page.

I
L L

WA v concwrend on vk Al 1961, esder the piese of Boald T kil P dmad s (o ailin o opeiend == Ll

Saprambar 1381 WWF ban ard op offices sad e
Woenld Wiele Frud by Ry, | ¥ vimild I EFFA, e e -

-

T —

View in the web browser—Text on the WWF

the future

Mmemort BUtes

s

Deprecated Element  an outdated element that is
still supported but would become obsolete in

'
"

* The comment lags <!-- and > are used to add

comments to an HTML document,

section headings,
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<b= and <iz are used to make text bold, and  »  Margin properties can be used to set the

italicised, respectively. margin for an HTML element.

Using font propenties, you can change the font, «  Border properties can be used to set styles of

size, and style of the et horder of any HTML element.

The text propertios provide you with various.— * You should specify the horder-style property

text formatting options that help you to forma hefore the hordler-colowr propery as an

the tesd inaowely page. element must have a border before you change
its colour.

If a font name consists of a space, then il

should be written within double quotes. o Inline styles are used to apply a style to
specific elements on a web page.

Objective Type Questions

1. Choose the correct oplion.

b.

Which of the following defines the least prominent heading?

i. <hl> ii. <hs> fii. <h6> iv., none of these
Which of the following values can be assigned to the text-align property?
i. left ii. right fii. centre iv. all of these

. Identify the correct code.

i, text-decoraticn: RODE
ii. text-decoration: underline
iii. text-decaration: overline

iv. all of these
d. While specifying RGB colour values, the values must be from 0 to
i, 254 ii. 255 ii. 256 iv. none of these
£, THE 1ovvooesesesssssessonss PYOpENty is used to specify harizontal alignment of text,
i. align il. alignmant iil, text-align iv. none of these
i Which of the following code is correct, if you want to apply a shadow to the text?
i. text-shadow: green
ii, text-shadow: 2Zpx 2px aqua
iii. shadow: 2px Zpx aqua
iv. None of the above
g. The value that can be assigned to the font-style property is
I, normal fi. lealia iil. obligue iv. Any one of these
h. The default value of the font-size property is
i. medium i, small iii. large iv. none of these
OXFORD 158 .
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pescriptive Type Questions
. Answer the following,

Mention any two ways in which the colour property can be assigned its values.

mame the property that is used to specify the horizontal alignment propery. What is its default value?
What values can be assigned to the text-transiorm property?

Which tag is used to give comments in an HTML document?

What is the use of the font-family and the font-style property?

What is the purpose of the margin property? Explain with an example.

Differentiate between the text-shadow and the text-decoration properties.

What is the use of the <hr> tag? Is it an empty or a container element?

Why do you think that most of the commands in this chapter deal with text formatting!?

Now that vou know a number of commands and how to write simple HTML codes, how would
you assess the language in terms of ease of learning and use!

Write an HTML code for the *About Us' page for your school's website. Make sure you include
information about the history of your school, your school leaders, and also how to get in touch
with your school’s office.

TS Fm RN T

=

Application-Based Questions
a. Usman has to create a web page on an HTML 5 tutorial. He needs to give a thematic break afler
each topic.
i. Which HTML tag should he use for this purpase?
ii. Name the property he should set to change the colour of the horizontal line.

b. Ohserve the following HTML code and answer the questions:
hlltext-align: eentre; color: white; transform: upparcase)
i. Identify the erroris) and write the correct code.
ii. What change will you make in the above code if you want the text in small letters?
iii. What other values can be specified with the text-align property?
c. Wasim has written an HTML code for a simple web page that uses the first three heading levels. He
wants to assign the color, maroon, 1o all the heading levels. He has written the following code:
il {ecolor: macoon)
hZ{color: maToan)
hl [color: maroon}
i. Can this code be written in anather way?
ii. How many levels of headings can be created in HTMLE
iii, Name any two properties that can be set for the heading element,

d. Talal has created a web page giving informalion about the national animal of Pakistan. Which
praperty should he use, if he wanls to make the iollowing changes:
i. Change the spacing between the lines.

159 OXFORD
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i, Change the alignment of the paragrapl text o justify”.
i Apply a shadow to the heading,

@
% IN THE LAB

L4

1. Jibran has collected information about ‘Mangroves’. He now wanls to creale a web page 1o share

this information with others. Help him with the task.

Create a simple web page giving some inspiring quotations. A harizontal line should be drawn aiter

each quotation to separate them.

3. Mansoor has to create a web page on the topic ‘National Festivals of Pakistan’, Can you creale a
similar web page for your class. Set a suitable background colour, font, font size, and font colour.
Also, sel the top and bottom margins.

4, Maria loves playing badminton. Her teacher has asked her to create a web page for her school
giving information about the game. Set a suitable font, size, and colour for the text. Draw a border
around the text, Important terms should be in bold. Also set the background colour as black.

I

GROUP PROJECT

Create group Web Design. It would be helpful if your group web pages were all on the same topic

- e.g. wild animals, football teams, or fashion. Your theme for your web pages is different colour
coding. Explore the different colour values used in HTML 5. Each member of the group should create a
wehpage by applying a different colour code. Once all your web pages are created, put them together

to show to the other groups. What can you leamn from one another? How will it help you improve your
work!

=% TEACHER'S NOTES

« Explain to the students how o use hexadecimal code for specifying text colour,

* Demonstrate how to change the fom style, size, and colour of text and )
! L ETCOy i
with different styles. rage them to experimen

* Explain how the same propertics can be set for different HTML elements,
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KEYBOARD SHORTCUTS

Copy CTRL+C Center Align CTEL + E
Paste CTRL +\ Right Align CTRL + R
CutCTRL + X Justify CTRL +)
Undo CTRL + 2 Plew Drawing CTRL + N
Redo CTRL+Y Save CTRL + 5
Resize and Skew CTRL + W Open CIRL+ 0O
Select All CTRL + A Print CTRL + P
Open Font CTRL+D
Left Align CTRL+L
..:IE
________-——'-_ e
: IJKFU}'EE
.'.. _- u u v kiR
gt e | B @ E © B
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Book Piracy
and Plagiarism
are Crimes.

Don’t be
Deceived

Buy Genuine Oxford Books

Look out for the new security label whenever you purchase an Oxford
textbook or supplementary reader. Labels with the features shown below
are proof of genuine Oxford books.

The image of Quaid's
Mausoleum changes colour
from orange to green when

viewed from different angles.

CRIRED

'‘OUPF* written in very small
print becomes visible when
viewed through a magnifying

—) glass.

1a00000000

The labels have security cut
marks to prevent them from
being peeled off and reused. #3—

S

» Download free ‘FPQR Tasdig' app
from App Store/Play Store on
your smartphone.

« Scan PR code on the security labg]
to verlfy if you have purchased a

The word ‘ORIGINAL genuine Oxford book,
appears when the area
under ‘RUB HERE' is S ; The labels tear if peeled off
rubbed with a coin, EF—————— (& from the book cover.

Pirated books can be recognised by:

: + Inferior production quality =
I * low-grade paper { Do not accept the book if the label is

* variations in texture and colour missing. has been torn of tampered
| * paor print guality . with, the colour on the security
' - blurred text and images label does not change, or the word
| » poor binding and trimming "ORIGINAL' does not appear upon
|L + substandard appearance of the book | rubbing the area with a cain.

If you suspect that you are being sold a plrated book
without the security label, please contact:

Oxford University Press, _
o 38, Sector 15, Korangl industiisl Area, Karschi-T4500, Pakistan O e

Tiels (92-20) 3507158086 Fax: (92-11) I50550N-12 l .[' (_) RD
Tall-feee He: OBOO-GATIS (9 a.m. to5 pm.: Monday Yo Friday]
Emall: cential manketing. piofioup o den

Wheinsite: www.oupcompk Find us anc ﬁ n
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KEYBOARD

Computer Science With Application Software

THIRD EDITION

Keyboard: Computer Science with Application Software [Third Edition), a series
of eight books for Classes 1 to 8, is a comprehensively revised edition of the existing
Keyboard series and carries forward the very same interesting and interactive approach

that is the hallmark of the existing edition. .
This revised edition features updated MS Office modules alang with KTurtle at the

primary level, and includes design and graphics software, namely Flash, HTMLS, Visual
Basic, Dreamweaver, and Photathop, at the secondary level. It also introduces sound and
video editing through Audacity and Lightworks.

Key Features

«  Worksheets: Unit-based and conforming to the continuous assessment needs of the
learmers

« Top Tap: Useful tips on options avallable for different operations

« Practice Time: Situational exercises along with solutions that reinforce learing

»  Fast Forward: Time saving keyboard shortcuts for meny commands

« Computer Manners: Computer etiquette explained through cartoon strips

+  Tricky Terms: Chapter-end list of important terms along with their definitions

+  Exercises: A varied set of questions which test learers on aspects of conceptual
theory covered in the chapter

*  In the Lab: Practical exercises to enable application of concepts to real-life situations

+  Group Project: Activity-based learning to encourage creative and collaborative skills

* Teacher’s Notes: important information and suggestions n;;-;;é'a_'ﬂu-e appedaches o a
chapter ar a topic T

%ol S e
The course i also supported by Teaching Guides that include lesson plans, the complete
answer key to the Student’s Books, worksheets, and test papers.

Each Student’s Book iy accompanied by downloadable digital resources that offer intensating

animations. informatiee tutorisls, and interactive tests for the student to supplement
Deownloadabie Digitsd Rétaurces clastnom imatruction with independent leaming. .

@ ISniaeon NS  The Tauching Guides are st sccempanied by downboadable digital resources that affer

reinforcement ard assessment materiali An inncrative T
w1t Gererator enables teuchers o
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